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2012-06-01 MMCC integration deleted. FRN 5712

2014-10-01 Installation of XML APL does not need the SAPGUI Client. CQ00315638
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About this Manual

Who should read this Manual?

1  About this Manual

1.1  Who should read this Manual?

This installation and configuration manual addresses the technical staff who is 
responsible for implementing or operating an XPR - based Unified Messaging or 
CTI solution in connection with an SAP environment.

Within this scope, only XPR-SAP integrations via the SAP interfaces 
SAPconnect, SAPphone and ICI will be considered.

Though we comprehensively describe technically significant basics as well as 
installation and configuration steps in the following chapters, the reader should 
fulfill the following prerequisites:

• Excellent knowledge of how to operate Windows and Windows-analog 
computer interfaces.

• Practical knowledge of how to install and configure software in Windows 
systems.

• General information technology knowledge.

• Practical experience with installing and configuring the XPR server.
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1.2  General Information on this Manual

1.2.1  Manual Structure

In the following you will find an overview of this manual’s structure. For that we 
introduce here the contents of each chapter:

Chapter 1 – About this Manual

This chapter provides – as you can already see – a short overview of this 
manual's contents. In other words, the single chapters are shortly presented as 
regards structure and contents. Explanations of symbols and acronyms used are 
given here as well.

Chapter 2 – Introduction

The Introduction chapter describes the conceptual method of resolution of an 
XPR-SAP integration, which forms the basis for the realizations to follow.

Chapter 3 – Technological Concepts

In this chapter we introduce basic technology concepts. Such preparative 
descriptions serve to help you understand the XPR server and SAP system 
configuration explained at a later stage.

Chapter 4 – Installation

The Installation chapter describes all installation and configuration steps for the 
solution scenarios of the areas Unified Messaging and CTI.
Each of these scenarios is preceded by a short description of the respective 
interface communication and the general integration concept. The operational 
steps are complemented by figures showing the associated screen contents.

Chapter 5 – Function Reference

The Function Reference documents the possible configuration options on the 
XPR server side. Thus this chapter serves as reference book for users who want 
to perform configurations and acquaint themselves with setting alternatives in the 
SAPR3 and SAPPHONE APL.
Furthermore, a short description of the most important CTI functions is given for 
selected SAP clients.
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Chapter 6 – Registry Values

The chapter Registry Values sums up all XPR server registry values. 
Documented are the respective names, associating keys, default entries, and the 
possible registry entries.

Chapter 7 – Important SAP Transaction Codes

In the Important SAP Transaction Codes chapter, all transaction codes required 
in the course of the installation under SAP R/3 are compiled.

Chapter 8 – Document Formats in SAP R/3

Describes the file formats used under SAP R/3.

Chapter 9 – Scope of Services of the SAPphone Interface

This chapter lists the features supported by the SAPphone interface in correlation 
to different SAP R/3 versions.

Chapter 10 – Troubleshooting

In this chapter we deal with possible errors in the installations performed. It 
contains various error descriptions, possible causes and a recommendation for 
the respective error recovery.
Understandably this chapter can only represent a mere basis for a first error 
search. If system failures occur in connection with an XPR-SAP integration that 
cannot be solved by the suggestions made in this chapter, we refer to additional 
system documentation (for example release notes etc.) and subsequently to your 
contractual partner if required.

Glossary

The glossary summarizes all technologically significant terms of an XPR-SAP 
integration and provides a short description of these.
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1.2.2  Symbols Used

In the following paragraphs you will find a description of the symbols and their 
significance.

IMPORTANT:
In this way notes are indicated that signal important information. Please 
definitely heed such notes to avoid malfunctions, loss of data or damages to 
property.

NOTE:
This symbol indicates a note containing information worth knowing about the 
described matter.

With the registry description in Chapter 6, “Registry Values”, the parameters 
linked to a unit within the system are followed by this unit in square brackets [ ]. 
The indication of these units serves information purposes only and the units must 
not be considered on entering registry values.

Example:
 

The numeric value stored in this registry value is within the system interpreted as 
specification in milliseconds.

1.2.3  Acronyms Used

The following list displays the acronyms used in this manual without any further 
description. Additional explanations of these terms are given in the Glossary.
 

SystemStartWaitTime [REG_DWORD]

Default: 5000 [milliseconds]

Possible values: <number> [milliseconds]

Acronym Significance

APL Access Protocol Layer

AUM Advanced Unified Messaging

CN Calling Number

CIC Customer Interaction Center

CPI-C Common Programing Interface for Communication

CRM Customer Relationship Management

CTI Computer Telephony Integration

Table 1 Acronyms Used
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EX Extension

GUI Graphical User Interface

HKLM HKEY_LOCAL_MACHINE

HTTP Hypertext Transfer Protocol

IC Interaction Center

ICI Integrated Communication Interface

IP Internet Protocol

IVR Interactive Voice Response

SN Short Name

LDAP Lightweight Directory Access Protocol 

PSTN Public Switched Telephony Network

RFC Remote Function Call

CN Calling Number

SMS Short Message Service

SMTP Simple Message Transfer Protocol

TCP Transmission Control Protocol

SMTP Simple Mail Transfer Protocol 

SOAP Simple Object Access Protocol

UM Unified Messaging

WWW World Wide Web (Internet)

XML Extensible Markup Language

XPR OpenScape Xpressions

Acronym Significance

Table 1 Acronyms Used
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1.2.4  Additional Information

Various sections of this manual deal with software components that do not directly 
refer to the configuration of the described XPR-SAP integration. Within the scope 
of this documentation we cannot go to such lengths as to describe the installation 
or advanced operation of such components. In fact, we assume that they have 
already been installed and that the reader generally knows how to operate them.

As far as these components need to be handled for the configuration of a solution 
present, the required steps are comprehensively explained and represented. For 
more information on operating or installing these components please refer to the 
corresponding documentation of the respective producer.

Realizing the XPR-SAP integration requires in particular the SAPGUI - the 
graphical user interface of an SAP system. Therefore, you find a description of its 
installation and configuration as detailed as required. This manual is not a general 
SAPGUI operating instruction though. Further information is in this special case 
found in the official SAP manuals.

As regards the reference documentation on the SAP components we also refer 
to the SAP producer documentation.

Supplementary information on the CTI APL of the XPR server is provided in the 
XPR manual Server Administration.

Additional SAP documentation

You will find additional producer information on SAP R/3 in the following sources:

• SAP Web Help Portal under http:// help.sap.com
(as SAP partner or customer you can register there as Service Market 
Place user).

• SAPGUI Online Help CD

• SAP Interface and certification documentation

• SAPNotes.
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1.3  Data Protection and Data Security 

This system also processes and uses personal data for purposes such as billing, 
displays, and customer data acquisition.

In Germany, the processing and use of such personal data is subject to various 
regulations, including the regulations of the Federal Data Protection Law 
(Bundesdatenschutzgesetz = BDSG). For other countries, please follow the 
appropriate national laws.

The aim of data protection is to protect the rights of individuals being affected by 
use of their personal data.

In addition, the aim of data protection is to prevent the misuse of data when it is 
processed and to ensure that one’s own interests and the interests of other 
parties which need to be protected are not affected.

The customer is responsible for ensuring that the system is installed, 
operated and maintained in accordance with all applicable labor laws and 
regulations and all laws and regulations relating to data protection, privacy 
and safe labor environment.

Employees of Unify Software and Solutions GmbH & Co. KG are bound to safeguard trade secrets and 
personal data under the terms of the company's work rules.

In order to ensure that the statutory requirements during service – whether during 
“on-site service” or during “remote service” – are consistently met, you should 
always observe the following rules. You will not only maintain the interests of your 
and our customers, you will also avoid personal consequences.

A conscientious and responsible approach helps protect data and ensure 
privacy:

• Ensure that only authorized persons have access to customer data.

• Take full advantage of password assignment options; do not allow 
unauthorized persons to gain access to passwords by writing them down on 
a piece of paper or via other means.

• Ensure that no unauthorized person is able to process (store, modify, 
transmit, disable, delete) or use customer data in any way.

• Prevent unauthorized persons from gaining access to data media such as 
tapes, CDs or DVDs. This applies to service calls as well as to storage and 
transport.

• Ensure that storage media which are no longer required are completely 
destroyed. Ensure that no sensitive documents are left unprotected.

Work closely with your customer contact; this promotes trust and reduces 
your workload.
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Introduction

XPR and SAP R/3 – a well coordinated Team

2  Introduction

2.1  XPR and SAP R/3 – a well coordinated Team

SAP R/3 is an integrated collection of standardized company applications that 
map and support a broad range of company processes. The currently available 
applications reach from materials management and procurement via accounting 
solutions and staff administration to customer management, e-Commerce and 
web portal solutions. 

SAP R/3 is a real-time system. All company-significant information is centrally 
consolidated in the SAP database and can thus be queried any time.

The XPR server provides different communication modules for an efficient 
connection of the XPR server to such an SAP environment. The SAPR3 APL 
supports the SAP interface SAPconnect and the SAPPHONE APL supports the 
SAPphone interface. Furthermore, connections to the ICI interface of SAP R/3 
can be enabled with the XML APL.

The following figure provides an overview of the available XPR server interfaces 
and modules that matter in the environment of an XPR-SAP integration.
 

SAP R/3
Server

SAP R/3
Server

SMTP
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Integrating the XPR server and SAP system does not only provide the user with 
the actual SAP applications, but he/she can also utilize the wide range of the XPR 
server communication solutions in system-integrated form. The scope of these 
additional services depends on the realized type of SAP interface.

SAPcomm is the most simple interface and provides merely fax services. The 
SMTP interface already enables integrating Unified Messaging services. Beyond 
that, SAPphone realizes the integration of CTI functions in SAP R/3.
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2.2  Unified Messaging and CTI – what is that?

Unified Messaging and CTI solutions help optimizing an increasingly 
communication-related business culture.

Unified Messaging (UM)

The term Unified Messaging describes the consolidation of various 
communication services on a common platform. Such services can be, for 
example, telephony, fax, e-mail or SMS, which are administered in a Unified 
Messaging solution on a universal communication platform and, in the ideal case, 
are interconvertible.

In practical terms this means that a user can reach all of his/her incoming 
messages via a central system access. As regards SAP integration this means 
that all communication services can be provided via one interface – namely the 
SAPGUI or the SAP WebClient.

Computer Telephony Integration (CTI)

CTI summarizes all functions that enable a logical link between data and 
telephone services. In the most simple case this can be, for example, starting a 
defined PC application when a call arrives at the telephone terminal device of the 
same workstation. This scenario can be extended at will by linking an incoming 
call to more complex, computer-based processes. Such processes can include, 
for example, the display of caller-specific information on the computer screen. 
The other way round, from computer to telephone, is possible as well. A good 
example of this is establishing a phone connection to a subscriber from within a 
computer application.
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Technological Concepts

SAP R/3 in General

3  Technological Concepts

This chapter provides information on the following topics:

• SAP R/3 in General

• Unified Messaging via SAPconnect

• Notes for an Environment with several Clients.

3.1  SAP R/3 in General

The information in this chapter is structured as follows:

• Logical Structure of an SAP R/3 System

• External SAP R/3 Interfaces

• RFC Protocol

• SAP Routing.
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3.1.1  Logical Structure of an SAP R/3 System

While SAP R/2 used to work on a mainframe basis, SAP R/3 is realized in a 
hierarchical client/server architecture. Various logical servers provide different 
services for the next higher server layer in the network. The following figure 
shows the logical system components of this structure.
 

Database server 

The database server acts as central administrator of all data stored in SAP R/3.

Application server

The application server provides the SAP users with all required SAP applications 
under SAP R/3. If an invoked application under SAP R/3 needs stored data, the 
application server communicates with the database server and retrieves all 
required information from there.

The SAP applications of a company can be distributed among various application 
servers and are thus highly scalable.

Gateway service

The gateway service is one of the SAP R/3 services typically installed on an 
application server. It provides external connections for the entire SAP server 
system. In this function it is responsible for processing outgoing Remote Function 
Calls (RFC) (cf. Section 3.1.3, “RFC Protocol”, on page 29).

An SAP server carrying a gateway service is also called SAP Gateway Host.

Database Server

Application Server

Presentation Server

SAP Client/Server Structure

…..…..Gateway Service
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Presentation server

The presentation server is in charge of the user-compatible representation of all 
information on the SAP user system. It is part of the SAPGUI, the graphical PC 
user interface of an SAP user, or is addressed as X-Server by an X-Terminal. The 
information to be represented is retrieved by the representation server from the 
application server.

3.1.2  External SAP R/3 Interfaces

SAP R/3 provides various interfaces for communicating with external systems. 
For the time being, these are SAPcomm, SAPconnect, SAPphone and ICI.

3.1.2.1  SAPcomm Interface

The SAPcomm interface is the oldest communication interface for connecting 
external systems to an SAP system. It was introduced with SAP R/2 and is 
beyond that also used in SAP R/3 environments. Since it merely supports fax 
service, it has largely been replaced with the more recent SAPconnect interface, 
which provides a wider range of services.

Data interchange using the SAPcomm interface occurs via a file storing system. 
In this store, messages to be transmitted are filed by the sending side. The 
receiving side can then read out the information for forwarding.

SAPcomm will not be officially supported any more after SAP R/3 version 4.6.

IMPORTANT:
The XPR server does not support the Unicode format via the SAPcomm interface.
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3.1.2.2  SAPconnect Interface

The SAPconnect interface was introduced with SAP R/3 version 3.1G and 
provides the services fax (with document attachment), e-mail and pager/SMS. 
SAPconnect communication is based on the SAP-own RFC interface. This 
interface works client/server-oriented and exchanges queries and information via 
the so-called Remote Function Calls (RFC) (cf. Section 3.1.3, “RFC Protocol”, on 
page 29).

Since the introduction of SAP Basis 7, SAPconnect has not been officially 
supported any more. Fax and SMS messages have eversince been exchanged 
with external systems via the SMTP interface of the SAP system (cf.Section 
3.1.2.3, “SMTP Interface”, on page 26).

With the SAPR3 APL the XPR server provides a certified version of the 
SAPconnect interface.

IMPORTANT:
The SAPR3 APL does not support the Unicode format.

3.1.2.3  SMTP Interface

The SMTP interface with SAP Basis 7 replaces the SAPconnect interface. This 
enables the SAP system to exchange fax and SMS with external systems default-
based via SMTP.

With the SMTP APL the XPR server provides a certified version of the BC-SMTP 
interface.

IMPORTANT:
The SMTP APL does not support the Unicode format.
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3.1.2.4  SAPphone interface

The SAPphone interface was also introduced with SAP R/3 version 3.1G. It 
enables the use of CTI functions that optimize telephone communication in wide 
areas by integrating the PC workstation. Some simple examples of this are 
setting up telephone calls with a mouseclick or using a journal. Such a journal 
documents incoming calls in a manageable way, so that return calls can be easily 
initiated. An individual SAP workflow and telephone communication linkup or 
transporting data with a telephone call (CAD) is possible as well.

Just like SAPconnect, SAPphone is based on the subjacent SAP RFC 
communication (cf. Section 3.1.3, “RFC Protocol”, on page 29).

With the SAPPHONE APL the XPR server provides a certified version of the 
SAPphone interface.

IMPORTANT:
The SAPphone APL does not support the Unicode format.
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3.1.2.5  ICI interface

By now the SAP R/3 systems provide a communication interface that does not 
use the SAP-proprietary RFC communication any more - the Integrated 
Communication Interface (ICI). This interface was implemented based on the 
specifications for XML/SOAP of the W3C consortium and works with a 
progressive, web-oriented technology.

ICI defines the possibility to support the Unified Messaging services fax, mail, 
SMS, pager and SAP work items. Furthermore, the installation of CTI solutions is 
enabled by external communication servers. Ample monitoring, reporting and 
collecting statistics are additional options of the ICI interface.

ICI has been supported since SAP CRM 4.0.

Based on the XML APL the XPR server supports an ICI interface certified by SAP. 
From the services listed above this interface currently supports ’ICI-Mail’ and ’ICI-
CTI’.

IMPORTANT:
The XML APL does not support the Unicode format.

IMPORTANT:
The XML APL does not support a Web Dispatcher on the SAP R/3 side.
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3.1.3  RFC Protocol

The RFC protocol provides a platform-independent SAP interface. This interface 
is a TCP/IP-based client/server interface with a symmetric communication 
character.
 

The messages exchanged via RFC – the so-called Remote Function Calls (RFC) 
– realize the call of RFC application functions. While the RFC server provides the 
RFC application functions itself, the RFC client realizes their call-up. A function 
call thus always occurs from the client to the server.

Against the background of the client/server architecture, a terminal-system 
related difference is made between RFC client and RFC server connections. A 
client connection ends on the RFC client of the considered system and a server 
connection ends on the associating RFC server.

We name RFC client and RFC server connections always related to the XPR 
server.

For each connection of an SAP application server as well as for the 
communication of each SAP client, a logical communication link is required 
between the XPR server and SAP R/3 system. For each of these links a number 
of RFC client and RFC server connections is thereby established.

External System

SAP System

RFC Client RFC Server

RFC Server RFC Client

SAPconnect/SAPphone Interface

SAPconnect/SAPphone Interface

RFC Transactions
Client

Connection
(SAP-related)

Server
Connection

(SAP-related)
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This link forms the communication basis between SAP system and XPR server 
with using the SAP interfaces SAPconnect or SAPphone.

NOTE:
On the XPR server the RFC interface is provided by the program library 
LibRFC32.dll. It is automatically installed on configuring the SAPGUI.

Let's now see how many RFC connections between the XPR server and the SAP 
system are established.

NOTE:
The LibRFC32.dll by SAP limits the number of parallel RFC connections. This 
limitation can be set via the environment variable CPIC_MAX_CONV of the 
Windows operating system and allows up to 100 parallel RFC connections by 
default. Consider this restriction particularly in CTI and contact center environ-
ments (Section 3.1.3.6, “Numerical Restriction of RFC Connections”, on page 
35).

Number of RFC connections for the SAPGUI

For each SAPGUI connection that accesses a connected SAP system from the 
XPR server platform for configuration purposes, a client connection is established 
between the systems. This structure is independent from the communication 
interface used between the XPR server and the SAP system.

Number of RFC connections via SAPconnect

If a SAPconnect interface is used between the XPR server and the SAP system, 
the number of established RFC connections results from this as follows:

The XPR server and the SAP system establish for each link that exists between 
the XPR server and the SAP system two client connections and one server 
connection.
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Number of RFC connections via SAPphone

If a SAPphone interface is used between the XPR server and the SAP system, 
the number of established RFC connections results from this as follows:

• The XPR server and the SAP system establish for each link that exists 
between XPR server and SAP system always four server connections at 
first.
Via these connections, RFC transactions are exchanged between the 
XPR server and SAP system with each unanswered transaction blocking 
the relevant connection.

• To enable the transmission of further transactions when such blockings 
occur, the XPR server tries to establish further server connections to the 
SAP system. Namely, altogether one server connection for each 
monitored telephone of a CTI environment. This procedure is to ensure 
that for calls from SAP R/3 an adequately large, not blocked connection 
pool is available. RFC connections once established are kept open for 
handling future RFC transactions.
The maximum number of RFC server connections established in this way 
can be connection-specifically defined in the SAPphone APL 
configuration dialog via the Max. Server Connections option. The 
default value of this setting is 20 server connections.

• For each established server connection a client connection is set up also.
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3.1.3.1  RFC Destination

So that the respective RFC client can address its RFCs precisely to the target 
system via the SAP interface, it must receive a target address for its 
communication. This information is handed over to the client in the form of the 
RFC destination. The RFC destination thus represents for the RFC client the 
logical dimension of the connection to an external system.

On the SAP system side the RFC destination is specified by direct configuration 
of the SAP application server with the SAPGUI. In the XPR server its 
configuration is indirectly performed via an entry in the saprfc.ini. On 
establishing the communication with the SAP system, the XPR server reads the 
relevant entry out of this configuration file.

NOTE:
Alternatively, the RFC information can be handed over to the XPR server via the 
corresponding entries in the XPR registry. This procedure has however only been 
maintained for reasons of compatibility to older implementations and is no longer 
recommended.

3.1.3.2  Program ID

In order to operate several parallel links via an SAPconnect or SAPphone 
interface, a logical ID is assigned to each connection – the program ID. This ID is 
configured on the XPR server as well as on the SAP application server and is 
transmitted along with the communication of these two systems for 
authentication.

3.1.3.3  Saprfc.ini  – the RFC Configuration File

The saprfc.ini file is a configuration file for any RFC-based applications. It is 
used to configure the RFC parameters for the XPR server interfaces SAPconnect 
and SAPphone and its communication with an SAP application server.

IMPORTANT:
The saprfc.ini must be available on the XPR server in the
<XPR Install>\bin\ directory. As alternative to these defaulted paths you can 
define an individual directory under the Windows environment variable RFC_INI 
for storing the saprfc.ini file. If the storage location of the configuration file is 
specified in this way, all RFC applications must use the same saprfc.ini .
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In the following you see an example of an extract from an saprfc.ini  file. Here 
the parameters needed for an RFC connection are configured, which are later 
taken over by the XPR server if required:

[…]

[RFC-SERVER]
DEST=SRV
TYPE=R
PROGID=CE6_850_MMCC
GWHOST=/H/194.77.158.13/H/…/S/3297/H/cpce601
GWSERV=sapgw00
RFC_TRACE=0

[RFC-CLIENT]
DEST=CE6
TYPE=A
ASHOST=/H/194.77.158.13/H/…/S/3297/H/cpce601
SYSNR=00
RFC_TRACE=0
ABAP_DEBUG=0
USE_SAPGUI=0

[…]

The following table shows the denominators and the settings they represent:
 

Please refer to the reference section under Section 5.5, “saprfc.ini”, on page 283 
for explanations on the most important entries used.

Denominator Description

ASHOST Host name of the SAP application server

DEST Referencing string for the XPR server

GWHOST Host name of the SAP gateway server

GWSERV Name of the SAP gateway service

PROGID Program ID of the RFC connection

SYSNR System number of the SAP gateway service

Table 2 Description for the Parameters of the saprfc.ini (Extract)
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3.1.3.4  CPIC User

For communication via RFC we recommend the definition of a virtual user of type 
CPI-C.

NOTE:
Depending on the SAP version, the CPI-C user type is also called system user 
(from SAP R/3 4.6C) or communication user (from SAP R/3 6.10 basis).

At least the SAP system privileges S_A.SCON must be assigned to this user via 
his/her profile.

NOTE:
You can also grant full SAP system privileges (SAP_ALL, SAP_NEW) to the 
virtual user. Since user type CPI-C is selected, you cannot log on to the SAP 
system via this user from outside. This prevents abuse of the assigned privileges.

Via this user the XPR server will later log on to the SAP application server to 
exchange RFC information with SAP R/3.

3.1.3.5  Restricted RFC Parameter Selection

Since some of the parameters described in this section have reference and 
authentication functions, the following restrictions must be respected on the 
otherwise free assignment of these parameters:

• Program-ID
Denominators for the program ID must be client-spanningly unique on 
an SAP system. With their parallel definition on the XPR server and SAP 
system, respect case sensitivity.

• DEST in the saprfc.ini
As referencing denominator this parameter must be unique within the 
saprfc.ini.
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3.1.3.6  Numerical Restriction of RFC Connections

The LibRFC32.dll, which enables any RFC communication to the SAP system 
on the XPR server, limits the number of parallel RFC connections. This restriction 
can be set via the Maximum Number of RFC Connections item in the 
SAPphone APL and allows up to 100 parallel RFC connections by default, which 
result from the sum of client and server connections.

As already described in Section 3.1.3, “RFC Protocol”, on page 29, these 
connections comprise:

• All original client/server connections between the XPR server and the 
SAP system per client/application server and SAPGUI.

• All connections for the telephones of a CTI environment to be monitored 
(solely via the SAPphone interface).

On the one hand this restriction leads to a limitation of SAP systems to be 
connected. On the other hand, a loss of system performance may have to be 
taken into account with an extremely large number of telephone terminal devices 
to be monitored.

The system-related setting Max Server Connections in the SAPphone APL 
enables in this context a system optimization. This optimization allows a selective 
distribution of possible RFC server connections among various connected SAP 
systems.

NOTE:
In this context, it is necessary to differentiate clearly between server and client 
connection of the RFC protocol.
The Maximum Number of RFC Connections limits the possible server and 
client  connections to altogether 100 connections by default. The Max. Server 
Connections setting restricts, in contrast, merely RFC server connections.
The sum of the Max. Server Connections of all SAP systems must therefore be 
smaller than the Maximum Number of RFC Connections. The resulting 
difference is required for possible SAPR3 APL connections and additional 
SAPphone APL client connections.
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Optimization example:
Two SAP systems with 20 respectively 200 users are connected to an XPR 
server. Both systems are to provide Unified Messaging and CTI functionalities for 
their users via a SAPconnect or a SAPphone interface.

Let us contemplate this scenario with the default settings for Max. Server 
Connections – namely with 20 server connections for each of the SAP systems:

Though both R/3 systems clearly differ in the number of users, the XPR server 
provides them with an identical maximum number of RFC server connections. 
The result is a proportionately worse service quality by the ’big’ R/3 system. This 
particularly affects the CTI functionality the number of RFC server connections of 
which proportionately increases with the CTI users.

In such an environment we therefore recommend to reserve a bigger share of the 
maximum of 100 RFC connections for the R/3 system with 200 SAP users. 
Consequently, we optimize the XPR server settings by allowing a maximum of 
e.g. 60 RFC server connections for the ’big’ SAP system, and a maximum of 10 
RFC server connections for the ’small’ system.

The remaining RFC connections can then be used, for example, for the additional 
Unified Messaging connection via SAPconnect, and for required RFC client 
connections.
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3.1.4  SAP Routing

When connecting an XPR server to an SAP system, establishment of a 
communication relation between both systems must be ensured. This requires 
routing of the transmitted information from the source to the target.

If the SAP and XPR server are separated by a WAN connection, a ’source route’-
based routing is used. The sending system is thereby informed about the exact 
route from the start to the target system. This is done by specifying the so-called 
’router connect string’. It defines all SAP routers that need to be passed on the 
way to the target, and the target system itself. The thus described routing path 
through the network is added to the data to be transmitted, which, based on this 
information, can be routed to the desired target by the SAP routers.

A ’router connect string’ consists of several substrings that specify various 
information of the respective systems. Each substring has the format /H/
<Host>/S/<Service>/P/<Password> with the denominators H, S and P 
describing which specification type follows.

The following applies:
 

/H/ Specification of a host / SAP router (IP address or host name) follows

/S/ Specification of a TCP port to be used in this SAP router / host (optional 
denominator/parameter) follows

/P/ Specification of a password to be handed over to this SAP router / host for
identification follows (optional denominator/parameter)
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The following example illustrates how an XPR server can reach its SAP 
application server via a WAN connection with two SAP routers.

Example:
 

In this example the associated router connect string results in:

/H/10.12.41.55/H/140.12.41.56/S/3290/H/10.32.15.48

Indication of a router connect string is later required for e.g. logging on to an SAP 
application server.

XPR Server SAP Router
IP Address: 10.12.41.55

SAP Router
IP Address: 140.12.41.55
TCP Port:    3290

SAP R/3 System
IP Address: 10.32.15.48

WAN

LAN

LAN



03-SAP-Konzept.fm

Technological Concepts

Unified Messaging via SAPconnect

A31003-S2370-M103-4-76A9, 10/2014
OpenScape Xpressions V7 SAP R/3 Gateway, Installation and Administration Manual 39

          

3.2  Unified Messaging via SAPconnect

NOTE:
Since the introduction of SAP Basis 7, SAPconnect has not been officially 
supported any more. Fax and SMS messages have eversince been exchanged 
with external systems via the SMTP interface of the SAP system.

The information in this chapter is structured as follows:

• Address Formats and ANI Hits

• User Profile Replication.

3.2.1  Address Formats and ANI Hits

For sending messages between the XPR server and SAP R/3 system, you must 
comply with addressing conventions that depend on the service to be transmitted.

The following table shows the formats used in this context:
 

Direction XPR Service SAP Service Format Example

from the SAP system
to the XPR server

FAXG3 FAX DE 02404/901-100 or also DE02404901100

SMTP INT support.alsdorf@cycos.com

SMS PAG* SMS:01725121314 or also D2:01725121314

Fax G3 polling FAX DE02404901100 with the send attribute
’Answer required’

all services INT NVS:<service>/<address>@<XPR Server Domain>
e.g. NVS:voice/492404901200@cycos.com

from the XPR server
to the SAP system

SMTP** INT SAPR3<SN***>/INT/support.alsdorf@cycos.com

FAXG3/FAXG4 FAX SAPR3<SN>/FAX/DE02404901100

SMS PAG SAPR3<SN>/PAG/SMS:01725121314

Table 3 Address Formats for XPR and SAP Services
* Available from SAP R/3 version 4.6
** The XPR server can rout all offline messages via SMTP
*** Short name, as configured with the SAPR3 APL configuration

(cf. Section 5.1, “SAPR3 APL”, on page 266)
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ANI hit under SAP R/3

Under SAP R/3 specific workflows can be controlled on the basis of the originator 
calling number of an incoming call. For this the calling number transmitted to SAP 
R/3 must be compared with the known calling numbers of the contact data saved 
under SAP R/3. Subsequent to a calling number match (inbound ANI Hit), a 
defined workflow can be started.

To achieve a calling number match in such a scenario at all, two preconditions 
must, among other things, be fulfilled:

• the phone numbers saved under SAP R/3 must be continuously available 
in a defined phone number format and

• the originator calling numbers passed on to SAP R/3 by the XPR server 
must have a format that corresponds to the storage format under SAP R/
3.

In this context, the address formats used by the XPR server and SAP R/3 are of 
note. Depending on the R/3 version, SAP R/3 uses up to three different database 
fields, which are allocated with a specific calling number format each. 
Corresponding to their phone number format these three fields are called: Edited 
Format, Compressed Canonical Format and Given Number Format. These 
formats were implemented in SAP R/3 in the sequence mentioned, with already 
existing implementations being maintained. This means that an R/3 version 
supporting the Given Number calling number format automatically implements 
the two previous formats as well.



03-SAP-Konzept.fm

Technological Concepts

Unified Messaging via SAPconnect

A31003-S2370-M103-4-76A9, 10/2014
OpenScape Xpressions V7 SAP R/3 Gateway, Installation and Administration Manual 41

          

The following table describes the use of these fields and formats in the XPR 
server and under SAP R/3.
 

SAP Format (Field) Use under SAP Use in the XPR Server Format Example

Edited Format Database field that can be 
arbitrarily edited by SAP users.

– DE 02404 / 901-999

Given Number Format Is used with SAP R/3 version 4.0 
and 4.5.
After the first manual search for 
the associated database entry, 
the calling number transmitted 
by the remote server is saved in 
the transmitted format. With this, 
remote server specific SAP R/3 
notations can be ’learned’.

Was used by the SAPPhone 
APL in earlier XPR versions.

+49 (2404) 901-999
02404901999

Compressed Canonical Format Has been used with patches 
since SAP R/3 version 4.6B.
This database field is 
automatically filled in with the 
associated, normalized format 
when the ’Edited Format’ field 
has been newly allocated or 
changed.
This field is used for the inbound 
ANI Hit.

Is used by the SAPPhone 
APL in the present XPR 
version.

+492404901999

Table 4 SAP Phone Number Formats
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3.2.2  User Profile Replication

No user information can be replicated between the XPR server and SAP R/3 via 
the SAPconnect interface. Since SAP users must also be maintained in the XPR 
server up to a certain degree for enabling an XPR-SAP integration, there is the 
question of how to transfer information between both systems.

There are currently four options for realizing a user profile synchronization:

• Manual user maintenance in the XPR server and in SAP R/3

• Use of a centralized user administration

• Use of a default user in the XPR server via who all SAP users can send 
messages

• Activating the ’AutoLearn’ mode

In the following sections we will take a closer look at these alternatives.

3.2.2.1  Manual User Maintenance

The parallel, manual maintenance of user profiles in the XPR server and in SAP 
R/3 is the most time consuming way of synchronizing all necessary user settings 
between XPR server and SAP R/3. It may be useful in a small test environment 
but this method is otherwise considered inadequate, especially for productive 
systems.

3.2.2.2  Centralized User Maintenance

Centralized solutions for system-spanning user administration is often used in 
complex system environments. In such a realization there is a central user 
database the contents of which can be retrieved by all authorized systems. This 
information exchange is based on a directory protocol such as LDAP.

The XPR server as well as SAP R/3 support such an LDAP connection in the form 
of an LDAP client.
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3.2.2.3  XPR Server Default Users

In the DefaultUser [REG_SZ] registry value of the XPR server a user name can 
be entered via which all messages of SAP users unknown in the XPR user 
database are sent. Trouble-free operation of this method requires of course that 
the default user has previously been created in the XPR server with the 
corresponding privileges.

Such a realization represents an interesting solution for sending messages from 
SAP R/3. However, this scenario can cause problems when the XPR server 
receives a reply to a message sent in this way. 

With reply reception, two different cases can occur here:

• The incoming message has been sent to the address of the original SAP 
user.

• The incoming message has been sent to the address of the default user.

Let's take a closer look at these two cases.

Personal address of the original SAP user

Since the respective SAP user is unknown in the XPR database, the XPR server 
cannot route the incoming message to the actual recipient. In this case you can 
use the SAP inbound routing rules of the XPR server MTA to define the logical 
line of the XPR server where undeliverable messages are to be routed to1. With 
this solution we assume that at least the following system can identify the 
addressed recipient.

You find continuative information about the MTA routing rules in the OpenScape 
Xpressions Server Administration manual.

Address of the default user

If a message is directly sent to the address of the default user, a selective mail 
delivery is possible neither in the XPR server nor in the SAP R/3 system. A 
message addressed in this way can merely be routed to the postmaster of the 
XPR server or of the SAP R/3 system. In the latter case the routing rules in the 
MTA must be employed here as well1.

You find continuative information about the MTA routing rules in the OpenScape 
Xpressions Server Administration manual.

1. Note that you need to adapt the SAP inbound routing rules for the selection of the correct logical 
XPR line before you can use them.
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3.2.2.4  XPR Server ’AutoLearn’Mode

An improved 'AutoLearn' mode has meanwhile been implemented in the SAPR3 
APL. This mode makes sure that for an SAP user, of whom the XPR server 
receives a message for transmission, a user profile is automatically defined and 
possibly supplemented in the XPR user database.

Prerequisite for this is that the corresponding formats in the SAP node settings 
are correctly transferred to the XPR server. Furthermore, the originator data of the 
respective SAP user must be correctly filed in the SAP system for the individual 
services.

The following three illustrations explain the ’Autolearn’ function.

Outgoing messages of a previously unknown user

Within the cycle of an outgoing message, ’Autolearn’ can define new users still 
unknown in the XPR server, who can thus not receive any incoming messages 
yet. The following figure shows which stages are passed through in this case.
 

1. A user, still unknown to the XPR server, creates, for example, a new fax 
message under SAP. As soon as he/she sends it, the message is forwarded 
to the SAPconnect interface and routed to the XPR server.

XPR Server SAP R/3

 User Database

 User Entry

 SMTP Address

 FAX Address

PAG Address

User Name

SAPR3 APLMTA

 User Database

 User Entry

User Name

PREFERRED=SAPR3[S N]

SAPR3[SN]:
 Fax Address

FAX Address

SMTP Address

SMS Address(3)

Sending Fax
Message

Fax Message
Created(5) SAPconnect (1)(2)(4)
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2. The SAPconnect interface of the SAP R/3 system sends the message to the 
XPR server along with the SAP user name and the originator’s fax address.

IMPORTANT:
The SAP user ID of the originator sending from SAP R/3 is never passed on 
to the XPR server with the object sent. As replacement, the associated XPR 
user name is composed in the ’AutoLearn’ mode of the first and second name 
configured in SAP.
In compliance with the interface description, both values in the sent object are 
merely optional but should, according to SAP, always be set, since at least the 
second name is a ’necessary value’ with defining an SAP user.
Consequently, no more independent user profiles are defined in the 
’AutoLearn’ mode in the XPR user database for each message service used.
Note that if two users with the same first and second name existed in SAP R/
3, only one user would be defined in the XPR user database. Therefore make 
sure that the corresponding information in SAP R/3 is unique.
From the user name thus generated in the XPR server, the XPR user ID 
(CLASS denominator) is automatically created for the new user profile.

3. Based on the transmitted SAP user name the SAPR3 APL searches the XPR 
user database. It does not find an entry though, since the SAP user is still 
unknown to the XPR server. ’Autolearn’ now becomes active and generates 
a new user in the XPR user database. It stores the user name and the 
originator fax address in the associated database fields and assigns 
optionally specified default values to the new profile (cf. Section 3.2.2.4, 
“Default Values for new User Profiles”, on page 50).
Furthermore, ’Autolearn’ sets the PREFERRED field of the new user to 
SAPR3[SN1] and enters the originator fax address in the SAPR3[SN] 
database field in the format FAX/+[normalized R/3 originator fax number].

4. Subsequently, the SAPR3 APL passes the fax message on to the MTA in 
charge of routing the message.

5. The MTA executes the switching operations configured in the XPR server and 
transfers the fax message via the XPR server APL in charge.

The described ’Autolearn’ mechanism does not only work with sending fax 
messages but also with other message types in the same way. For example, with 
an SMTP message, ’Autolearn’ uses an SMTP address for generating a user 
profile instead of a fax address.

1. Short name , as configured with the SAPR3 APL configuration.
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Outgoing messages of a user already known

If an SAP user with a profile in the XPR user database sends a new message, 
’Autolearn’ is no longer required to define a new user profile. In this case its task 
is to supplement the already existing profile with new user information if available.

Supposing the user in the above example sends a short message after the fax 
document, ’Autolearn’ will be able to recognize the SMS originator address 
appearing for the first time and to assign it to the previously created profile. This 
assignment is possible as the SMS originator address occurs in combination with 
the user name.

IMPORTANT:
Since the user described here has a profile in the XPR database already, the new 
address is merely copied to the respective database field. The PREFERRED field 
remains unchanged.
Consider this when users already known are to be adapted to message reception 
under SAP R/3. Such a case requires the manual adjustment to the logical line to 
the SAP system.

After sending this second (short) message, the user profile in our example 
contains a fax as well as an SMS address.

This mechanism applies to each message type used for the first time by the 
individual SAP user. Thus the more addresses are used by the individual SAP 
user, the more will be copied to his/her XPR user profile.

IMPORTANT:
By default, the XPR server does not override address information already entered 
in the XPR database. If this behavior is desired, the OverwriteUserData 
[REG_DWORD] registry value must be set. This value can be set globally for all 
SAP R/3 systems as well as individually for each system.

Now that ’AutoLearn’ has the previously unknown SAP user defined in the XPR 
server and assigned him/her a fax and an SMS address, incoming fax and short 
messages can be routed to him/her. This is dealt with in the following section.
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Incoming messages

How are messages routed to an SAP user in the XPR server? Let's take a look at 
the following figure to follow the routing process of an incoming SMS message. 
We assume that for the addressed user the fax and SMS address have been 
learned via ’Autolearn’.
 

1. Via an XPR server APL the incoming short message is routed to the MTA. 
This agent performs first routing operations.

2. In the next step the MTA looks for a user with the addressed SMS address in 
the XPR server user database. The agent finds him/her and comes in the 
associating profile upon an SAPR3[SN] entry in the PREFERRED field 
whereupon it will forward the short message to the SAPR3 APL (step 4).

3. First, however, it follows the PREFERRED entry and finds the entered fax 
address of the SAP user in the associated SAPR3[SN] database field.
We remember: This field was filled in with the first originator address of the 
first message sent. Since this was a fax message we find a fax address here. 
If the SAP user had sent an SMS message first, ’AutoLearn’ would have 
come upon the user’s SMS address at this point.

4. With this information it forwards the short message to the logical line 
SAPR3[SN] of the SAPR3 APL.

5. Before the SAPR3 APL can rout the short message to the correct user, it must 
find the user associated to the fax address handed over by the MTA. For this 
purpose, the SAPR3 APL searches the XPR user database for an entry with 
just this fax address.

6. The SAPR3 APL finds the corresponding user profile and reads out the 
previously learned address of the required message type - in our example the 
associated SMS address.

7. With this SMS address the SAPR3 APL transmits the short message to the 
SAPconnect interface after having converted the target address in a valid 
SAP R/3 format.

XPR Server SAP R/3

 User Database

 User Entry

 SMTP Address

 FAX Address

PAG Address

User Name

SAPR3 APLMTA

 User Database

 User Entry

User Name

PREFERRED=SAPR3[S N]

SAPR3[SN]:
 Fax Address

FAX Address

SMTP-Adresse

SMS Address

(2)

Ingoing SMS
Message

Delivering Fax
Message

(1) SAPconnect (9)(7)

(8)

(5)(3)

(6)

(4)
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8. After the SAPconnect interface of the SAP system has received the new 
message, the associated user is determined in the SAP system on the basis 
of the transmitted SMS address.

9. Subsequently, the short message is sent to the SMS inbox of the addressed 
SAP user.

Limits of the ’AutoLearn’ mode

’Autolearn’ cannot completely make up for the missing user database replication.

Suppose the user who has just received the short message had not previously 
sent a short message from within SAP R/3.

Let's take a look at the following figure:
 

XPR Server SAP R/3

 User Database

 User Entry

SMTP Address

 FAX Address

PAG Address

User Name

SAPR3 APLMTA

 User Database

 User Entry

User Name

PREFERRED=SAPR3[S N]

SAPR3[SN]:
 Fax Address

FAX Address

SMTP Address

SMS Address

(2)

Incoming Short
Message

Delivering Fax
Message

(1) SAPconnect

X
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Since ’Autolearn’ has not assigned an SMS address to our user as he/she did not 
previously send a short message, the MTA search for this address fails in step 2. 
Consequently, the incoming message cannot be routed and the routing rules 
configured in the XPR server for this case take effect. In most cases, messages 
that cannot be delivered to the addressed person in the XPR server are routed to 
the XPR server postmaster.

NOTE:
The way undeliverable messages are handled in the XPR server can be individ-
ually determined by routing rule configuration in the XPR monitor. These rules are 
defined under the MTA settings.
At this stage the use of the SAP inbound routing rules in the XPR server MTA can 
be useful. They determine that undeliverable messages are automatically 
forwarded to the SAPR3 APL. Note that you need to adapt the SAP inbound 
routing rules for the selection of the correct logical XPR line before you can use 
them.

This shows:

Before an incoming message of a specific type can be delivered from the XPR 
server to an SAP system,

• the SAP user to be addressed must either have previously sent a 
message of the same type or

• the field of the respective service in the XPR server user database must 
have already been set in another way.

Since the XPR server enables replication with the central user databases, user 
identification under the application of ’AutoLearn’ and with sending from R/3 will 
work in the cases in which the SAP originator addresses match, for example, 
those in Active Directory. Message transmission via the XPR server is thus 
ensured.
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Default Values for new User Profiles

As already described, ’Autolearn’ is able to define new user profiles in the XPR 
server user database. Specific database fields can be default set via the 
corresponding entries in the XPR registry. These entries are made in the registry 
value AutoLearnEntries [RegMultiSZ] under the key 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\PP-
COM\MRS\SapR3Apl\System[x].

NOTE:
If you perform settings in the AutoLearnEntries [RegMultiSZ] registry value for the 
first time, you first need to define this value in the registry if necessary.

The format of each entry is <Identifier>=<Value> , with <Identifier> defining the 
respective database field and <Value> the desired default value for this field.

Creating users newly learned by ’Autolearn’ as actual users and not only as 
contact requires at least the definition of the following database fields and their 
default values in the registry:

• GROUP=USER

• PASSWORD=xxxxxxxx1.

Further database fields for which defining a default value can be useful are:

• FAXSTATIONARY

• COSTINFO

• FAXG3-HEADLINE

• FAXG3-HEADLINE.

1. The password must be entered in the registry in encoded form. Copy it by ’Infotool’ from an ac-
count with known password and paste it in the registry editor.
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The following table lists all fields of the XPR user database automatically 
maintained by ’AutoLearn’ upon transmission of the corresponding message from 
within SAP R/3.
 

The following figure shows an example of a configuration of the AutoLearnEntries 
[RegMultiSZ] registry value:
 

For more information on registry keys see Chapter 6, “Registry Values”.

Fax Message E-Mail SMS /Pager Message

FAXG3 — —

FAXG3-HEADLINE — —

FAXG3-ID — —

FAXG4 — —

FAXG4-ID — —

PREFERRED PREFERRED PREFERRED

SAPR3[SN*]

* Short name, as configured with the SAPR3 APL configuration (cf. Function Reference in Section 
5.1, “SAPR3 APL”, on page 266)

SAPR3[SN ] SAPR3[SN ]

— — SMS

— SMTP —

NAME**

(corresponds to user name)

** The XPR user name consists of the first and second user name configured in SAP. From the user 
name thus generated in the XPR server, the XPR user ID (CLASS denominator) is automatically 
created for the new user profile.

NAME
(corresponds to user name)

NAME
(corresponds to user name)

Table 5 AutoLearn-maintained XPR Database Fields
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3.3  Notes for an Environment with several Clients

In an XPR-SAP integration with several clients the following applies for the 
definition of RFC destinations, CPIC users etc. in SAP R/3:

• RFC destinations depend on clients
 In an environment with several clients an individual RFC destination must 
therefore be defined in each client that communicates via RFC. For the 
various RFC destinations, different program IDs must be used.

• CPIC users depend on clients
 In an environment with several clients an individual CPIC user must 
therefore be defined in each client that communicates via RFC. Name 
and password of the different CPIC users may be identical.

• SAPconnect nodes depend on clients
In an environment with several clients an individual SAPconnect node 
must therefore be defined in each client that communicates via the 
SAPconnect interface. Apart from the RFC destination, the attributes of 
the different nodes may be identical.

• SAPconnect jobs depend on clients
In an environment with several clients an individual SAPconnect job must 
therefore be defined for handling the send processes in each client that 
communicates via the SAPconnect interface.

In an XPR-SAP integration with several clients the following applies for the 
configuration in the XPR server:

• For each client an outgoing RFC destination of type R must be defined. 
Such RFC destinations are configured in the saprfc.ini under [RFC-
SERVER].

• For all clients of an SAP R/3 system a common, incoming RFC 
destination of type A can be used. This RFC destination is configured in 
the saprfc.ini under [RFC-CLIENT].
If the clients are distributed among different SAP R/3 systems, a 
corresponding RFC destination must be defined for each SAP R/3 
system.
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Installation

4  Installation

This section provides information on the following setup topics:

• Installation and Configuration Requirements

• Installing the SAPGUI

• Configuring a Connection to an SAP Application Server

• Installing SAP APLs on the XPR Server

• Configuring Unified Messaging via SAPconnect

• Configuring Unified Messaging via SMTP Interface

• Configuring CTI via SAPphone
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4.1  Installation and Configuration Requirements

4.1.1  SAP Component Requirements 

To install the SAP system you need the following information:

• The SAP system ID
(corresponds to the three letters of the system name)

• The application server’s IP address or the host name, verifiable by the 
DNS

• The SAP client number

• The SAP system number
(specifies among other things the last two ciphers of the TCP port for 
which the corresponding gateway service of the SAP application service 
has been configured. Is in most cases value 00)

• The Router Connect String for reaching the application server.

Furthermore you need:

• An SAP user account with sufficient system privileges
(for the SAP configuration we recommend using a user account with full 
administrative privileges – thus SAP_ALL or SAP_NEW).

We assume at this point a running TCP/IP connection between the XPR server 
and the desired SAP application server, so that a connection to the SAP 
application server can later be established. This includes the proper configuration 
of available firewalls and SAP routers.
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4.1.2  XPR Server Requirements 

For the XPR server configuration the following requirements apply:

• For using the SAPR/3 APL, SAPTENANT licenses must have been 
implemented in the XPR server. The XPR server must have at least as 
many of these licenses as clients access the XPR server via the SAPR/3 
APL.

Furthermore you need:

• An XPR user account with full administrative privileges.
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4.2  Installing the SAPGUI

This section describes the installation of the SAPGUI – the graphical SAP user 
interface. All required installation steps will be dealt with in detail.

The integration of XPR services in SAP R/3 requires the installation of the 
SAPGUI on the XPR server for three reasons:

• The SAPR3 and/or SAPPHONE APL installation on the XPR server 
requires the routine library LibRFC32.dll. If this library is not present, 
the option for installing the SAP APLs in the XPR setup is not available.

• Along with the SAPGUI installation the TCP ports significant for SAP are 
reserved in the Windows system file Services of the XPR server 
system.

• The SAPGUI is required for the SAP application server configuration.

NOTE:
For SAPGUI access to an SAP system applies:
A new SAPGUI client version may access an older SAP R/3 version if the corre-
sponding option has been set; an old SAPGUI client version, however, may not 
access a new SAP R/3 version.

How to install the SAPGUI:

1. Start the SAPGUI installation file setup.exe on the XPR server.

2. Confirm the welcome dialog of the setup wizard with Next.
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3. In the following dialog determine the target folder to which the SAPGUI files 
are to be copied and confirm your selection with Next.
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4. Select the components to be installed. Select here at least the following 
components and continue the setup with Next.

• SAPGUI (as main component) and

• CRM Add-On (for later testing of CTI functions in the IC).

IMPORTANT:
Also select the R/3-Add-On option, if the SAPGUI is available in a more 
recent version than the SAP R/3 environment.

 

5. Answer the installation prompt with Install.

6. Confirm the dialog for completing the installation with Finish.

The SAPGUI is now installed on the XPR server.
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4.3  Configuring a Connection to an SAP Application Server

So that the SAP application server can be configured, access to the desired SAP 
server system must first be established. This requires:

• The SAP system ID

• The application server’s IP address or the host name, verifiable by the 
DNS

• The SAP client number

• The SAP system number

• The Router Connect String for reaching the application server

• An SAP user account with sufficient system privileges

If you do not know some of the specifications required here, please consult the 
SAP system administrator in charge.

Establishing the SAPGUI connection to the SAP application server

Now that all required items of information are present, the connection to the 
desired SAP server can be established. Proceed as follows:

1. Start the already installed SAPGUI under Start > Programs > SAP 
FrondEnd > SAPlogon.

2. Select the New button to define a new system.
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3. In the Description field enter the system name for the new SAP system.
 

NOTE:
For clarity we recommend specifying the SAP system ID here.

4. In the Application Server field enter the new SAP application server’s IP 
address or the host name, verifiable by the DNS.

5. In the SAP Router String field enter the Router Connect String of the new 
SAP application server.

6. Under SAP System select the SAP version applicable for the new system.

7. In the System number field enter the system number of the new SAP 
application server.

8. Confirm your specifications with OK.
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9. In the log-on dialog select the SAP application server you want to connect to 
and push Logon.
 

 

Now you have successfully configured the connection to the SAP application 
server required for the following configurations.
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4.4  Installing SAP APLs on the XPR Server

IMPORTANT:
For the following installation and later configuration of the SAPR3, SAPphone 
and SAProute APL, an SAP client must first be installed on the XPR server 
system. Perform the installation steps from Section 4.2, “Installing the 
SAPGUI”, on page 56 for this purpose.

To install the SAP APLs on the XPR server, either perform a complete XPR server 
reinstallation or a server update.

1. Start in both cases the setup.exe from the XpressionsInstall directory 
of the setup medium. Follow the general installation instructions in the Server 
Installation manual.

2. In the Select Features setup dialog select the CRM/ERP Integration option 
in addition to the otherwise required components. This is used to install the 
SAPR3 and SAPphone APL for the SAP R/3 interfaces SAPconnect and 
SAPphone.
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3. Furthermore, select the Web service provider option under Services to 
install the XML APL (ICI interface).
 

4. Continue the setup as described in the general XPR server installation 
instructions.

Configuration of the SAP APLs is not part of the XPR server installation and is 
therefore described in the corresponding sections of the installation chapters to 
follow.
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4.5  Configuring Unified Messaging via SAPconnect

This section describes the concept of an XPR-SAP integration via the 
SAPconnect interface and its configuration in the XPR server and SAP system.

The below user interfaces of the various SAP R/3 versions are very different from 
each other. Therefore, we cannot document a version-spanning user guide for the 
configuration steps at this point. The SAP system configuration section in this 
manual consists of three parts:

• Configuration under CRM Version 3.1 (Basis 6.20)

• Configuration under SAP R/3 Version 4.6C

• Configuration under SAP R/3 Version 3.1i.

For the following configuration we assume a running SAP system and an XPR 
server with installed SAPR3 APL. Furthermore, the XPR client application 
Communications must be installed on the XPR server. This application is later 
used for user profile maintenance in the XPR server.

First, however, some information on the conception of an SAPconnect connection 
will be given.
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4.5.1  Communication Structure of SAPconnect

The following figure provides an overview of the communication structure via the 
SAPconnect interface:
 

With the SAPGUI the Windows program library LibRFC32.dll is installed on 
the XPR server. It provides the RFC communication interface, required for 
message exchange between the XPR server and the SAP system. This transport 
layer obtains its configuration parameters on the XPR side from the 
saprfc.ini, which contains all information for communication with the SAP 
system.

The SAPR3 APL communicates with the SAP gateway server of the SAP 
application server via the RFC transport layer, using the CPI-C user. On this, the 
SAPR3 APL uses a logical connection on the SAPconnect interface, specified by 
the program ID on both sides.

The XPR server access to the SAP system is authenticated via the user privileges 
of the CPIC user in SAP R/3.
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4.5.2  General Integration Concept

An XPR-SAP integration via SAPconnect is used, as already mentioned, in 
Unified Messaging environments. In the following we will describe and configure 
a corresponding solution for the integration of fax messages in SAP R/3.

Scenario

Many companies would like to simplify fax message traffic. Since fax devices are 
still often used, the desire for simplification can be well understood.

The following scenario is the solution. For, in and outgoing fax messages can be 
directly handled by any SAP user at his/her SAP workstation. This is enabled by 
the integration of the Unified Messaging services of the XPR server into the SAP 
user interface. Since information usually only needs to be printed out for classic 
fax transmission via a fax device, sending fax messages directly from a PC saves 
time and money.

In many cases, only sending faxes from SAP R/3 is desired. The fax messages 
received in this case are then processed by another e-mail system, which may 
also be connected to the XPR server. Common company platforms such as MS 
Exchange or Lotus Notes are supported.
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How the Unified Messaging solution works

Our system consists of two main components. One component is the XPR server, 
which provides the connection to the public telephone network via a PBX. The 
other component is the SAP system, with which the XPR server communicates 
via an SAPconnect interface, and to which the SAP user is logged in via the 
SAPGUI of their PC work centers.

The following figure provides a simplified overview of the way our Unified 
Messaging example scenario works. You will find a more detailed description of 
message routing via the SAPconnect interface in Section 3.2.2.4, “XPR Server 
’AutoLearn’Mode”, on page 44.
 

Let's see how a fax message is routed to the SAP user Joe Green:

1. An external subscriber sends a fax message to our SAP user. The fax 
transmission is accepted by the PBX, which has been configured for the 
extension range -100 to -199 with forwarding to the XPR server.

2. If the XPR server receives the fax message from the connected PBX via its 
ISDN APL, it looks for the corresponding recipient based on the fax number -
125 in the XPR user database.
The addressed user is in our case an SAP user who is to receive his/her fax 
messages under SAP R/3. Therefore, a logical connection via the SAPR3 
APL (PREFERRED=SAPR3[KN]) has been entered in his/her XPR user 
profile as preferred address.

3. The incoming fax message is consequently transmitted by the XPR server to 
the SAP system as copy.

4. SAP R/3 now looks for an SAP user with the requested fax number and finds 
Reiner Wagner. The SAP system then accepts the message.
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5. Finally, the SAP user Reiner Wagner is informed about the arrival of a new 
message and he can now access the message via his SAP inbox.

The message, still available on the XPR server, is automatically deleted after 
expiration of a storage period configured in the XPR server. In the SAP system 
the message is present until the SAP user deletes it.

If an SAP user sends a fax message from within the SAP system, the new 
message is passed on to the XPR server by the SAP system in one of the 
system’s cyclic transmissions. The server sends the message via the PBX and 
the public telephone network to the recipient. Subsequently, the XPR server 
returns a send confirmation or an error message to the SAP system, which is then 
delivered to the SAP user who has sent the message.

In the course of the next sections we will configure this scenario with the 
SAPconnect interface. The following flow chart provides a first overview of the 
steps required and described in detail on the pages to follow.

The following configuration steps are based on the basic configuration of the 
above XPR-SAP integration, which does not consider any system redundancies 
etc.
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After this first overview we start configuring the communication between the XPR 
server and the SAP system.
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4.5.3  Configuring the XPR-SAP Communication

In this section we will perform all XPR server and SAP system configurations 
required for the RFC communication between the two systems.

This part is divided into the following sections:

• Configuration under CRM Version 3.1 (Basis 6.20)

• Configuration under SAP R/3 Version 4.6C

• Configuration under SAP R/3 Version 3.1i

• Configuring the SAPR3 APL.
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4.5.3.1  Configuration under CRM Version 3.1 (Basis 6.20)

In the following the configuration steps under the SAP version CRM 3.1 are 
documented.

Creating a virtual CPI-C user in SAP R/3

1. Log on to the previously configured SAP application server via the SAPGUI.

2. Enter the transaction code /nSU01 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option SAP menu > 
Basis Tools > Administration > User Maintenance > Users with a 
doubleclick.
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3. In the User field enter a user name for the virtual CPI-C user and push the 
Create icon in the toolbar.
 

NOTE:
We recommend to select a ’speaking’ name – for example MRS-CON or 
MRS-CPIC.
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4. In the Last name field of the Address tab enter a name for the user.
 

NOTE:
We recommend copying the user name at this point.

5. In the Language field select the desired language option. This specification 
will influence log outputs on RFC level at a later date.

6. Switch to the Logon data tab.
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7. Assign a Password to the user and select the Communications option as 
User Type.
 

IMPORTANT:
Note that SAP R/3 differentiates upper and lower case with password entries.

NOTE:
Depending on the SAP version the CPI-C user type is also called CPIC user 
(through SAP R/3 4.6C) or system user (after SAP R/3 4.6C).

8. Switch to the Profiles tab.
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9. In the table under Profile enter the user profile S_A.SCON and confirm the 
entry with the enter key of your keyboard.
 

NOTE:
You can also grant full SAP system privileges (SAP_ALL, SAP_NEW) to the 
virtual user. Since the user type CPI-C is selected, there is no way you can 
log in to the SAP system from outside via this user profile. In this way abuse 
of the granted privileges is prevented.

10. Save the settings for the virtual user with the Save icon in the toolbar.

Now you have created the virtual user MRS-CPIC who will later be used for 
communication between the XPR server and the SAP application server.

We will now continue with configuring the RFC destination.
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Defining an RFC destination in SAP R/3

1. Push the F3 function key to return to the SAP Easy Access Extended 
Relationship Management.

2. Enter the transaction code /nSM59 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option SAP menu > 
Basis Tools > Administration > Administration > Network > RFC 
Destinations with a doubleclick.
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3. Select TCP/IP connections and push the Create button.
 

4. Assign a name to the RFC destination in the RFC destination field.
 

NOTE:
We recommend choosing a name of the structure SAPCONNECT_<CPIC-
user>_<client number> to enhance clarity. In our example it is 
SAPCONNECT_MRS-CPIC_200.

5. Enter letter T in the Connection type field to configure a TCP/IP connection.

6. Enter a short description for the RFC destination in the Description field.

7. Save the RFC destination settings with the Save icon in the toolbar.
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8. In the Technical settings tab select the Registered Server Program option.

 

NOTE:
This setting informs the SAP application server that an external RFC service 
will register with it with the program ID to be configured in the next step.
This configuration is directly associated with the TYPE=R parameter from the 
saprfc.ini of the XPR server (cf. Section 4.5.3.4, “Creating entries in the 
saprfc.ini”, on page 102).
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9. In the Program ID field assign a string for this logical link between the XPR 
server and the SAP application server.

IMPORTANT:
The program ID serves later for identifying the logical link. Therefore the 
string must be unique. Respect the use of upper and lower case when you 
enter it.

NOTE:
We recommend selecting a string of the structure UMS_<SAP system 
ID>_<client number> to enhance clarity. Accordingly, we select the program 
ID UMS_APC_200.

10. Save the settings with the Save icon in the toolbar.

11. Leave this SAPGUI entry form opened. We will use it again straight after 
configuring the SAPR3 APL of the XPR server for a first function test.

Continue with Section 4.5.3.4, “Configuring the SAPR3 APL”, on page 98.
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4.5.3.2  Configuration under SAP R/3 Version 4.6C

In the following paragraphs we will describe the configuration steps under SAP 
R/3 version 4.6C.

Creating a virtual CPI-C user in SAP R/3

1. Log on to the previously configured SAP application server via the SAPGUI.

2. Enter the transaction code /nSU01 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option User menu > 
Tools > Administration > User Maintenance > SU01–Users with a 
doubleclick.
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3. In the User field enter a user name for the virtual CPI-C user and push the 
Create icon in the toolbar.
 

NOTE:
We recommend to select a ’speaking’ name – for example MRS-CON or 
MRS-CPIC.
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4. In the Last name field of the Address tab enter a name for the user.
 

NOTE:
We recommend copying the user name at this point.

5. In the Language field select the desired language option. This specification 
will influence log outputs on RFC level at a later date.

6. Switch to the Logon data tab.
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7. Assign a Password to the user and select the CPIC option as User Type.
 

IMPORTANT:
Note that SAP R/3 differentiates upper and lower case with password entries.

NOTE:
Depending on the SAP version the CPI-C user type is also called system user 
(after SAP R/3 4.6C) or communication user (from SAP R/3 6.10 Basis).

8. Switch to the Profiles tab.
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9. In the table under Profile enter the user profile S_A.SCON and confirm the 
entry with the enter key of your keyboard.
 

NOTE:
You can also grant full SAP system privileges (SAP_ALL, SAP_NEW) to the 
virtual user. Since user type CPI-C is selected, you cannot log in at the SAP 
system via this user profile from outside. In this way abuse of the granted 
privileges is prevented.

10. Save the settings for the virtual user with the Save icon in the toolbar.

Now you have created the virtual user MRS-CPIC who will later be used for 
communication between the XPR server and the SAP application server.

We will now continue with configuring the RFC destination.
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Defining an RFC destination in SAP R/3

1. Push the F3 function key to return to the SAP Easy Access – User menu.

2. Enter the transaction code /nSM59 in the SAPGUI command line and confirm 
the entry, or select from the directory tree the menu option User menu > 
Tools > Administration > Administration > Network > SM59–RFC 
Destinations with a doubleclick.
 

3. Select TCP/IP connections and push the Create button.
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4. Assign a name to the RFC destination in the RFC destination field.
 

NOTE:
We recommend choosing a name of the structure SAPCONNECT_<CPIC-
user>_<client number> to enhance clarity. In our example it is 
SAPCONNECT_MRS-CPIC_200.

5. Enter letter T in the Connection type field to configure a TCP/IP connection.

6. Enter a short description for the RFC destination in the Description field.

7. Save the RFC destination settings with the Save icon in the toolbar.
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8. Push the Registration button.

NOTE:
This setting informs the SAP application server that an external RFC service 
will register with it with the program ID to be configured in the next step.
This configuration is directly associated with the TYPE=R parameter from the 
saprfc.ini of the XPR server (cf. Section 4.5.3.4, “Creating entries in the 
saprfc.ini”, on page 102).
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9. In the Program ID field assign a string for this logical link between the XPR 
server and the SAP application server.
 

IMPORTANT:
The program ID serves later for identifying the logical link. Therefore the 
string must be unique. Respect the use of upper and lower case when you 
enter it.

NOTE:
We recommend selecting a string of the structure UMS_<SAP system 
ID>_<client number> to enhance clarity. Accordingly, we select the program 
ID UMS_APC_200.

10. Save the settings with the Save icon in the toolbar.

11. Leave this SAPGUI entry form opened. We will use it again straight after 
configuring the SAPR3 APL of the XPR server for a first function test.
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Continue with Section 4.5.3.4, “Configuring the SAPR3 APL”, on page 98.
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4.5.3.3  Configuration under SAP R/3 Version 3.1i

In the following we will describe the configuration steps under SAP R/3 version 
3.1i.

Creating a virtual CPI-C user in SAP R/3

1. Log on to the previously configured SAP application server via the SAPGUI.

2. Push the Dynamic menu button.

3. Enter the transaction code /nSU01 in the SAPGUI command line and confirm 
the entry, or select from the directory tree the menu option SAP standard 
menu > Tools > Administration > Maintain users > Users with a 
doubleclick.
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4. In the User field enter a user name for the virtual CPI-C user and push the 
Create icon in the toolbar.
 

NOTE:
We recommend to select a ’speaking’ name – for example MRS-CON or 
MRS-CPIC.

5. In the Initial password field enter a password and its confirmation. 

6. Select the CPIC option as User type.

IMPORTANT:
Note that SAP R/3 differentiates upper and lower case with password entries.

NOTE:
Depending on the SAP version the CPI-C user type is also called system user 
(after SAP R/3 4.6C) or communication user (from SAP R/3 6.10 Basis).

7. In the table under Authorization profiles enter the user profile S_A.SCON 
and confirm the entry with the enter key of your keyboard.

NOTE:
You can also grant full SAP system privileges (SAP_ALL, SAP_NEW) to the 
virtual user. Since user type CPI-C is selected, you cannot log in at the SAP 
system via this user profile from outside. In this way abuse of the granted 
privileges is prevented.

8. Save the settings for the virtual user with the Save icon in the toolbar.

Now you have created the virtual user MRS-CPIC who will later be used for 
communication between the XPR server and the SAP application server.
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We will now continue with configuring the RFC destination.
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Defining an RFC destination in SAP R/3

1. Push the F3 function key to return to the SAP standard menu.

2. Enter the transaction code /nSM59 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option User menu > 
Tools > Administration > Administration > Network > SM95–RFC 
Destinations with a doubleclick.
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3. Select TCP/IP connections and push the Create button.
 

4. Assign a name to the RFC destination in the RFC destination field.
 

NOTE:
We recommend choosing a name of the structure SAPCONNECT_<CPIC-
user>_<client number> to enhance clarity. In our example it is 
SAPCONNECT_MRS-CPIC_200.
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5. Enter letter T in the Connection type field to configure a TCP/IP connection.

6. Enter a short description for the RFC destination in the Description field.

7. Save the RFC destination settings with the Save icon in the toolbar.

8. Push the Registration button.

NOTE: This setting informs the SAP application server that an external RFC 
service will register with it with the program ID to be configured in the next 
step.
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9. In the Program ID field assign a string for this logical link between the XPR 
server and the SAP application server.
 

IMPORTANT:
The program ID serves later for identifying the logical link. Therefore the 
string must be unique. Respect the use of upper and lower case when you 
enter it.

NOTE:
We recommend selecting a string of the structure UMS_<SAP system 
ID>_<client number> to enhance clarity. Accordingly, we select the program 
ID UMS_APC_200.

10. Save the settings with the Save icon in the toolbar.

11. Leave this SAPGUI entry form opened. We will use it again straight after 
configuring the SAPR3 APL of the XPR server for a first function test.
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Continue with configuring the XPR server SAPR3 APL in the next section.
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4.5.3.4  Configuring the SAPR3 APL

If the XPR server and the XPR monitor have not been started yet, start them and 
proceed as follows:

SAPR3 APL settings

1. In the modules window of the XPR monitor select the menu option Settings 
> SAPR3 APL > Set Options with a doubleclick.

2. In the dialog then open access the General Settings tab.

3. Push the Add button.
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4. In the Short Name field of the System tab specify a short name that will later 
serve message routing via the SAPR3 APL.
 

IMPORTANT:
The XPR server composes of SAPR3 and attaching this short name a logical 
line of the format SAPR3<short name>, via which messages can be routed 
between the XPR server and the SAP system. Therefore make sure that the 
short name is unique. The SAPR3 APL does not check for possible correla-
tions in this context.

NOTE:
We recommend using the SAP system ID.

5. In the Description field enter a short description of the SAP system that can 
be reached via this logical line.

6. Select the option Automatically establish the connection to this system 
by default, since the configured RFC connection is otherwise not established 
in the first place.
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7. Select the Activate ’autolearn’ mode and… option.

8. Switch to the Server tab.

9. Select the Destination from saprfc.ini option to copy the XPR configuration 
data for the RFC connection from the saprfc.ini.
 

10. Enter a name in the associated field that refers to the desired configuration 
data in the saprfc.ini configuration file.

IMPORTANT:
Owing to its referencing character make sure that this identifier clearly refer-
ences to the saprfc.ini.

11. Switch to the Client tab.
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12. Select the Destination from saprfc.ini option to copy the XPR configuration 
data for the RFC connection from the saprfc.ini.
 

13. Enter a name in the associated field that refers to the desired configuration 
data in the saprfc.ini configuration file.

IMPORTANT:
Owing to its referencing character make sure that this identifier clearly refer-
ences to the saprfc.ini.

14. In the Client field enter the client number to be used.

15. Copy the name of the virtual user previously created under SAP R/3 to the 
User field.

16. In the Password field enter the virtual user’s password configured under SAP 
R/3 and repeat the entry in the Confirm Password field.

IMPORTANT:
Please respect upper and lower case when entering the password.

17. Confirm your settings with Apply and push OK.

The direct SAPR3 APL settings are thus accomplished. Now we need to adjust 
the saprfc.ini configuration file.
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Creating entries in the saprfc.ini 

IMPORTANT:
The configuration file saprfc.ini must be stored in the <XPR Install>\bin\ 
directory by default.

Depending on whether you install an XPR-SAP integration for the first time or 
whether you extend an existing system, begin as follows:

First installation: 

1. Start the Windows editor and open a new document.

2. Save the new document in the <XPR Install>\bin\ directory on the XPR 
server and choose saprfc.ini as file name.

3. Continue with step 6 under Extension.

Extension: 

4. Open the already existing saprfc.ini file.

5. Verify that the names you have previously assigned to Destination from 
saprfc.ini (Server tab) and Destination from saprfc.ini (Client tab) are not 
yet used in the saprfc.ini.

6. Now perform, for example, for our scenario configured so far the following 
supplementations in the configuration file:

[RFC-SERVER]
DEST=APC-SRV
TYPE=R
PROGID=UMS_APC_200
GWHOST=/H/10.2.11.2/H/192.168.249.17/S/3299/H/192.168.249.52
GWSERV=sapgw00
RFC_TRACE=0

[RFC-CLIENT]
DEST=APC-CLT
TYPE=A
ASHOST=/H/10.2.11.2/H/192.168.249.17/S/3299/H/192.168.249.52
SYSNR=00
RFC_TRACE=0
ABAP_DEBUG=0
USE_SAPGUI=0

7. Stop the XPR SAPR3 APL service on the XPR server system and reboot it. 
This enables the SAPR3 APL to copy the new information from the 
saprfc.ini.

The SAPR3 APL configuration is thus accomplished. We will now test the 
configured RFC connection between the XPR server and the SAP system. This 
should be established successfully with the settings performed up to now.
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RFC connection test

1. Return to the last SAPGUI entry form and thus to the display of the RFC 
connection we have configured.

NOTE:
If you have inadvertently closed the SAPGUI, you can reach the RFC 
connection dialog via the /nSM59 transaction dialog. In there select your 
previously configured connection from the TCP/IP connections.

2. Push the Test connection button.

SAP R/3 displays the measured parameters for our RFC connection between 
the XPR server and the SAP application server. Communication from the 
SAP system towards the XPR server has obviously been established 
successfully.
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In case of an error the SAP system reports the termination of the connection 
test with the following message:
 

3. With a successful communication establishment the Physical Lines window 
of the XPR monitor also displays a constant link for the SAPR3 APL. Please 
check this.
 

If no trouble-free RFC communication from the XPR server to the SAP 
system can be set up, the Physical Lines window of the XPR monitor 
displays lines that attempt to build up in 10-second intervals. 
 

Communication from the XPR server towards the SAP system has thus also been 
successfully established.

We can now continue with the further system adjustment.
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4.5.4  System Adjustment of the XPR-SAP 
Environment

After successfully testing the basis configuration with the RFC connection, we 
continue with adapting the SAP system. These adjustments are required for 
message exchange between the XPR server and the SAP system.

This part is divided into the following sections:

• Adjustments under CRM Version 3.1 (Basis 6.20)

• Adjustments under SAP R/3 Version 4.6C

• Adjustments under SAP R/3 Version 3.1i

• XPR Server System Adjustments.

4.5.4.1  Adjustments under CRM Version 3.1 (Basis 6.20)

In the following we will describe the configuration steps for the system 
adjustments under CRM version 3.1.

Setting the communication methods

First we perform settings for the various communication methods. In doing so we 
define which message types are sent by SAP R/3 via the SAPconnect interface.

1. Push the F3 function key to return to the SAP Easy Access – User menu.
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2. Enter the transaction code /nSCON in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option SAP 
menu > Basis Tools > Business Communication > Communication > 
SAPconnect with a doubleclick.

 

3. In the Settings menu of the dialog now open select the communication 
methods option.
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4. Make sure that for each media type to be exchanged between the XPR server 
and SAP system the SAPconnect method is specified.
You can make alterations by selecting the respective field and subsequently 
choosing the associating selector icon.
 

5. Save the new settings with the Save icon in the toolbar.

IMPORTANT:
To modify these node-spanning settings a customizing job must exist or be 
newly created.

You have now configured the communication method. We will now continue with 
the format conversion settings.
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Format conversion settings

1. Push the F3 function key to return to the SAP Easy Access Extended 
Relationship Management.

2. Enter the transaction code /nSCON in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option SAP 
menu > Basis Tools > Business Communication > Communication > 
SAPconnect with a doubleclick.

3. In the Settings menu of the dialog now open select the Device Types for 
Format Conversion option.

4. If required perform special settings here.
 

Check the parameters configured here if you do not exclusively work with 
postscript or text output.

We recommend:

• for PCL: HPLJ4 or HPLJIIID as HP PCL 5 driver

• for PS: POST2 (in older R/3 versions, POST is available only)

5. Confirm your modifications with the OK icon in the dialog.

After configuring the format conversions we will now define a pager subtype for 
the SMS.
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Configuration of a pager subtype for SMS

The XPR server transmits inbound short/pager messages with a destination 
phone number of the format NVS:SMS/<phone number> to the SAP destination 
system. The SMS subtype must be defined there so that this message type can 
be correctly recognized in SAP R/3.

1. In the SAPGUI switch to project processing with the /nSPRO transaction 
code.

2. Select the SAP Reference IMG button.

3. Select the menu option SAP Implementation Guide > SAP Web 
Application Server > SAP Web Application Server > Basis Services > 
Address Management > Define pager services.
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4. In the table perform the following settings from left to right:
 

 

5. Save the settings with the Save icon in the toolbar.

IMPORTANT:
To modify these node-spanning settings a customizing job must exist or be 
newly created.

The SMS subtype, required for the configuration of the node under SAP R/3, is 
thus defined.

Pag. Service SMS

Pager service: <Short description of this entry>

Use: SMS-Service
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Setting the node

SAP R/3 administers externally activated systems in logical format as so-called 
nodes. With configuring such a node, specifications are made as regards e.g. for 
which address area the active system is in charge, or which data formats are 
supported by it.

How to configure the XPR server as SAP node:

1. Push the F3 function key to return to the SAP Easy Access Extended 
Relationship Management.

2. Enter the transaction code /nSCON in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option SAP 
menu > Basis Tools > Business Communication > Communication > 
SAPconnect with a doubleclick.

3. In the View menu of the dialog now open select the Node option.

4. Push the Create icon in the toolbar to define a new node.
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5. Enter a name for the new node in the Node field. The name must not exceed 
6 characters.
 

6. In the Description field enter a short description for the node respectively the 
active system.

7. Push Continue.

8. In the following dialog select the RFC Node option.

9. Push Continue.
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10. In the RFC Destination field enter the previously configured RFC destination, 
or open a selection list with a click on the selector icon at the end of the 
activated text field.
 

11. Push Continue.
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12. Select Fax as address type for the new node.
 

NOTE:
You can select only one address type (message service). After defining this 
type you can however configure further address types for this node in 
succession.
In the following we will describe the configuration of the address types Fax, 
Internet (SMTP) and PAGER (SMS). In the course of your system configu-
ration only select the address types that you want to use in your XPR-SAP 
environment.

13. Confirm your selection with Continue.
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14. Define the address area (calling number range) for which this node is to take 
on the routing.
 

The structure of the filter entries for the address area of type Fax is:
<country code><optional number string><optional wildcard character ’*’> A 
filter hit always occurs after the longest precise match.

Example: Address area=DE02402*
All fax messages beginning with the number string 492402 are handed over 
to this node by the SAP system. 

In our environment we want the fax messages of all calling numbers be 
passed on to the XPR server. Therefore we enter ’*’ as address area.

For the addressing schemes of the various addressing types compare 
Section 3.2.1, “Address Formats and ANI Hits”, on page 39.

15. Push Continue.
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16. Define the standard formats into which SAP R/3 converts internal document 
formats before they are passed on to the node.
 

IMPORTANT:
The conversion settings made here only concern some of the SAP - individual 
formats – namely SAPScript (SCR) and ABAP Listen (ALI). Further options 
are later accessible with the node maintenance.
Message attachments of all other formats are passed on to the node trans-
parently in the format present.

17. Push Continue.

18. In the next dialog select the Restrict send time option.
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19. Depending on three priority statuses specify send time restrictions for 
messages of this address type.
 

IMPORTANT:
The XPR server does not explicitly evaluate the start and end times specified 
here, but merely the priority status passed on with a message. The dedicated 
start times for sending messages of the individual priorities must be 
configured in the XPR server if needed.
Settings of any kind must be performed in this dialog so that the SAP system 
transmits the required status information with the message to the XPR server.

20. Push Continue.
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21. In the Country field specify the country code for the node location. This entry 
is required to determine the code for calling numbers.
 

22. Push Continue.

23. Answer the question whether to set further address types with Yes.
 

24. Push Continue.
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25. Next we configure the Internet address type. Select the Internet option in the 
following dialog.
 

26. Push Continue.
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27. Just like under the Fax address type, enter the address areas in the table for 
which SAP R/3 is to send e-mails to the XPR server for routing.
 

NOTE:
At this point you can use filter formats to configure an intelligent message 
routing via the XPR server.
With our configuration you can, for example, send an e-mail with the target 
address <cellphone number>@sms.mydomain.com to the XPR server, which 
transmits the information contained in the e-mail as short message into the 
public network.
By defining the corresponding routing rules/address conversions in the XPR 
server, the individual address structures are adapted to the common address 
formats.
You find continuative information on generating such routing rules in the 
OpenScape Xpressions Server Administration manual.

28. Push Continue.
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29. Define the standard formats into which SAP R/3 converts internal document 
formats before they are passed on to the node. Push Continue.

IMPORTANT:
The conversion settings made here only concern some of the SAP - individual 
formats – namely SAPScript (SCR) and ABAP lists (ALI). Further options are 
later accessible with the node maintenance.
Message attachments of all other formats are passed on to the node trans-
parently in the format present.

30. In the next dialog select the Restrict send time option.

IMPORTANT:
The XPR server does not explicitly evaluate the start and end times specified 
here, but merely the priority status passed on with a message. The dedicated 
start times for sending messages of the individual priorities must be 
configured in the XPR server if needed.
Settings of any kind must be performed in this dialog so that the SAP system 
transmits the required status information with the message to the XPR server.

31. Depending on three priority statuses specify send time restrictions for 
messages of the Internet address type. Push Continue.

32. Answer the question whether to set further address types with Yes. Push 
Continue.

33. Next we configure the Pager (SMS) address type. In the following dialog 
select the Pager (SMS) option and push Continue.



Installation

04-SAP-Installation.fm

Configuring Unified Messaging via SAPconnect

 A31003-S2370-M103-4-76A9, 10/2014
122 OpenScape Xpressions V7 SAP R/3 Gateway, Installation and Administration Manual

         

34. Just like under the Fax address type, enter the address areas in the table for 
which SAP R/3 is to send e-mails to the XPR server for routing.
 

35. Push Continue.

36. Define the standard formats into which SAP R/3 converts internal document 
formats before they are passed on to the node. Push Continue.

IMPORTANT:
The conversion settings made here only concern some of the SAP - individual 
formats – namely SAPScript (SCR) and ABAP lists (ALI). Further options are 
later accessible with the node maintenance.
Message attachments of all other formats are passed on to the node trans-
parently in the format present.
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37. In the next dialog select the Restrict send time option.

IMPORTANT:
The XPR server does not explicitly evaluate the start and end times specified 
here, but merely the priority status passed on with a message. The dedicated 
start times for sending messages of the individual priorities must be 
configured in the XPR server if needed.
Settings of any kind must be performed in this dialog so that the SAP system 
transmits the required status information with the message to the XPR server.

38. Depending on three priority statuses specify send time restrictions for 
messages of the Pager (SMS) address type.

39. Push Continue.

40. In the following dialog answer the question whether to set further address 
types with No.

41. Push Continue.
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42. Make an entry in the Hours and Minutes field to define how long SAP R/3 is 
to repeat the transmission of a message to this node. If the time set is 
exceeded, the originator is informed by a note that the message could not be 
delivered.
 

NOTE:
When you set the waiting period make sure that shorter maintenance works 
on the system do not lead to the message transmission being reported as 
failed to the respective SAP users.
We recommend to set the waiting period to at least three hours.

43. Confirm your settings with Continue.
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44. In the following dialog select none of the available options (Node can resolve 
path references and Node is to be monitored by the alert monitor).

45. Push Continue.

46. In the following dialog select the Node is ready for use option and save the 
settings with Continue.

The next window displays all information on the node just configured. 
Furthermore, you can check all settings made and modify them if required. By 
selecting one of the Set buttons you can reconfigure the respective address type 
or adapt parameters already set.
 

NOTE:
You reach this dialog via SAP menu > Basis Tools > Business Communi-
cation > Communication > SAPconnect (/nSCOT) under the menu option 
View > Nodes. Select one of the nodes listed there.

Now you have configured the logical node for connecting the XPR server via the 
SAPconnect interface. In the next section we will create an SAPconnect job.
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Job setting

In the background of SAP R/3 the SAPconnect job is in charge of sending ready-
to-transmit messages to external systems (nodes).

IMPORTANT:
The following job configuration must be performed under an SAP user with suffi-
cient system privileges, since otherwise it will probably not be executed as 
desired.
Since the privilege order under SAP R/3 is version-dependent, we recommend to 
perform the configuration under a user account with full administrative privileges.

How to configure a job:

1. Push the F3 function key to return to the SAP Easy Access Extended 
Relationship Management.

2. Enter the transaction code /nSCON in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option SAP 
menu > Basis Tools > Business Communication > Communication > 
SAPconnect with a doubleclick.

3. In the View menu of the opened dialog select the Jobs option.

4. Push the Create icon in the toolbar to define a new job.
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5. Enter a unique name in the Job name field and confirm your entry with the 
OK icon of the dialog.
 

6. Select the SAP&CONNECTALL version to have all message types sent by 
the new job. Then click Schedule job.
 

NOTE:
By selecting another job variant you can also generate SAP jobs with 
specified tasks. The SAP&CONNECTFAX version generates, for example, a 
job that merely transmits fax messages.
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7. In the Date and Time fields specify the first execution of the new job.
 

IMPORTANT:
Check the automatically generated entry in the Time field, which displays the 
start time of the job.
Since the SAP system waits with the initial start of the job until one hour after 
the job’s configuration, change the suggested entries to an earlier time.
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8. Select the Schedule periodically option and set the Repeat period in the 
now open dialog.
 

IMPORTANT:
A repeat period selected too short may overload the SAP application server 
and lead to performance losses in the SAP operation.
Useful is a setting between three to five minutes. In the end it is always a 
compromise between the desire to send a new message as quickly as 
possible, and not calling on the system for message transmissions too 
strongly.

9. Confirm your settings with the Create button.

Now you have defined an SAPconnect job for message transmission. The 
configuration of a postmaster account under SAP R/3 comes next.
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Postmaster configuration

SAP R/3 only accepts messages from external systems if message delivery to an 
SAP user is possible.

If a message is addressed to a user unknown in SAP R/3, the message is rejected 
in case of a missing postmaster account. If, however, such a postmaster has 
been configured for the respective message type, an otherwise undeliverable 
message can be routed to this configured postmaster account.

How to configure the required postmaster:

1. Push the F3 function key to return to the SAP Easy Access Extended 
Relationship Management.

2. Enter the transaction code /nSO28 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option SAP menu > 
Basis Tools > Business Communication > Office > Addresses > 
Inbound distribution with a doubleclick.
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3. Push the Add Row icon in the toolbar.

4. In the table perform the following settings from left to right:
 

NOTE:
For each message type to be passed on by the XPR server to the SAP R/3 
system, an associated postmaster should be configured.
In this example, two SAP users were previously defined with the alias names 
Postmaster-Mail and Postmaster-Fax under SAP R/3. You can however 
define any other SAP user for the postmaster function.

 

5. Select the Alternative option for each postmaster.

You have thus defined postmasters for the message types Internet and Fax to 
who all undeliverable messages of the associating type can be routed.

Now the privileges for external sending of messages from the Business 
Workplace need to be configured.

AddrType: <Address type of the messages for which this user is to take 
on the postmaster function>

New recipient: <Name of the SAP user that you want to define as 
postmaster>

AddrType: Name
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Checking the external send privileges for the Business Workplace

Now the privileges for external sending of messages from the Business 
Workplace need to be configured.

1. Push the F3 function key to return to the SAP Easy Access Extended 
Relationship Management.

2. Enter the transaction code /nSO16 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option SAP menu > 
Basis Tools > Business Communication > Office > Shared office 
settings with a doubleclick.
 

3. In the window now open access the Send tab.
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4. Make sure that in the Connected components for external sending portion 
all required components are selected.
At least those components must be active that correspond to the message 
types previously defined by you in the node configuration. In our case these 
are:

• the Fax component for sending fax messages,

• the Internet connection for sending e-mails.

• Pager connect for sending short messages.
 

If you cannot select required options, consult your SAP system administrator for 
activating them.

Now you have made sure that messages can be routed via the XPR server from 
within SAP R/3. Next in the configuration is setting the SAP user profile.
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SAP user profile setting

To ensure the correct delivery of messages between the XPR server and SAP 
R/3, the SAP profile of our example user must be adapted. Proceed as follows:

1. Push the F3 function key to return to the SAP Easy Access Extended 
Relationship Management.

2. Enter the transaction code /nSU01 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option SAP menu > 
Basis Tools > Administration > User Maintenance > Users with a 
doubleclick.

3. In the User field enter the user name the profile of which you want to 
customize and click the Change icon in the toolbar.
 

NOTE:
If you want to adapt the profile under which you are currently logged in to SAP 
R/3, enter the transaction code /nSU1 to be directly taken to the configuration 
form of the logged-in profile.



04-SAP-Installation.fm

Installation

Configuring Unified Messaging via SAPconnect

A31003-S2370-M103-4-76A9, 10/2014
OpenScape Xpressions V7 SAP R/3 Gateway, Installation and Administration Manual 135

          

4. Enter the corresponding data in the associated contact fields (for example 
Fax and Mobile Phone) for the previously configured message types.
 

NOTE:
Depending on the R/3 version it may happen that the mobile phone field is not 
immediately displayed. In this case select the Other communication button.

SAP recommends using the following address formats:

• for Fax: <area code>/<main station>–<extension>

• for SMS: SMS:<cellphone number>.

You have thus accomplished the SAP system adjustment.

continue with Section 4.5.4.4, “XPR Server System Adjustments”, on page 190.



Installation

04-SAP-Installation.fm

Configuring Unified Messaging via SAPconnect

 A31003-S2370-M103-4-76A9, 10/2014
136 OpenScape Xpressions V7 SAP R/3 Gateway, Installation and Administration Manual

         

4.5.4.2  Adjustments under SAP R/3 Version 4.6C

In the following we will describe the configuration steps for the system 
adjustments under SAP R/3 version 4.6C.

Setting the communication methods

First we perform settings for the various communication methods. In doing so we 
define which message types are sent by SAP R/3 via the SAPconnect interface.

1. Push the F3 function key to return to the SAP Easy Access – User menu.

2. Enter the transaction code /nSCOT in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option User 
menu > Tools > Business Communication > Communication > SCOT–
SAPconnect with a doubleclick.
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3. In the Settings menu of the dialog now open select the communication 
methods option.

4. Make sure that for each media type to be exchanged between the XPR server 
and SAP system the SAPconnect method is specified.
You can make alterations by selecting the respective field and subsequently 
choosing the associating selector icon.
 

5. Save the new settings with the Save icon in the toolbar.

You have now configured the communication method. We will now continue with 
the conversion rules settings.
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Conversion rule settings

Conversion rules define into which formats SAP R/3 can convert documents to be 
sent.

1. Push the F3 function key to return to the SAP Easy Access – User menu.

2. Enter the transaction code /nSCOT in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option User 
menu > Tools > Business Communication > Communication > SCOT–
SAPconnect with a doubleclick.

3. In the Settings menu of the dialog now open select the Conversion rules 
option.
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4. If required perform special settings here.
 

NOTE:
Check the parameters configured here if you do not exclusively work with 
postscript format (PS).
If you want to use the PCL5 format as well, select a conversion rule with the 
desired original format and the destination format ’PS’. Click the Copy as… 
icon and change the destination format ’PS’ to ’PCL’. Confirm your modifi-
cation with the Enter icon (this simple supplementation works as for the 
formats ’PS’ and ’PCL’ the same SAP conversion module is used).
Via Ranking (possible values are 1...9) you can prioritize rules with the same 
original format.

5. Confirm your modifications with the Save icon in the toolbar.

After configuring the conversion rules we will now define a pager subtype for the 
SMS.
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Configuration of a pager subtype for SMS

The XPR server transmits inbound short/pager messages with a destination 
phone number of the format NVS:SMS/<phone number> to the SAP destination 
system. The SMS subtype must be defined there so that this message type can 
be correctly recognized in SAP R/3.

1. Push the F3 function key to return to the SAP Easy Access – User menu.

2. Enter the transaction code /nSPRO in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option User 
menu > Tools > Accelerated SAP > Customizing > SPRO-Edit Project 
with a doubleclick.

3. Select the SAP Reference IMG button.

4. Select the menu option Implementation Guide for R/3 Customizing (IMG) 
> Basis Components > Basis Services > Address Management > Define 
pager service subtypes.
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5. In the table perform the following settings from left to right:
 

 

6. Save the settings with the Save icon in the toolbar.

IMPORTANT:
To modify these node-spanning settings a customizing job must exist or be 
newly created.

The SMS subtype, required for the configuration of the node under SAP R/3, is 
thus defined.

Pag. Service SMS

Pager service: <Short description of this entry>

Use: SMS-Service
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Setting the node

SAP R/3 administers externally activated systems in logical format as so-called 
nodes. With configuring such a node, specifications are made as regards e.g. for 
which address area the active system is in charge, or which data formats are 
supported by it.

How to configure the XPR server as SAP node:

1. Push the F3 function key to return to the SAP Easy Access – User menu.

2. Enter the transaction code /nSCOT in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option User 
menu > Tools > Business Communication > Communication > SCOT–
SAPconnect with a doubleclick.

3. In the View menu of the dialog now open select the Node option.

4. Push the Create icon in the toolbar to define a new node.
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5. Enter a name for the new node in the Node field. The name must not exceed 
6 characters.
 

6. In the Description field enter a short description for the node respectively the 
active system.

7. Push Continue.
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8. In the RFC Destination field enter the previously configured RFC destination, 
or open a selection list with a click on the selector icon at the end of the 
activated text field.
 

9. Push Continue.
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10. Select Fax as address type for the new node.
 

NOTE:
You can select only one address type (message service). After defining this 
type you can however configure further address types for this node in 
succession.
In the following we will describe the configuration of the address types Fax, 
Internet (SMTP) and PAGER (SMS). In the course of your system configu-
ration only select the address types that you want to use in your XPR-SAP 
environment.

11. Confirm your selection with Continue.
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12. Define the address area (calling number range) for which this node is to take 
on the routing.
 

The structure of the filter entries for the address area of type Fax is:
<country code><optional number string><optional wildcard character ’*’> A 
filter hit always occurs after the longest precise match.

Example: Address area=DE02402*
All fax messages beginning with the number string 492402 are handed over 
to this node by the SAP system. 

In our environment we want the fax messages of all calling numbers be 
passed on to the XPR server. Therefore we enter ’*’ as address area.

For the addressing schemes of the various addressing types compare 
Section 3.2.1, “Address Formats and ANI Hits”, on page 39.

13. Push Continue.
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14. Select the Only the fll formats option and define the formats into which SAP 
R/3 converts internal document formats before they are passed on to the 
node.
 

IMPORTANT:
Do not configure a combination of the format types PS, PCL or PDF within 
an address type (for example Fax, Internet, etc.). This may lead to conversion 
problems.

We recommend defining the formats:

• PS

• TXT

• RAW

• ’MS Office’ formats (for example DOC)

Via the additional options (All formats and All formats except the fllw) you 
can select a varying definition strategy of the desired formats.

If you want to send a document type from SAP R/3 not specified here, R/3 
converts the respective document automatically into a format defined here. 
This, however, requires the previous definition of the corresponding 
conversion rule (cf. Section 4.5.4.2, “Conversion rule settings”, on page 138).

If the corresponding conversion rule has not been defined, SAP R/3 issues 
an error message.
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15. Push Continue.

16. In the next dialog specify for which device type SAPscript documents are 
prepared in SAP R/3 if a format conversion (for example to PS, PCF or PDF) 
is performed.
 

Check the parameters configured here if you do not exclusively work with 
postscript or text output.

We recommend:

• for PCL: HPLJ4 or HPLJIIID as HP PCL 5 driver

• for PS: POST2 (in older R/3 versions, POST is available only)

17. Select the Restrict send time option.

18. Push Continue.



04-SAP-Installation.fm

Installation

Configuring Unified Messaging via SAPconnect

A31003-S2370-M103-4-76A9, 10/2014
OpenScape Xpressions V7 SAP R/3 Gateway, Installation and Administration Manual 149

          

19. Depending on three priority statuses specify send time restrictions for 
messages of this address type.
 

IMPORTANT:
The XPR server does not explicitly evaluate the start and end times specified 
here, but merely the priority status passed on with a message. The dedicated 
start times for sending messages of the individual priorities must be 
configured in the XPR server if needed.
Settings of any kind must be performed in this dialog so that the SAP system 
transmits the required status information with the message to the XPR server.

20. Push Continue.
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21. In the Country field specify the country code for the node location. This entry 
is required to determine the code for calling numbers.
 

22. Push Continue.

23. Answer the question whether to set further address types with Yes.
 

24. Push Continue.
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25. Next we configure the address type Internet. Select the Internet option in the 
following dialog.
 

26. Push Continue.
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27. Just like under the Fax address type, enter the address areas in the table for 
which SAP R/3 is to send e-mails to the XPR server for routing.
 

NOTE:
At this point you can use filter formats to configure an intelligent message 
routing via the XPR server.
With our configuration you can, for example, send an e-mail with the target 
address <cellphone number>@sms.mydomain.com to the XPR server, which 
transmits the information contained in the e-mail as short message into the 
public network.
By defining the corresponding routing rules/address conversions in the XPR 
server, the individual address structures are adapted to the common address 
formats.
You find continuative information on generating such routing rules in the 
OpenScape Xpressions Server Administration manual.

28. Push Continue.
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29. Select the Only the fll formats option and define the formats into which SAP 
R/3 converts internal document formats before they are passed on to the 
node.

IMPORTANT:
Do not configure a combination of the format types PS, PCL or PDF within 
an address type (for example Fax, Internet, etc.). This may lead to conversion 
problems.

We recommend defining the formats:

• TXT

• RAW

• ’MS Office’ formats (for example DOC)

• PDF (may be useful for newer SAP R/3 versions).

Via the additional options (All formats and All formats except the fllw) you 
can select a varying definition strategy of the desired formats.

If you want to send a document type from SAP R/3 not specified here, R/3 
converts the respective document automatically into a format defined here. 
This, however, requires the previous definition of the corresponding 
conversion rule (cf. Section 4.5.4.2, “Conversion rule settings”, on page 138).

If the corresponding conversion rule has not been defined, SAP R/3 issues 
an error message.

30. Push Continue.
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31. In the next dialog specify for which device type SAPscript documents are 
prepared in SAP R/3 if a format conversion (for example to PS, PCF or PDF) 
is performed.

Check the parameters configured here if you do not exclusively work with 
postscript or text output.

We recommend:

• for PCL: HPLJ4 or HPLJIIID as HP PCL 5 driver

• for PS: POST2 (in older R/3 versions, POST is available only)

32. Select the Restrict send time option.

IMPORTANT:
The XPR server does not explicitly evaluate the start and end times specified 
here, but merely the priority status passed on with a message. The dedicated 
start times for sending messages of the individual priorities must be 
configured in the XPR server if needed.
Settings of any kind must be performed in this dialog so that the SAP system 
transmits the required status information with the message to the XPR server.

33. Push Continue.

34. Depending on three priority statuses specify send time restrictions for 
messages of the Internet address type.

35. Push Continue.

36. Answer the question whether to set further address types with Yes.

37. Push Continue.

38. Next we configure the Pager (SMS) address type. In the following dialog 
select the Pager (SMS) option.

39. Push Continue.
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40. Just like under the Fax address type, enter the address areas in the table for 
which SAP R/3 is to send e-mails to the XPR server for routing.
 

41. Push Continue.

42. Select the Only the fll formats option and define the formats into which SAP 
R/3 converts internal document formats before they are passed on to the 
node.

We recommend defining the formats:

• TXT

• RAW.

Via the additional options (All formats and All formats except the fllw) you 
can select a varying definition strategy of the desired formats.

If you want to send a document type from SAP R/3 not specified here, R/3 
converts the respective document automatically into a format defined here. 
This, however, requires the previous definition of the corresponding 
conversion rule (cf. Section 4.5.4.2, “Conversion rule settings”, on page 138).

If the corresponding conversion rule has not been defined, SAP R/3 issues 
an error message.

43. Push Continue.
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44. In the next dialog specify for which device type SAPscript documents are 
prepared in SAP R/3 if a format conversion (for example to PS, PCF or PDF) 
is performed.

NOTE:
Check the parameters configured here if you do not exclusively work with 
postscript or text output.

45. Select the Restrict send time option.

IMPORTANT:
The XPR server does not explicitly evaluate the start and end times specified 
here, but merely the priority status passed on with a message. The dedicated 
start times for sending messages of the individual priorities must be 
configured in the XPR server if needed.
Settings of any kind must be performed in this dialog so that the SAP system 
transmits the required status information with the message to the XPR server.

46. Push Continue.

47. Depending on three priority statuses specify send time restrictions for 
messages of the Pager (SMS) address type.

48. Push Continue.

49. In the following dialog answer the question whether to set further address 
types with No.

50. Push Continue.
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51. Make an entry in the Hours and Minutes field to define how long SAP R/3 is 
to repeat the transmission of a message to this node. If the time set is 
exceeded, the originator is informed by a note that the message could not be 
delivered.
 

NOTE:
When you set the waiting period make sure that shorter maintenance works 
on the system do not lead to the message transmission being reported as 
failed to the respective SAP users.
We recommend to set the waiting period to at least three hours.

52. Confirm your settings with Continue.

53. In the following dialog select none of the available options (Node can resolve 
path references and Node is to be monitored by the alert monitor).

54. Push Continue.

55. In the following dialog select the Node is ready for use option and save the 
settings with Continue.
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56. The next window displays all information on the node just configured. 
Furthermore, you can check all settings made and modify them if required. By 
selecting one of the Set buttons you can reconfigure the respective address 
type or adapt parameters already set.
 

NOTE:
You reach this dialog via User menu >Tools > Business Communication > 
Communication > SCOT–SAPconnect (/nSCOT) under the menu option 
View > Nodes. Select one of the nodes listed there.

Now you have configured the logical node for connecting the XPR server via the 
SAPconnect interface. In the next section we will create an SAPconnect job.
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Job setting

In the background of SAP R/3 the SAPconnect job is in charge of sending ready-
to-transmit messages to external systems (nodes). 

IMPORTANT:
The following job configuration must be performed under an SAP user with suffi-
cient system privileges, since otherwise it will probably not be executed as 
desired.
Since the privilege order under SAP R/3 is version-dependent, we recommend to 
perform the configuration under a user account with full administrative privileges.

How to configure a job:

1. Push the F3 function key to return to the SAP Easy Access – User menu.

2. Enter the transaction code /nSCOT in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option User 
menu > Tools > Business Communication > Communication > SCOT–
SAPconnect with a doubleclick.

3. In the View menu of the opened dialog select the Jobs option.

4. Push the Create icon in the toolbar to define a new job.
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5. Enter a unique name in the Job name field and confirm your entry with the 
Continue icon.
 

6. Select the SAP&CONNECTALL version to have all message types sent by 
the new job. Then click Schedule job.
 

NOTE:
By selecting another job variant you can also generate SAP jobs with 
specified tasks. The SAP&CONNECTFAX version generates, for example, a 
job that merely transmits fax messages.
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7. In the Date and Time fields specify the first execution of the new job.
 

IMPORTANT:
Check the automatically generated entry in the Time field, which displays the 
start time of the job.
Since the SAP system waits with the initial start of the job until one hour after 
the job’s configuration, change the suggested entries to an earlier time.
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8. Select the Schedule periodically option and set the Repeat period in the 
now open dialog.
 

IMPORTANT:
A repeat period selected too short may overload the SAP application server 
and lead to performance losses in the SAP operation.
Useful is a setting between three to five minutes. In the end it is always a 
compromise between the desire to send a new message as quickly as 
possible, and not calling on the system for message transmissions too 
strongly.

9. Confirm your settings with the Create button.

Now you have defined an SAPconnect job for message transmission. The 
configuration of a postmaster account under SAP R/3 comes next.
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Postmaster configuration

SAP R/3 only accepts messages from external systems if message delivery to an 
SAP user is possible.

If a message is addressed to a user unknown in SAP R/3, the message is rejected 
in case of a missing postmaster account. If, however, such a postmaster has 
been configured for the respective message type, an otherwise undeliverable 
message can be routed to this configured postmaster account.

How to configure the required postmaster:

1. Push the F3 function key to return to the SAP Easy Access – User menu.

2. Enter the transaction code /nSO28 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option User menu > 
Tools > Business Communication > Office > Addresses > SO28–
Inbound Distribution with a doubleclick.
 

3. Push the Add Row icon in the toolbar.
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4. In the table perform the following settings from left to right:
 

 

NOTE:
For each message type to be passed on by the XPR server to the SAP R/3 
system, an associated postmaster should be configured.
In this example, two SAP users were previously defined with the alias names 
Postmaster-Mail and Postmaster-Fax under SAP R/3. You can however 
define any SAP user for the postmaster function.

5. Select the Alternative option for each postmaster.

You have thus defined postmasters for the message types Internet and Fax to 
who all undeliverable messages of the associating type can be routed.

Now the privileges for external sending of messages from the Business 
Workplace need to be configured.

AddrType: <Address type of the messages for which this user is to take 
on the postmaster function>

New recipient: <Name of the SAP user that you want to define as 
postmaster>

AddrType: Name
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Checking the external send privileges for the Business Workplace

Now the privileges for external sending of messages from the Business 
Workplace need to be configured.

1. Push the F3 function key to return to the SAP Easy Access – User menu.

2. Enter the transaction code /nSO16 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option User menu > 
Tools > Business Communication > Office > SO16–Shared Office 
Settings with a doubleclick.
 

3. In the window now open access the Send tab.
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4. Make sure that in the Connected components for external sending portion 
all required components are selected.

 

At least those components must be active that correspond to the message 
types previously defined by you in the node configuration. In our case these 
are:

• the Fax component for sending fax messages,

• the Internet connection for sending e-mails.

• Pager connect for sending short messages.

NOTE:
If you cannot select required options, consult your SAP system administrator 
for activating them.

Now you have made sure that messages can be routed via the XPR server from 
within SAP R/3. Next in the configuration is setting the SAP user profile.
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SAP user profile setting

To ensure the correct delivery of messages between the XPR server and SAP 
R/3, the SAP profile of our example user must be adapted. Proceed as follows:

1. Push the F3 function key to return to the SAP Easy Access – User menu.

2. Enter the transaction code /nSU01 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option User menu > 
Tools > Administration > User Maintenance > SU01–Users with a 
doubleclick.

3. In the User field enter the user name the profile of which you want to 
customize and click the Change icon in the toolbar.
 

NOTE:
If you want to adapt the profile under which you are currently logged in to SAP 
R/3, enter the transaction code /nSU1 to be directly taken to the configuration 
form of the logged-in profile.
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4. Enter the corresponding data in the associated contact fields (for example 
Fax and Mobile Phone) for the previously configured message types.

 

NOTE:
Depending on the R/3 version it may happen that the mobile phone field is not 
immediately displayed. In this case select the Other communication button.

SAP recommends using the following address formats:

• for Fax: <area code>/<main station>–<extension>

• for SMS: SMS:<cellphone number>.

You have thus accomplished the SAP system adjustment.

Continue with Section 4.5.4.4, “XPR Server System Adjustments”, on page 190.
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4.5.4.3  Adjustments under SAP R/3 Version 3.1i

In the following we will describe the configuration steps under SAP R/3 version 
3.1i.

Setting the communication methods

First we perform settings for the various communication methods. In doing so we 
define which message types are sent by SAP R/3 via the SAPconnect interface.

1. Push the F3 function key to return to the SAP standard menu.

2. Enter the transaction code /nSCON in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option SAP 
standard menu > Tools > Administration > Administration > Process 
technology > SAPconnect with a doubleclick.
 



Installation

04-SAP-Installation.fm

Configuring Unified Messaging via SAPconnect

 A31003-S2370-M103-4-76A9, 10/2014
170 OpenScape Xpressions V7 SAP R/3 Gateway, Installation and Administration Manual

         

3. In the window now open push the Configuration button.

4. Under Overall setting push the Communication methods button.
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5. Make sure that for each media type to be exchanged between the XPR server 
and SAP system the SAPconnect method is specified.
You can modify entries by pushing the Display –> Change icon. Select the 
method of the desired entry and subsequently the matching method via the 
associated selector icon.
 

6. Save the new settings with the Save icon in the toolbar.

You have now configured the communication method. We will continue with the 
format group settings.
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Format groups setting

We will now perform the settings for the various format groups. Format groups 
settings are in other SAP versions often performed under the node settings.

A format group defines the formats into which SAP R/3 converts internal 
document formats before they are passed on to a specific node. The assignment 
of nodes and formats groups occurs later during the node configuration. Since we 
will assign a format group to each desired communication type (fax, Internet, etc.) 
there, the corresponding number of groups must be set at this point already. In 
the event that various communication types are set with the same formats, the 
number of format groups may be smaller.

1. Push the Back icon in the toolbar to return to the SAPconnect interface 
configuration.

2. Under Overall setting push the Format groups button.

3. Push the Display–>Change icon and subsequently the New entries button 
now available.

Define all required format groups with their respective formats, into which SAP 
converts internal document formats, before they are passed on to the node. 
Proceed as follows:

4. Enter a name for the new group in the Format group column.
 

5. Enter a format to be supported for the group in the Format column.
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6. Continue this process until all format groups with their respective formats are 
defined.

IMPORTANT:
Do not configure a combination of the format types PS, PCL or PDF within a 
format group. This may lead to conversion problems.

We recommend defining the formats:

For the address type Fax:

• PS

• TXT

• RAW

• ’MS Office’ formats (for example DOC)

For the address type Internet:

• TXT

• RAW

• ’MS Office’ formats (for example DOC)

• PDF (may be useful for newer SAP R/3 versions).

If you want to send a document type via a node late on and this type has not 
been specified for its associating format group here, R/3 converts the 
respective document automatically into a format defined here. This, however, 
requires the definition of a corresponding conversion rule in the next section.

If the corresponding conversion rule has not been defined, SAP R/3 issues 
an error message.

7. Confirm your modifications with the Save icon in the toolbar.

We will continue with the conversion rules settings.
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Conversion rule settings

Conversion rules define into which formats SAP R/3 can convert documents to be 
sent. They are thus directly related to the format groups just configured.

1. Push the Back icon in the toolbar to return to the SAPconnect interface 
configuration.

2. Under Overall setting push the Conversion rules button.

3. If required perform special settings here.
 

NOTE:
Check the parameters configured here if you do not exclusively work with 
postscript format (PS).
If you want to use the PCL5 format as well, select a conversion rule with the 
desired original format and the destination format ’PS’. Click the Copy as… 
icon and change the destination format ’PS’ to ’PCL’. Confirm your modifi-
cation with the Enter icon (this simple supplementation works as for the 
formats ’PS’ and ’PCL’ the same SAP conversion module is used).
Via ranking (possible values are 1...9) you can prioritize rules with the same 
original format.

4. Confirm your modifications with the Save icon in the toolbar.

After configuring the format conversions we will now set the node.
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Setting the node

SAP R/3 administers externally activated systems in logical format as so-called 
nodes. With configuring such a node, specifications are made as regards e.g. for 
which address area the active system is in charge, or which data formats are 
supported by it.

How to configure the XPR server as SAP node:

1. Push the Back icon in the toolbar to return to the SAPconnect interface 
configuration.

2. Under Infrastructure push the Nodes button.

3. Push the Display–>Change icon and subsequently the New entries button 
now available.

4. Enter a name for the new node in the Node ID field. The name must not 
exceed 6 characters.
 

5. In the Country field define the country token for the node. With a click on the 
selector icon at the end of the selected text field you can open a selection list 
to assist you in making this entry.

6. In the Destination field enter the RFC destination already defined. The 
selector icon is of help here as well.

7. In the Description field enter a short description for the node.
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8. Save the newly set node with the Save icon in the toolbar.

IMPORTANT:
To create a new node, a modification job must be present or newly defined.

9. Push Continue.

Some further node settings must still be performed. Proceed as follows:

1. Push the Back icon in the toolbar to return to the SAPconnect interface 
configuration.

2. Under Infrastructure push the Node attributes button.

3. Push the Display–>Change icon and subsequently the New entries button 
now available.

4. In the Node column enter the node previously set. With a click on the selector 
icon at the end of the selected text field you can open a selection list to assist 
you in making this entry.
 

5. In the Type column enter an address type for which our node is to be in 
charge. The selector icon is of help here as well.

6. In the Group column enter one of the previously configured format groups 
that defines the supported formats for the selected address type. The selector 
icon is of help here as well.

7. In the Dev.type column select a device for which SAPscript documents are 
prepared in SAP R/3 if a format conversion is carried out (for example to PS, 
PCF or PDF).

8. Continue in this way until all desired address types have been defined for our 
new node.
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9. Save the newly set node with the Save icon in the toolbar.

IMPORTANT:
To create a new node, a modification job must be present or newly defined.

Setting the node has thus been accomplished. We will continue with the routing 
definition.
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Setting the routing

This type of configuration determines which messages are sent from SAP R/3 via 
which node.

1. Push the Back icon in the toolbar to return to the SAPconnect interface 
configuration.

2. Under Infrastructure push the Routing button.

3. Push the Display–>Change icon and subsequently the New entries button 
now available.

4. In the Type column enter an address type our node is to route. With a click 
on the selector icon at the end of the selected text field you can open a 
selection list to assist you in making this entry.
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5. In the Address Area column define an address area that specifies for which 
addresses of the previously selected address type our node is to take on the 
routing.
We do not restrict the fax message area in our configuration. In the case of 
the Internet service our node solely routes messages with the two specified 
domain descriptions.

For the filter entry structure the following formats apply:

• Address type FAX:
<country code><optional digit string><optional wildcard character ’*’>

Example: DE02402*
All fax messages beginning with the number string 492402 are handed 
over to this node by the SAP system.

A filter hit occurs after the longest precise match. In our environment we 
want the fax messages of all calling numbers be passed on to the XPR 
server. Therefore we enter ’*’ as address area.

• Address type INTERNET:
At this point you can use filter formats to configure an intelligent e-mail 
routing via the XPR server.
With our configuration you can, for example, send an e-mail with the 
target address <cellphone number>@sms.mydomain.com to the XPR 
server, which transmits the information contained in the e-mail as short 
message into the public network.
By defining the corresponding routing rules/address conversions in the 
XPR server, the individual address structures are adapted to the common 
address formats. You find continuative information on generating such 
routing rules in the OpenScape Xpressions Server Administration 
manual.

For the addressing schemes of the various addressing types compare 
Section 3.2.1, “Address Formats and ANI Hits”, on page 39.

6. Repeat the configuration steps 4 and 5 until at least one address range is 
specified for each address type defined in the node properties.

7. Save the new settings with the Save icon in the toolbar.

Setting the routing has thus been accomplished. We will continue with the SAP 
job setting.
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Job setting

In the background of SAP R/3 the SAPconnect job is in charge of sending ready-
to-transmit messages to external systems (nodes). How to configure a job:

1. Push the F3 function key to return to the SAP standard menu.

2. Enter the transaction code /nSCOA in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option SAP 
standard menu > Tools > Administration > Administration > Process 
technology > SAPconnect with a doubleclick.
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3. In the Job name field enter a name for the new job.
 

4. In the Background portion select the Schedule option.

5. Push the Execute button.

6. Select variant FAX to have all due fax messages sent by the new job.
 

NOTE:
By selecting or configuring (Create variant) another job variant you can also 
create SAP jobs for other tasks. For example, a job that sends all due 
messages of all address types.

7. Push the Schedule job button.

8. In the Date and Time fields specify the first execution of the new job.
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IMPORTANT:
Check the automatically generated entry in the Time field, which displays the 
start time of the job.
Since the SAP system waits with the initial start of the job until one hour after 
the job’s configuration, change the suggested entries to an earlier time.
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9. Select the Schedule periodically option and set the Repeat period in the 
now open dialog.
 

IMPORTANT:
A repeat period selected too short may overload the SAP application server 
and lead to performance losses in the SAP operation.
Useful is a setting between three to five minutes. In the end it is always a 
compromise between the desire to send a new message as quickly as 
possible, and not calling on the system for message transmissions too 
strongly.

10. Confirm your settings with the Create button.

Now you have defined an SAPconnect job for fax message transmission. The 
configuration of a postmaster account under SAP R/3 comes next.

Postmaster configuration

SAP R/3 only accepts messages from external systems if message delivery to an 
SAP user is possible.

If a message is addressed to a user unknown in SAP R/3, the message is rejected 
in case of a missing postmaster account. If, however, such a postmaster has 
been configured for the respective message type, an otherwise undeliverable 
message can be routed to this configured postmaster account.

How to configure the required postmaster:

1. Push the F3 function key to return to the SAP standard menu.
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2. Enter the transaction code /nSO28 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option SAP standard 
menu > Tools > Administration > Administration > Process 
technology > Office > Addresses > Inbound distribution with a 
doubleclick.
 

3. Push the Add Row icon in the toolbar.
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4. In the table perform the following settings from left to right:
 

 

NOTE:
For each message type to be passed on by the XPR server to the SAP R/3 
system, an associated postmaster should be configured.
In this example, two SAP users were previously defined with the alias names 
Postmaster-Mail and Postmaster-Fax under SAP R/3. You can however 
define any SAP user for the postmaster function.

5. Select the Alternative option for each postmaster.

You have thus defined postmasters for the message types Internet and Fax to 
who all undeliverable messages of the associating type can be routed.

Now the privileges for external sending of messages from the SAPoffice need to 
be configured.

AddrType: <Address type of the messages for which this user is to take 
on the postmaster function>

New recipient: <Name of the SAP user that you want to define as 
postmaster>

AddrType: Name
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Checking the external send privileges for SAPoffice

The privileges for external message sending from SAPoffice need to be checked 
now.

1. Push the F3 function key to return to the SAP standard menu.

2. Enter the transaction code /nSO16 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option SAP standard 
menu > Tools > Administration > Administration > Process 
technology > Office > Office settings with a doubleclick.
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3. Make sure that all required components are selected in the Internal 
administration: Connected components portion.
 

At least those components must be active that correspond to the message 
types previously defined by you in the node configuration. In our case these 
are:

• the Fax component for sending fax messages,

• the Internet gateway for sending e-mails.

NOTE:
If you cannot select required options, consult your SAP system administrator 
for activating them.

Now you have made sure that messages can be sent from within SAPoffice. Next 
in the configuration is setting the SAP user profile.
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SAP user profile setting

To ensure the correct delivery of messages between XPR server and SAP, the 
SAP profile of our example user must be adapted. Proceed as follows:

4. Push the F3 function key to return to the SAP standard menu.

5. Enter the transaction code /nSU01 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option SAP standard 
menu > Tools > Administration > User Maintenance > Users with a 
doubleclick.
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6. In the User field enter a user name for the virtual CPI-C user and push the 
Create icon in the toolbar. In the User field enter the user name the profile of 
which you want to customize and click the Change icon in the toolbar.

 

NOTE:
If you want to adapt the profile under which you are currently logged in to SAP 
R/3, enter the transaction code /nSU1 to be directly taken to the configuration 
form of the logged-in profile.

7. Enter the corresponding data in the associating contact fields (for example 
Fax number and E-mail address) for the previously configured message 
types.

SAP recommends using the following address formats:

• for Fax: <area code>/<main station>–<extension>

• for SMS: SMS:<cellphone number>.

You have thus accomplished the SAP system adjustment.

Continue with performing the still required XPR server settings in the next section.
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4.5.4.4  XPR Server System Adjustments

After adapting the SAP system, you now need to perform some XPR server 
settings. We start with extending the XPR user database.

Extending the XPR user database

For the XPR-SAP integration, a new field must be added to the XPR user 
database. Proceed as follows:

1. Start the auxiliary program InfoTool.exe from the directory
<XPR Install>\SDKTools\ with the command line:
infotool maskexport file=export.txt.

NOTE:
The InfoTool is among other things used for editing the XPR user database. 
With the program call
infotool maskexport file=export.txt
the correlation database structure is exported to the export.txt text file.
In this format it can be edited and later be reimported modified to the XPR 
server by the InfoTool command parameter maskimport.
You find detailed information on the InfoTool in the OpenScape Xpressions 
Server Administration manual.

2. Open the text file generated in the SDKTools directory with the Windows 
editor and look for the $mask USER entry.
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3. Insert the new SAPR3APC database field for example under the 
QUOTAUSED entry followed by 50 ’#’ characters. This defines the new 
SAPR3APC field with a display length of 50 characters in the user mask.

NOTE:
The database field description results from the logical line realized by the 
SAP3APL. SAPR3APC is composed of the APL name and the short name 
defined on the XPR server with the SAPR3 APL configuration (cf. Section 
4.5.3.4, “SAPR3 APL settings”, on page 98).

 

4. In the export.txt file look for the $attrib entry.

5. For reasons of clarity insert the new SAPR3APC database field followed by 
’CHAR’ under the QUOTAUSED entry, too. This defines that the new field 
may contain one character of type CHAR per ’#’ character.
 

6. Restart the InfoTool.exe auxiliary program from the 
<XPR Install>\SDKTools\ directory. This time with the command line:
infotool maskimport file=export.txt.

$mask USER
[…]
QUOTAUSED
APR3APC
LMACCOUNT
PAGER_01
[…]

##############
##################################################
##################################################
##################################

$attrib 
[…]
QUOTAUSED
SAPR3APC
SMS
SMS#
[…]

PSUPER,CHAR
CHAR
DNO,PSUPER,HIDE,CHAR,UNIQUE
DNOREAD,CHAR
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7. If you define a new user, for example via the XPR client application 
Communications, the new field Sapr3apc is displayed in the Advanced tab.

 

The user database modification is thus accomplished and we can now move on 
to the user entry maintenance.

Maintaining user entries in the XPR database

SAP users who are to receive messages via the XPR server must also be present 
in the XPR database. Furthermore, special entries must be made for them. These 
settings can be performed in different ways (cf. Section 3.2.2, “User Profile 
Replication”, on page 42). In our example we will perform this configuration 
manually.

Proceed as follows:

1. Log in to Communications as administrator.

2. Select from the menu bar File > New > User to define a new XPR user.

3. Switch to the Addressing tab.
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4. In the User ID field enter a user ID for the new user.
 

IMPORTANT:
If manually defined XPR users are to operate under the ’AutoLearn’ mode late 
on, the XPR user name (Name) must be created correspondingly to the 
automatic generation by ’AutoLearn’ (cf. Section 3.2.2.4, “XPR Server 
’AutoLearn’Mode”, on page 44). If you do not respect this, ’AutoLearn’ will 
create another profile for each SAP user manually defined in the XPR server.

5. In the Name field enter the user name at length if required.

6. In the Preferred Address field select SAPR3APC.

7. Switch to the Advanced tab.
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8. In the Sapr3apc field enter the user’s SAP fax address.
 

The address comprises of:

• The service token ’FAX’

• A ’/’

• The leading plus sign

• The normalized fax number

9. Switch to the Addressing tab and enter in the Business Fax G3 field the 
user’s fax number in the described format. This time, however, without the 
service token.

 

NOTE:
The fax number entered here must match the one in SAP R/3. Furthermore, 
it must be within the calling number range defined for the voicemail script in 
the ISDN APL.

The configuration of the Unified Messaging solution is thus complete. A short 
system test will be performed in the next section.



04-SAP-Installation.fm

Installation

Configuring Unified Messaging via SAPconnect

A31003-S2370-M103-4-76A9, 10/2014
OpenScape Xpressions V7 SAP R/3 Gateway, Installation and Administration Manual 195

          

4.5.5  Conclusive Unified Messaging System Test

To test the system we send and receive a fax each. In this way we can test fax 
transmission and receiving under SAP R/3 and see whether the XPR server 
correctly routes the message.

This part is divided into the following sections:

• Test under CRM 3.1/R/3 4.6C

• Test under SAP R/3 3.1i.

4.5.5.1  Test under CRM 3.1/R/3 4.6C

In the following we describe a short system test of the Unified Messaging solution 
for the SAP versions CRM 3.1 and R/3 4.6C. In this test we send a message from 
the SAP R/3 Business Workplace.

1. Select the SAP Business Workplace icon in the toolbar of the SAP user 
menu to switch to the SAP Business Workplace.

2. Select the New message icon in the toolbar.
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3. Enter a short text in the Title and Document contents field each.
 

4. Under Recipient enter the fax number of the fax device you want to send the 
message to. Make sure that the calling number format is correct!

5. For the Recip. type select the Fax number option.

6. Select the Send icon in the toolbar.
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Since we do not want to wait for the automatic transmission of the new message 
from the SAP system to the XPR server at this point, we manually trigger our 
previously configured job:

7. Switch to the SAPconnect interface display as follows:

• CRM version 3.1:
Enter the transaction code /nSCON in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option SAP 
menu > Basis Tools > Business Communication > 
Communication > SAPconnect with a doubleclick.

• SAP R/3 version 4.6C:
Enter the transaction code /nSCOT in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option SAP 
menu > Tools > Business Communication > Communication > 
SCOT–SAPconnect with a doubleclick.

8. In the View menu of the opened dialog select the Jobs option.

9. Select the Start send process icon in the toolbar to initiate the manual fax 
transmission.

10. Select address type Fax in the dialog now open.

11. Confirm your selection with the Continue button.

12. A new fax message will shortly arrive at the fax device.
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After the transmission of a fax message from within SAP R/3 we will now send a 
fax to our SAP user. Proceed as follows:

1. Send a fax to our test user’s calling number from a fax device.

2. In the Business Workplace  select the Inbox > Unread documents folder 
and check the arrival of the new fax message.
 

If all configurations have been performed correctly, a new fax appears in the 
inbox.

Thus you can send as well as receive incoming fax messages.
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4.5.5.2  Test under SAP R/3 3.1i

In the following we describe a short system test of the Unified Messaging solution 
for the SAP-R/3 version 3.1i. In this test we send a message from the SAPoffice.

1. After logging in to the SAP application server select the Office > Outbox 
option.
 

2. Select the Create icon in the toolbar. The dialog for creating a new message 
opens.

3. In the Class field enter the RAW document type.
 

4. In the Title field specify a subject line for the new message.

5. Make sure that OUTBOX is selected as Target folder.

6. Push the Continue button.
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7. Enter a short message and subsequently select the Send icon in the toolbar.
 

8. Under Recipient enter the desired target calling number of the fax device you 
want to send the message to. Make sure that the calling number format is 
correct!
 

9. Select the Send icon in the toolbar.

Since we do not want to wait for the automatic transmission of the new message 
from the SAP system to the XPR server at this point, we manually trigger our 
previously configured job. Proceed as follows:

10. Enter the transaction code /nSCOA in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option SAP 
standard menu > Tools > Administration > Administration > Process 
technology > SAPconnect with a doubleclick.
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11. In the Addr.type field enter the joker character ’* . In this way SAP transmits 
the new messages of all address types to the respective nodes.
 

12. Push the Start button.

13. A new fax message will shortly arrive at the fax device.

After the transmission of a fax message from within SAP R/3 we will now send a 
fax to our SAP user. Proceed as follows:

1. Send a fax to the test user’s calling number from a fax device.

2. After logging in to the SAP application server select the Office > Inbox option 
in the menu bar and in SAPoffice the Folders > Outbox option in the menu 
bar.
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3. Select the Total button to display all new incoming messages.
 

If all configurations have been performed correctly, a new fax appears in the 
SAPoffice inbox.

Thus you can send as well as receive incoming fax messages.
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4.6  Configuring Unified Messaging via SMTP Interface

This section describes the concept of an XPR-SAP integration via the SMTP 
interface and its configuration in the XPR server and SAP system.

For the following configuration we assume a running SAP system and an XPR 
server with installed SMTP APL. Furthermore, a possibly available firewall must 
be configured in a way that the SMTP Relay server can send messages.

4.6.1  General Integration Concept 

The SAP system can use the SMTP interface to directly communicate with an 
external SMTP server. It is thus able to send outbound fax and SMS messages 
of SAP users and receive fax and SMS messages that arrive for SAP users.

In the course of the next sections we will connect the SAP system to the XPR 
server via the SMTP interface. In this process an SMTP Relay server that 
receives messages from the SAP system and forwards them to the XPR server 
shall be used. Such a Relay server may be an available Exchange server.

The following flow chart provides a first overview of the steps required for the 
configuration and described in detail on the pages to follow.
 

After this first overview we begin with the SAP system configuration. The 
description documents the configuration for the CRM version 4.0 (basis 6.20).

SMTP Node Settings

Configuration on the
SAP Application Server

Configuration on the
XPR Server

Registry Settings
of SMTP APL 

User Database Extension

User Entry Maintenance
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4.6.2  Configuring the SAP System

On the SAP system you only need to configure the SMTP node of the SAP 
system for the connection via the SMTP interface.

Proceed as follows:

1. Log on to the SAP application server via the SAPGUI.

2. Enter the transaction code /nSCON in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option SAP 
menu > Basis Tools > Business Communication > Communication > 
SAPconnect with a doubleclick.

3. In the View menu of the dialog now open select the Node option.
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4. Select the existing node SMTP with a doubleclick.
 

5. In the Description field enter a short description for the node respectively the 
active system.

6. Enter in the Mail Host field the IP address under which the server SMTP 
Relay server is reached. You can also specify the fully qualified name of the 
SMTP Relay server as alternative.

NOTE: A possibly available firewall must be configured in a way that the 
SMTP Relay server can send messages.

7. Verify that the Node in use option is inactive.
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8. Select under Supported address types the Set button for the Fax address 
type.
 

9. Enter under Adress areas the address areas for which SAP R/3 is to send 
messages to the XPR server for transmission.

NOTE:
At this point you can use filter formats to configure an intelligent message 
routing via the XPR server.
By defining the corresponding routing rules/address conversions in the XPR 
server, the individual address structures are adapted to the common address 
formats.
You find continuative information on generating such routing rules in the 
OpenScape Xpressions Server Administration manual.
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10. Specify under Output Formats for SAP Documents the default formats into 
which SAP R/3 converts internal document formats before they are 
transferred to the node.

IMPORTANT:
The conversion settings made here only concern some of the SAP - individual 
formats – namely SAPScript (SCR) and ABAP Listen (ALI). Further options 
are later accessible with the node maintenance.
Message attachments of all other formats are passed on to the node trans-
parently in the format present.

11. Enter the domain for the XPR server under Domain.

12. Confirm the settings with the OK button of the dialog.

13. Set for all further desired address types the default formats by selecting the 
respectively associated Set button.

14. Confirm the node settings with the OK button of the dialog.

You have now configured the SMTP node of the SAP system.
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4.6.3  XPR Server Configuration

For the connection via the SMTP interface you now need to configure the SMTP 
APL of the XPR server.

Proceed as follows:

Configuring registry values for the SMTP APL

1. Start the registry editor on the XPR server computer system.

2. Switch to the directory:

HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\SmtpApl

3. Verify that value 1 has been entered in the SAP_Enable registry value.

This setting activates the SMTP interface in the SMTP APL.

4. Specify in the DefaultSapUsers registry value entries of the following format:

<default user>;<domain>

These entries have the following function:
If a message is sent via the SMTP APL the originator of which is unknown in 
the XPR server, the SMTP APL uses the settings of the specified default user 
to send the message. Such settings may be e.g.: fax stationery or send 
privileges.
Individual default users can be defined for different address domains via the 
domain specification.

Example:
EnterpriseSmtpUser;Enterprise.com
CycosSmtpUser;Cycos.com

You have now configured the registry values for the SMTP APL.
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Extending the XPR user database

For the XPR-SAP integration, a new field must be added to the XPR user 
database. Proceed as follows:

1. Start the auxiliary program InfoTool.exe from the directory
<XPR Install>\SDKTools\ with the command line:
infotool maskexport file=export.txt.

NOTE:
The InfoTool is among other things used for editing the XPR user database. 
With the program call
infotool maskexport file=export.txt
the correlation database structure is exported to the export.txt text file.
In this format it can be edited and later be reimported modified to the XPR 
server by the InfoTool command parameter maskimport.
You find detailed information on the InfoTool in the OpenScape Xpressions 
Server Administration manual.

2. Open the text file generated in the SDKTools directory with the Windows 
editor and look for the $mask USER entry.

3. Insert the new SAPSMTP database field for example under the 
QUOTAUSED entry followed by 50 ’#’ characters. This defines the new 
SAPSMTP field with a display length of 50 characters in the user mask.
 

$mask USER
[…]
QUOTAUSED
SAPSMTP
LMACCOUNT
PAGER_01
[…]

##############
##################################################
##################################################
##################################
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4. In the export.txt file look for the $attrib entry.

5. For reasons of clarity, insert the new SAPSMTP database field followed by 
’CHAR’ under the QUOTAUSED entry, too. This defines that the new field 
may contain one character of type CHAR per ’#’ character.
 

6. Restart the InfoTool.exe auxiliary program from the 
<XPR Install>\SDKTools\ directory. This time with the command line:
infotool maskimport file=export.txt.

7. If you define a new user, for example via the XPR client application 
Communications, the new field SAPSMTP is displayed on the Advanced tab.

The user database modification is thus accomplished and we can now move on 
to the user entry maintenance.

Maintaining user entries in the XPR database

SAP users who are to receive messages via the XPR server must also be present 
in the XPR database. Furthermore, special entries must be made for them. In our 
example we will perform this configuration manually.

Proceed as follows:

1. Log in to Communications as administrator.

2. Select from the menu bar File > New > User to define a new XPR user.

3. Switch to the Addressing tab.

$attrib 
[…]
QUOTAUSED
SAPSMTP
SMS
SMS#
[…]

PSUPER,CHAR
CHAR
DNO,PSUPER,HIDE,CHAR,UNIQUE
DNOREAD,CHAR
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4. In the User ID field enter a user ID for the new user.

5. In the Name field enter the user name at length if required.

6. In the Preferred Address field select SAPSMTP.

7. Switch to the Advanced tab.

8. In the SAPSMTP field enter the user’s SAP fax address.

9. Switch to the Addressing tab and enter in the Business Fax G3 field the 
user’s fax number also.

NOTE:
The fax number entered here must match the one in SAP R/3. Furthermore, 
it must be within the calling number range defined for the voicemail script in 
the ISDN APL.

Configuring the SMTP interface is thus complete.
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4.7  Configuring CTI via SAPphone

This section describes the general concept of a CTI integration via the SAPphone 
interface and its configuration in the XPR server and SAP system.

The below user interfaces of the various SAP R/3 versions are very different from 
each other. Therefore, we cannot document a version-spanning user guide for the 
configuration steps at this point. and have divided the SAP system configuration 
in two parts:

• Configuration under CRM 3.1 (Basis 6.20)

• Configuration under SAP R/3 Version 4.6C.

For the configuration we assume a running SAP system. Furthermore, the 
SAPPHONE APL must already be installed on the XPR server, since in the 
following only its configuration will be described. You will find information on the 
APL installation in Section 4.4, “Installing SAP APLs on the XPR Server”, on page 
62.

First, however, some information on the conception of a SAPphone connection in 
the environment of a CTI solution will be given.
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4.7.1  SAPphone Communication Structure

The following figure provides an overview of the communication structure via the 
SAPphone interface:
 

Like the SAPconnect interface, the SAPphone communication is also based on 
RFCs of the RFC transport layer. This layer is realized on the XPR server by the 
LibRFC32.dll and configured by the saprfc.ini configuration file.

As with connecting via the SAPconnect interface, a CPI-C user with system 
privileges is called on for authentication on the SAP R/3 side to enable the 
information exchange between the XPR server and SAP system.

Compared to the communication via the SAPconnect interface, an additional 
XPR component, the CTI APL, is used. This APL realizes the CTI functionalities 
and provides the external CTI communication of the XPR server with a PBX. It 
monitors the status of telephone terminal devices and can interfere in their 
control.

A softphone application serves as CTI application interface, as provided, for 
example, by SAPphone.
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4.7.2  General Integration Concept

An XPR-SAP integration via SAPphone is, among other things, used in CTI 
environments. In the following we will describe and configure a corresponding 
example scenario from this environment.

Scenario

For quite a while, PCs have been at the center of daily office work. Since the 
medium telephone as well as the computer now exists practically on every desk, 
the desire for an integration of both platforms is obvious. Such a combination 
optimizes contact management, in particular since telephone contacts are 
normally stored in the computer. In case of an integrated communication solution, 
phone numbers do no longer have to be maintained in parallel on the computer 
and on the telephone device.
In this chapter we will deal with the setup of a CTI solution that realizes exactly 
this very basic optimization in the wide field of CTI functionality – establishing a 
telephone connection from the computer.
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How the CTI solution works

The following figure provides a simplified overview of the way our CTI example 
scenario works.
 

SAP R/3 sets monitor points via the XPR server in the PBX to receive the system 
status for specific telephones. These monitor points represent the basis for a 
functioning CTI solution. In our example we see the monitor point set for the 
telephone terminal device with extension -109.

How SAP user Joe Green establishes a telephone connection from his PC:

1. After starting the SAPphone – the SAP softphone application – Joe Green 
enters the desired calling number in the corresponding GUI field and initiates 
the call. (In the ideal case the SAP user will select the calling number directly 
via marking a contact entry in a corresponding PC application).

2. SAPphone signalizes the call via the SAP system to the XPR server, which 
passes it on to the connected PBX via the CTI APL.

3. Upon the incoming call request the PBX establishes a connection – for 
example to the public telephone network.

4. Subsequently, the PBX signalizes the connection establishment via the 
associating subscriber line, upon which, for example, the loudspeaker and 
microphone are automatically activated at Joe Green’s phone and a ringing 
tone sounds.
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5. With this the status of Joe Green’s phone has changed. Thanks to the set 
monitor point, the PBX signalizes this alteration to the XPR server and thus 
to the SAP system. Consequently, the softphone indicates this new status 
information in a suitable format.

6. As soon as the called subscriber picks up the phone, the PBX connects 
through to the telephone and the conversation can begin.

7. Parallel to this interconnection, the PBX signalizes via the CTI interface the 
new status of the telephone terminal device to the XPR server, and thus to 
the SAP system and SAPphone. The softphone application can now display 
the new status information.

8. Joe Green terminates the call, for example, in SAPphone.

9. SAPphone signalizes this termination via the SAP system and the XPR 
server to the active PBX upon which the PBX clears the connection.

10. After the call termination in SAPphone the PBX deactivates the loudspeaker 
and microphone at Joe Green’s phone.

11. Finally, the PBX sends the new terminal device status via the CTI interface to 
the XPR server and thus to the SAP system and to SAPphone. The latter 
displays the call termination in a suitable format.

NOTE:
In our example description we assume that SAPphone, the softphone used, 
is an application integrated in SAP R/3. Only in this case the associated 
communication occurs via the SAPphone interface.
If an XPR server SoftPhone client is used instead, the client communicates 
via the TCP/IP network only directly with the XPR server.
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In the course of the next sections we will configure this scenario via the 
SAPphone interface. The following flow chart provides a first overview of the 
steps required and described in detail on the pages to follow.

The following configuration steps are based on the basic configuration of the 
above CTI solution, which does not consider any system redundancies etc.

NOTE: You can also connect an XPR server that has several links to different 
locations to an SAP system. The Cycos-White-Paper KB001327 provides the 
information to be considered in this case. You receive this White Paper upon 
request.
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4.7.3  Configuring the XPR-SAP Communication

The XPR-SAP integration via the SAPphone interface uses the same type of RFC 
communication as an integration under SAPconnect.

In the following two sections we have summarized all steps required for 
configuring the RFC communication on the SAP side from Section 4.5.3, 
“Configuring the XPR-SAP Communication”, on page 70ff. However, the 
descriptions related to the Unified Messaging solution have been adapted here, 
and the associated screenshots omitted.

This part is divided into the following sections:

• Configuration under CRM 3.1 (Basis 6.20)

• Configuration under SAP R/3 Version 4.6C

• SAPphone APL Configuration.

4.7.3.1  Configuration under CRM 3.1 (Basis 6.20)

In the following we will describe the configuration steps under the SAP CRM 
version 3.1.

Creating a virtual CPI-C user in SAP R/3

1. Log on to the previously configured SAP application server via the SAPGUI.

2. Enter the transaction code /nSU01 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option SAP menu > 
Basis Tools > Administration > User Maintenance > Users with a 
doubleclick.

3. In the User field enter a user name for the virtual CPI-C user and push the 
Create icon in the toolbar.

NOTE:
At this point we recommend to select a ’speaking’ name. We use the name 
MRS-CPIC.

4. In the Last name field of the Address tab enter a name for the user.

NOTE:
We recommend copying the user name at this point.
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5. In the Language field select the desired language option.

6. Switch to the Logon data tab. 

7. Assign a Password to the user and select the Communications option as 
User Type.

IMPORTANT:
Note that SAP R/3 differentiates upper and lower case with password entries.

NOTE:
Depending on the SAP version the CPI-C user type is also called CPIC user 
(through SAP R/3 4.6C) or system user (after SAP R/3 4.6C).

8. Switch to the Profiles tab.

9. In the table under Profile enter the user profile S_A.SCON and confirm the 
entry with the enter key of your keyboard.

NOTE:
You can also grant full SAP system privileges (SAP_ALL, SAP_NEW) to the 
virtual user. Since user type CPI-C is selected, you cannot log in at the SAP 
system via this user from outside. In this way abuse of the granted privileges 
is prevented.

10. Save the settings for the virtual user with the Save icon in the toolbar.

Now you have created the virtual user MRS-CPIC who will later be used for 
communication between the XPR server and the SAP application server.

We will now continue with configuring the RFC destination.
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Defining an RFC destination in SAP R/3

1. Push the F3 function key to return to the SAP Easy Access Extended 
Relationship Management.

2. Enter the transaction code /nSM59 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option SAP menu > 
Basis Tools > Administration > Administration > Network > RFC 
Destinations with a doubleclick.

3. Select TCP/IP connections and click on the Create button.

4. Assign a name to the RFC destination in the RFC destination field.

NOTE:
We recommend choosing a name of the structure SAPPHONE_<CPIC-
user>_<client number> to enhance clarity.
In our example it is SAPPHONE_MRS-CPIC_200.

5. Enter letter T in the Connection type field to configure a TCP/IP connection.

6. Enter a short description for the RFC destination in the Description field.

7. Save the RFC destination settings with the Save icon in the toolbar.

8. In the Technical settings tab select the Registered Server Program option.

NOTE:
This setting informs the SAP application server that an external RFC service 
will register with it with the program ID to be configured in the next step.
This configuration is directly associated with the TYPE=R parameter from the 
saprfc.ini of the XPR server (cf. Section 4.7.3.3, “SAPphone APL Config-
uration”, on page 226).
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9. In the Program ID field assign a string for this logical link between the XPR 
server and the SAP application server.

IMPORTANT:
The program ID serves later for identifying the logical link. Therefore the 
string must be unique. Respect the use of upper and lower case when you 
enter it.

NOTE:
We recommend selecting a string of the structure CTI_<SAP system 
ID>_<client number> to enhance clarity. Accordingly, we select the program 
ID CTI_APC_200.

10. Save the settings with the Save icon in the toolbar.

11. Leave this SAPGUI entry form opened. We will use it again straight after 
configuring the SAPPHONE APL of the XPR server for a first function test.

Continue with Section 4.7.3.3, “SAPphone APL Configuration”, on page 226.
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4.7.3.2  Configuration under SAP R/3 Version 4.6C

In the following paragraphs we will describe the configuration steps under SAP 
R/3 version 4.6C.

Creating a virtual CPI-C user in SAP R/3

1. Log on to the previously configured SAP application server via the SAPGUI.

2. Enter the transaction code /nSU01 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option SAP menu > 
Tools > Administration > User Maintenance > SU01–Users with a 
doubleclick.

3. In the User field enter a user name for the virtual CPI-C user and push the 
Create icon in the toolbar.

NOTE:
We recommend to select a ’speaking’ name – for example MRS-CPIC.

4. In the Last name field of the Address tab enter a name for the user.

NOTE:
We recommend copying the user name at this point.

5. In the Language field select the desired language option. This specification 
will influence log outputs on RFC level at a later date.

6. Switch to the Logon data tab.

7. Assign a Password to the user and select the CPIC option as User Type.

IMPORTANT:
Note that SAP R/3 differentiates upper and lower case with password entries.

NOTE:
Depending on the SAP version the CPI-C user type is also called system user 
(after SAP R/3 4.6C) or communication user (from SAP R/3 6.10 Basis).
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8. Switch to the Profiles tab.

9. In the table under Profile enter the user profile S_A.SCON and confirm the 
entry with the enter key of your keyboard.

NOTE:
You can also grant full SAP system privileges (SAP_ALL, SAP_NEW) to the 
virtual user. Since user type CPI-C is selected, you cannot log in at the SAP 
system via this user profile from outside. In this way abuse of the granted 
privileges is prevented.

10. Save the settings for the virtual user with the Save icon in the toolbar.

Now you have created the virtual user MRS-CPIC who will later be used for 
communication between the XPR server and the SAP application server.

We will now continue with configuring the RFC destination.
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Defining an RFC destination in SAP R/3

1. Push the F3 function key to return to the SAP Easy Access – User menu.

2. Enter the transaction code /nSM59 in the SAPGUI command line and confirm 
the entry. Or select from the directory tree the menu option User menu > 
Tools > Administration > Administration > Network > SM95–RFC 
Destinations with a doubleclick.

3. Select TCP/IP connections and push the Create button.

4. Assign a name to the RFC destination in the RFC destination field.

NOTE:
We recommend choosing a name of the structure SAPPHONE_<CPIC-
user>_<client number> to enhance clarity. In our example it is 
SAPPHONE_MRS-CPIC_200.

5. Enter letter T in the Connection type field to configure a TCP/IP connection.

6. Enter a short description for the RFC destination in the Description field.

7. Save the RFC destination settings with the Save icon in the toolbar.

8. Push the Registration button.
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9. In the Program ID field assign a string for this logical link between the XPR 
server and the SAP application server.

IMPORTANT:
The program ID serves later for identifying the logical link. Therefore the 
string must be unique. Respect the use of upper and lower case when you 
enter it.

NOTE:
We recommend selecting a string of the structure CTI_<SAP system 
ID>_<client number> to enhance clarity. Accordingly, we select the program 
ID CTI_APC_200.

10. Save the settings with the Save icon in the toolbar.

11. Leave this SAPGUI entry form opened. We will use it again straight after 
configuring the SAPR3 APL of the XPR server for a first function test.

Continue with configuring the XPR server SAPPHONE APL in the next section.



Installation

04-SAP-Installation.fm

Configuring CTI via SAPphone

 A31003-S2370-M103-4-76A9, 10/2014
226 OpenScape Xpressions V7 SAP R/3 Gateway, Installation and Administration Manual

         

4.7.3.3  SAPphone APL Configuration

If the XPR server and the XPR monitor have not been started yet, start them and 
proceed as follows:

SAPPHONE APL Settings

1. In the modules window of the XPR monitor select Settings > SAPphone 
APL > Set Options with a doubleclick.

2. In the SAPphone APL Settings dialog switch to the Special Phone Device 
Settings tab.

3. Select the …DISABLED… option and click on the Add button.
 

4. In the space under Extension List define for which telephones the speakers 
should be disabled when dialing.

NOTE:
For a correct functionality this CTI feature must be supported by the PBX. 
Furthermore, additional settings must be performed at the PBX if required.
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5. Switch to the SAPphone tab and click on the Add button.

6. In the System Number field specify the system number of the gateway 
service with which you want to connect the SAPphone APL.
The system number specifies the last two digits of the TCP port for which the 
corresponding gateway service was configured and represents mostly value 
00. In case of doubt consult your SAP administrator for the correct system 
number.
 

7. Activate the following options:

• Free inwait mode 

• Activate connection to the R/3 system 

• Enable daily restart 

8. Switch to the RFC Server tab.
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9. In the Server Destination field specify a name under which the server 
configuration data are stored in the saprfc.ini for the relevant connection. 
For our example we choose at this point APC-CTI-SRV.
 

10. In the Program ID field enter the ID that you have previously specified when 
configuring the RFC connection in the SAP system. In our example this is 
CTI_APC_200 .

11. In the Host Name field specify the router connect string for the host on which 
the desired gateway server is configured.

12. Switch to the RFC Client tab.
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13. In the Client Destination field specify a name under which the client 
configuration data are stored in the saprfc.ini for the relevant connection. 
For our example we choose at this point APC-CTI-CLT.
 

14. Select the option SAP Application Server (Type A).

15. In the Host Name field specify the router connect string for the host that is 
configured as application server.

16. Switch to the RFC Login tab.
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17. In the Client field enter the client number to be used.
 

18. In the User field enter the name of the virtual user that you have previously 
created under SAP R/3. In our example this is the user name MRS-CPIC.

19. In the Password field enter the password of the virtual user as you have 
previously assigned it under SAP R/3. Repeat the password in the Confirm 
Password field.

20. Confirm your settings with Apply and push OK.

The SAPphone APL settings are thus complete.

We will now test the configured RFC connection between the XPR server and the 
SAP system.
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RFC connection test

1. Return to the last SAPGUI entry form and thus to the display of the RFC 
connection we have configured.

NOTE:
If you have inadvertently closed the SAPGUI, you can reach a selection of all 
configured RFC connections via SAP menu > Basis Tools > Administration 
> Administration > Network > RFC destinations > TCP/IP connections.
You can also select your newly configured connection from the TCP/IP 
connections via the /nSM59 transaction code.

2. Push the Test connection button.
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SAP R/3 displays the measured parameters for our RFC connection between the 
XPR server and the SAP application server. Communication from the SAP 
system towards the XPR server has obviously been established successfully.

 

In case of an error the SAP system reports the termination of the connection 
test with the following message:
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3. With a successful communication establishment the Physical Lines window 
of the XPR monitor also displays a constant link for the SAPphone APL. 
Please check this.
 

Communication from the XPR server towards the SAP system has thus also been 
successfully established.
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4.7.4  System Adjustment of the XPR-SAP 
Environment

After successfully testing the basis configuration with the RFC connection, we 
continue with adapting the SAP system.

This part is divided into the following sections:

• Adjustments under CRM Version 3.1 (Basis 6.20)

• Adjustments under SAP R/3 Version 4.6C.

4.7.4.1  Adjustments under CRM Version 3.1 (Basis 6.20)

In the following paragraphs we will describe the configuration steps for the system 
adjustments under the SAP version CRM 3.1.

Configuring a site object

SAP R/3 needs some specifications to automatically perform site-dependent 
adjustments. For example, the calling number normalization requires the calling 
number structure or the time shift evaluation requires the time zone.

To provide the SAP system with this information, a so-called site object must be 
defined. Proceed as follows.

1. Select SAP menu in the toolbar to return to the SAP Easy Access Extended 
Relationship Management.
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2. Enter the transaction code /nSPHB in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option SAP 
menu > Interaction Center > Administration > Telephony > Maintain 
System Settings with a doubleclick.
 

3. In the new menu select the Site menu option.
 

NOTE:
If a suitable site has already been defined on the SAP system, you can use it 
for further configurations. In this case continue with Section 4.7.4.1, “Config-
uring a telephony server object”, on page 237.

4. Push the Create icon in the toolbar to define a new site.
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5. In the Site name, Number prefix, Country, Extension length and Time 
zone fields enter the applicable information for this site. Some of these fields 
offer the option to select values from a logically restricted value range via a 
selector icon at the end of the respective field.
 

IMPORTANT:
When you specify the Number prefix, separate the area code from the trunk 
side connection by a ’/’. All other separators or none at all are not permissible.

NOTE:
If various configuration options apply for one site, we recommend defining 
several sites under SAP R/3.
For example, if a site has two number prefixes, define an individual site for 
each number prefix.

6. Save the new site with the Save button in the toolbar.

You have thus defined a new site in SAP R/3.
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Configuring a telephony server object

The SAP system is to communicate via the SAPphone interface with an external 
telephone service – the XPR server. To configure its parameters on the SAP R/3 
side, we define a logical telephony server.

7. In the Sites menu select the Server Names menu option under your site just 
configured.
 

8. Push the Create icon in the toolbar to define a new telephony server.

9. Enter a name for the new telephony server in the Server field. The name must 
not exceed 6 characters.
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10. In the Name field enter a short description of the server. This specification will 
later simplify the assignment.
 

11. Push Continue. 
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12. In the RFC destination field enter the previously configured RFC destination. 
The selector at the end of the marked text field assists you in making a 
selection.
 

13. Push Continue.
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14. Select the Canon. numbers (cf. Section 3.2.1, “Address Formats and ANI 
Hits”, on page 39) and Telephony options.
 

15. Push Continue.

16. Skip the next dialog with Continue, since we do not configure a calling 
number replacement there.
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17. Select the Server is ready for use option to immediately start the new 
telephony server.
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18. SAP R/3 activates the server after a successful system test only. Start this test 
with Yes.
 

 

In case of an error the SAP system reports the termination of the connection 
test with the following message:
 

19. After a successful test push Continue.

20. Save the settings performed with the Save icon in the toolbar.
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This window displays all information on the telephony server just configured. 
Furthermore, you can check all settings made and modify them if required.
 

NOTE:
You reach this dialog via SAP menu > Interaction Center > Administration > 
Telephony > Maintain System Settings (transaction code /nSPHB) under the 
menu option Sites > Server Names. Select the desired server from those listed 
there.

The required telephony server is thus defined. Now you need to adapt the SAP 
user profile for the application of CTI functions.
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Configuration of the work center and user settings

In the following paragraphs we will configure CTI functions under SAP R/3 for the 
example user Joe Brown. We have previously defined this SAP user under SAP 
R/3 so that we can now access his profile. Since these settings are saved in the 
registry of the user workstation by default, the following configurations must be 
performed on the PC of the relevant user.

To enable Joe Brown using the CTI functions under SAP R/3, we will configure 
his profile in the following way.

IMPORTANT:
The following settings are administered in the registry of the PC on which you 
perform settings. You can thus make configurations for only one user on any 
workstation.

NOTE:
The following manual way of configuration is sufficient for our scenario. In 
solutions with a large number of CTI users under SAP R/3 it may however be 
useful not to configure users individually.
In this case the SAP administrator can define so-called sample profiles. The 
desired SAP users can then be assigned to such a sample profile. A sample 
profile is also created under the transaction code /nSPHB
. You find more information on this in the SAP R/3 product documentation.

1. Log in to the SAP R/3 system via the SAPGUI under the user to be defined.
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2. Enter the transaction code /nSPHA in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option SAP 
menu > Interaction Center > Administration > Telephony > Maintain 
Agent Settings with a doubleclick.
 

3. Push the Work center button.
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4. In the 1.Telephone no. field enter the calling number of the SAP user’s 
telephone terminal device.
 

5. Select the previously configured telephony server via the selector icon at the 
end of the Telephony server field.

6. Save the user settings with the Save icon in the toolbar.

7. Push the Back icon in the toolbar to return to the SAPphone interface 
administration (transaction code /nSPHA).

8. Push the User settings button.
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9. In the Display of inbound calls section select the Display inbound call 
option.
 

10. In the Notification of call in absence section select the Message if absent for 
call and No expiration time settings.

11. In the Data areas for caller search... section select the Business Address 
Services option via the selector icon in the text field.

NOTE:
In the data area configured here the originator calling number is searched for 
when a phone call comes in (cf. Section 3.2.1, “Address Formats and ANI 
Hits”, on page 39).

12. Save the settings performed with the Save icon in the toolbar.

The configuration of the CTI solution is thus accomplished. Continue with Section 
4.7.5, “Conclusive CTI Test”, on page 262.
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4.7.4.2  Adjustments under SAP R/3 Version 4.6C

In the following we will describe the configuration steps for the system 
adjustments under SAP R/3 version 4.6C.

Configuring a site object

SAP R/3 needs some specifications to automatically perform site-dependent 
adjustments. For example, the calling number normalization requires the calling 
number structure or the time shift evaluation requires the time zone.

To provide the SAP system with this information, a so-called site object must be 
defined. Proceed as follows.

1. Select the SAP menu icon the toolbar to return to the SAP Easy Access 
Extended Relationship Management.

2. Enter the transaction code /nSPHB in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option User 
menu > Tools > Business Communication > Communication > SPHB–
SAPphone with a doubleclick.
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3. In the new menu select the Site menu option.
 

NOTE:
If a suitable site has already been defined on the SAP system, you can use it 
for further configurations. In this case continue with Section 4.7.4.2, “Config-
uring a telephony server object”, on page 251.

4. Push the Create icon in the toolbar to define a new site. 
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5. In the Site name, Number prefix, Country and Extension length fields 
enter the applicable information for this site. Some of these fields offer the 
option to select values from a logically restricted value range via a selector 
icon at the end of the respective field.
 

IMPORTANT:
When you specify the Number prefix, separate the area code from the trunk 
side connection by a ’/’. All other separators or none at all are not permissible.

NOTE:
If various configuration options apply for one site, we recommend defining 
several sites under SAP R/3.
For example, if a site has two number prefixes, define an individual site for 
each number prefix.

6. Save the new site with the Save button in the toolbar.

You have thus defined a new site in SAP R/3.



04-SAP-Installation.fm

Installation

Configuring CTI via SAPphone

A31003-S2370-M103-4-76A9, 10/2014
OpenScape Xpressions V7 SAP R/3 Gateway, Installation and Administration Manual 251

          

Configuring a telephony server object

The SAP system is to communicate via the SAPphone interface with an external 
telephone service – the XPR server. To configure its parameters on the SAP R/3 
side, we define a logical telephony server.

7. In the Sites menu select the Server Names menu option under your site just 
configured.
 

8. Push the Create icon in the toolbar to define a new telephony server.

9. Enter a name for the new telephony server in the Server field. The name must 
not exceed 6 characters.
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10. In the Name field enter a short description of the server. This specification will 
later simplify the assignment.
 

11. Push Continue.
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12. In the RFC destination field enter the previously configured RFC destination 
and push Continue.

NOTE:
The selector displayed at the end of the RFC destination has no function. 
Therefore you need to enter the name via keyboard.
If you do not remember the name of your RFC destination any more, push the 
RFC destination button. You are then taken to a list of all RFC destinations 
defined. After you have found the right one, note down the name and return 
to the original entry form via the F3 function key.
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13. Select the Canon. numbers option (cf. Section 3.2.1, “Address Formats and 
ANI Hits”, on page 39).
 

14. Push Continue.

15. Skip the next dialog with Continue, since we do not configure a calling 
number replacement there.
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16. Select the Server is ready for use option to immediately start the new 
telephony server.
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17. SAP R/3 activates the server after a successful system test only. Start this test 
with Yes.
 

 

In case of an error the SAP system reports the termination of the connection 
test with the following message:

 

18. After a successful test push Continue.
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19. Save the settings performed with the Save icon in the toolbar.

This window displays all information on the telephony server just configured. 
Furthermore, you can check all settings made and modify them if required.
 

NOTE:
You reach this dialog via User menu > Tools > Administration > Business 
Communication > Communication > SPHB–SAPphone (/nSPHB) under the 
menu option Sites > Server Names. Select the desired server from those listed 
there.

The required telephony server is thus defined. Now you need to adapt the SAP 
user profile for the application of CTI functions.
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Configuration of the work center and user settings

In the following paragraphs we will configure CTI functions under SAP R/3 for the 
example user Joe Brown. We have previously defined this SAP user under SAP 
R/3 so that we can now access his profile. Since these settings are saved in the 
registry of the user workstation by default, the following configurations must be 
performed on the PC of the relevant user.

To enable Joe Brown using the CTI functions under SAP R/3, we will configure 
his profile in the following way.

IMPORTANT:
The following settings are administered in the registry of the PC on which you 
perform settings. You can thus make configurations for only one user on any 
workstation.

NOTE:
The following manual way of configuration is sufficient for our scenario. In 
solutions with a large number of CTI users under SAP R/3 it may however be 
useful not to configure users individually.
In this case the SAP administrator can define so-called sample profiles. The 
desired SAP users can then be assigned to such a sample profile. A sample 
profile is also created under the transaction code /nSPHB
. You find more information on this in the SAP R/3 product documentation.

1. Log in to the SAP R/3 system via the SAPGUI under the user to be defined.
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2. Enter the transaction code /nSPHA in the SAPGUI command line and 
confirm the entry. Or select from the directory tree the menu option User 
menu > Office > Telephone Integration > SPHA–Extended Settings with 
a doubleclick.
 

3. Push the Work center button.
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4. In the Telephone number field enter the calling number of the SAP user’s 
telephone terminal device.
 

5. Select the previously configured telephony server via the selector icon at the 
end of the Telephony server field.

6. Save the user settings with the Save icon in the toolbar.

7. Push the Back icon in the toolbar to return to the SAPphone interface 
administration (transaction code /nSPHA).

8. Push the User settings button.
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9. In the Display of inbound calls section select the Display inbound call 
option.
 

10. In the Notification of call in absence section select the Message if absent for 
call and No expiration time settings.

11. In the Data areas for caller search... section select the Business Address 
Services option via the selector icon in the text field.

NOTE:
In the data area configured here the originator calling number is searched for 
when a phone call comes in (cf. Section 3.2.1, “Address Formats and ANI 
Hits”, on page 39).

12. Save the settings performed with the Save icon in the toolbar.

The configuration of the CTI solution is thus accomplished. In the following 
section we will check the system for trouble-free operation.
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4.7.5  Conclusive CTI Test

To perform a short CTI function test for the previously defined user Joe Brown we 
use a test interface by SAP R/3 in which, for example, the processing of Call 
Attached Data (CAD) can be handled.

Proceed as follows:

1. Log in under the example user – in our example under user JBROWN.

2. Enter the /nSPHT transaction code in the SAPGUI command line.

3. Push the Call button to open SAPphone for a call.
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4. In the Telephone no. field enter an external calling number to test the CTI 
functions at the work center. Push the Initiate button.
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The call information is passed on to the PBX, which sets up a connection to the 
called subscriber. Therefore, the telephone of the example user should now 
signal an outgoing call.
 

Our CTI environment works perfectly.
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Function Reference

5  Function Reference

In this chapter you find detailed reference information about the following XPR 
and SAP components that are important in the XPR-SAP integration context.

• SAPR3 APL

• SMTP APL

• SAPPHONE APL

• XML APL

• saprfc.ini

• SAP R/3 Client SAPphone

• mySAP CRM Interaction WebClient (IC WebClient)

• CyViewer
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5.1  SAPR3 APL

In this section we describe the following configuration settings for the XPR 
server's SAPR3 APL:

• Settings – General Settings

• Settings – Advanced Settings

• System Properties – System

• System Properties – Server

• System Properties – Client
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5.1.1  Settings – General Settings 

 

 

Identification Defines a host name that can be addressed with an INT address from within SAP for 
using XPR services that are actually not directly addressable under SAP.

Example:
From within SAP a short message with the INT address SMS/
01702542323@company.com is passed on to the XPR server via the SAPconnect 
interface. The identifier company.com defined under Identification indicates that the 
message is not to be sent as e-mail but to an internal XPR service. On grounds of the 
additionally given address SMS/010702542323 the XPR server identifies the message 
as short message to be sent to the calling number specified.

R/3 System The list shows the connections that are configured in the SAPR3 APL and via which the 
APL can communicate with SAP R/3 systems. The SAPR3 APL and the SAP R/3 systems 
communicate via the SAPconnect interface.
If several clients of an SAP R/3 system are to be connected via the SAPR3 APL, you 
should configure an individual connection to the relevant SAP R/3 system for each client.

Add Opens the configuration dialog which you can configure a new connection to an SAP R/
3 system.

Remove Removes the selected connection from the connection list and thus the associated 
connection information from the SAPR3 APL configuration.

Properties Shows the configuration of the connection selected in the connection list. Corresponds to 
a double-click on the desired list entry.

Refresh Updates the displayed SAP R/3 connection list.
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5.1.2  Settings – Advanced Settings 

 

 

Info about the
sender of an object

Configures the object structure SXRECINFI1 for the debug output.
The following setting options apply: 

• black check mark:
• gray check mark:
• no check mark: 

Output in detailed scope
Output in normal scope
Disabled

Info about the
object properties

Configures the object structure SXDOCCHGI1 for the debug output.
The same setting options apply as described under the SXRECINFI1 structure (see 
above).

Info about the
Remote Function Call

Configures the object structure SXSYSDATI1 for the debug output.
The same setting options apply as described under the SXRECINFI1 structure (see 
above).

Info about the recipient(s) of an 
object

Configures the object structure SXEXTRECI1 for the debug output.
The same setting options apply as described under the SXRECINFI1 structure (see 
above).

Info about the
packing of an object

Configures the object structure SXPCKLSTI1 for the debug output.
The same setting options apply as described under the SXRECINFI1 structure (see 
above).

Info about the
sender of an object

Configures the object structure SXRECINFI1 for the debug output.
The following setting options apply: 
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5.1.3  System Properties – System 

 

 

Short Name In combination with the APL name ’SAPR3’ this name defines the description for a logical 
line to the relevant SAP system. In case of the above setting the associated logical line 
carries, for example, the name ’SAPR3APC’.
The name must not exceed eight characters and must be unique. For improved clarity in 
the XPR log we recommend selecting a short name – for example the three letters of the 
SAP system name.

Attention:
In this context the SAPR3 APL does not check whether the specified name may 
have already been allocated for another connection.

Description Defines an optional, short description for the relevant SAP R/3 system.

Automatically establish the 
connection to this system by 
default

Activates an automatic setup of the connection to the relevant SAP R/3 system after 
starting the APL.

Activate privilege verification 
for documents to be
sent

Activates for the relevant SAP R/3 system a check as to whether an SAP user is entered 
in the XPR user database and has in addition the send privilege upon sending a 
message.
If this option is set and the originator is not entered in the XPR user database or does not 
have the send privilege, he/she cannot send messages.
Exception:
If a default user whose XPR mailbox is used by an SAP R/3 user for sending messages 
is specified in the XPR server configuration of the SAP R/3 connection though, the send 
privilege of this default user is checked (cf. Section 6.1.4, “DefaultUser [REG_SZ]”, on 
page 297).

Activate ’autolearn’ mode and 
copy sender attributes to the 
database

Activates the ’autolearn’ mode for the relevant SAP R/3 system (cf. Section 3.2.2.4, “XPR 
Server ’AutoLearn’Mode”, on page 44).
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5.1.4  System Properties – Server 

 

 

Destination from
saprfc.ini

Activates the RFC configuration by the saprfc.ini (cf. Section 3.1.3.3, “Saprfc.ini – the 
RFC Configuration File”, on page 32).
If the RFC parameter configuration for the relevant SAP R/3 system is activated via the 
saprfc.ini, the referencing identifier, under which the associated settings are defined, 
is specified within the saprfc.ini.
This identifier must be unique within the saprfc.ini.

Hostname of 
Gateway

Activates the manual configuration of the RFC parameters without using the 
saprfc.ini and defines the router connect string for the SAP system on which the 
desired gateway service is configured (cf. GWHOST under Section 3.1.3.3, “Saprfc.ini – 
the RFC Configuration File”, on page 32).
This entry field is only active when the Hostname of Gateway option is selected.

Gateway service Defines the gateway service of the SAP system specified under Hostname of Gateway 
(cf. GWSERV in Section 3.1.3.3, “Saprfc.ini – the RFC Configuration File”, on page 32).
The entry always starts with sapgw, followed by two numbers (00-99) – called system 
number. This number specifies among other things the last two digits of the TCP port for 
which the corresponding gateway was configured and represents mostly value 00. In 
case of doubt consult your SAP administrator for the correct system number.
This entry field is only active when the Hostname of Gateway option is selected.

Program ID Defines the program ID for RFC connections to the SAP system specified under 
Hostname of Gateway (cf. PROGID under Section 3.1.3.3, “Saprfc.ini – the RFC 
Configuration File”, on page 32).
The program ID must be configured on the SAP application server and on the XPR server 
in the same way. Respect upper and lower case. Furthermore the ID must be unique.
This entry field is only active when the Hostname of Gateway option is selected.

Fax Polling Activates the option to interpret a ’To Answer’ send attribute set in an SAP fax send job 
as fax polling job for the relevant SAP R/3 system.
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5.1.5  System Properties – Client 

 

 

Destination from
saprfc.ini

Activates the RFC configuration by the saprfc.ini (cf. Section 3.1.3.3, “Saprfc.ini – the 
RFC Configuration File”, on page 32).
If the RFC parameter configuration for the relevant SAP R/3 system is activated via the 
saprfc.ini, the referencing identifier, under which the associated settings are defined, 
is specified within the saprfc.ini (cf. DEST in Section 5.5, “saprfc.ini”, on page 283).
This identifier must be unique within the saprfc.ini.

Hostname of
Appl. Server

Activates the manual configuration of the RFC parameters without using the 
saprfc.ini and defines the router connect string for the SAP application server (cf. 
ASHOST in Section 5.5, “saprfc.ini”, on page 283).
This entry field is only active when the Hostname of Appl. Server option is selected.

Hostname of 
Gateway

Defines the router connect string for the SAP system on which the desired gateway 
service is configured (cf. GWHOST in Section 5.5, “saprfc.ini”, on page 283).
This entry field is only active when the Hostname of Appl. Server option is selected.

Gateway service Defines the gateway service of the SAP system specified under Hostname of Gateway 
(cf. GWSERV in Section 5.5, “saprfc.ini”, on page 283).
The entry always starts with sapgw, followed by two numbers (00-99) – called system 
number. This number specifies among other things the last two digits of the TCP port for 
which the corresponding gateway was configured and represents mostly value 00. In 
case of doubt consult your SAP administrator for the correct system number.
This entry field is only active when the Hostname of Appl. Server option is selected.

System Number Defines the system number of the SAP system specified under Hostname of Gateway 
(cf. SYSNR in Section 5.5, “saprfc.ini”, on page 283).
The system number specifies the last two digits of the TCP port for which the 
corresponding gateway service was configured and represents mostly value 00. In case 
of doubt consult your SAP administrator for the correct system number.
This entry field is only active when the Hostname of Appl. Server option is selected.

Client Specifies the client number under which the RFC client of the SAPR3 APL communicates 
with the SAP R/3 system.
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5.2  SMTP APL

You find reference information about the SMTP APL in the OpenScape 
Xpressions Server Administration manual.

User Specifies the user ID under which the RFC client of the SAPR3 APL communicates with 
the SAP R/3 system.

Password Specifies the password for the above user under which the RFC client of the SAPR3 APL 
communicates with the SAP R/3 system. The entry in this field is hidden.

Confirm Password The above password needs to be re-entered here to avoid typing errors.

Always set EXPRESS flag for 
incoming SMTP documents

Activates the generation of EXPRESS messages under SAP in case of an incoming 
SMTP message.
Via the automatic display of such an EXPRESS message in the SAPGUI, SAP users are 
informed about a newly arrived e-mail.
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5.3  SAPPHONE APL

In this section we describe the following configuration settings for the XPR 
server's SAPphone APL:

• Automated Configuration of the saprfc.ini

• Settings – SAPphone

• Settings – Special Phone Device Settings

• System Properties – General

• System Properties – RFC Server

• System Properties – RFC Client

• System Properties – RFC Login
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5.3.1  Automated Configuration of the saprfc.ini

The SAPphone APL has an automated mechanism to

• store RFC connection settings in the saprfc.ini

• read RFC connection settings from the saprfc.ini.

Storing settings in the saprfc.ini

In SAPphone APL configuration dialogs you can define all information required 
for the configuration of an RFC connection. Of this information only those items 
are stored in the SAPphone APL configuration that do not belong to the 
saprfc.ini parameters. All other information is automatically stored by the 
SAPphone APL in the saprfc.ini as soon as you select the Apply or OK 
button in the SAPphone APL settings configuration dialog.

NOTE:
The SAPphone APL only stores settings for the server or client destination of a 
newly created connection in the saprfc.ini if the relevant server or client desti-
nation does not exist in the saprfc.ini yet.

Reading settings from the saprfc.ini

The SAPphone APL can load RFC connection information from the 
saprfc.ini. The requires at least the configuration of the following settings in 
the SAPphone APL and their storage in the SAPphone APL settings dialog via 
Apply or OK for the connection to be loaded.

• Server Destination on the RFC Server configuration tab 

• Client Destination on the RFC Client configuration tab 

• Client, User and Password on the RFC Login configuration tab.

So that the SAPphone APL can load information from the saprfc.ini, 
appropriate entries must exist in the saprfc.ini for the specified server and 
client destination. If the server and/or client destination does not exist in the 
saprfc.ini, the APL creates the specified server and/or client destination in 
the saprfc.ini.
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5.3.2  Settings – SAPphone 

 

 

Functionality The options listed are currently without function and can therefore not be configured 
individually. For the time being the SAPphone APL generally accepts from SAP R/3 all 
RFC commands defined in the SAPphone interface.

R/3 Systems The list shows the connections that are configured in the SAPphone APL and via which 
the APL can communicate with SAP R/3 systems. The SAPphone APL and the SAP R/3 
systems communicate via the SAPphone interface.
If several clients of an SAP R/3 system are to be connected via the SAPR3 APL, you 
should configure an individual connection to the relevant SAP R/3 system for each client.

Maximum number of
RFC Connections

The LibRFC32.dll by SAP limits the number of parallel RFC connections to value 100 
by default (cf. Section 3.1.3, “RFC Protocol”, on page 29).
With this setting this limitation can be customized for the individual APL.

Add Opens the configuration dialog which you can configure a new connection to an SAP R/
3 system.

Remove Removes the selected connection from the connection list and thus the associated 
connection information from the SAPphone APL configuration.

Properties Shows the configuration of the connection selected in the connection list. Corresponds to 
a double-click on the desired list entry.

Test connection Starts a connection test for the connection selected in the connection list.
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5.3.3  Settings – Special Phone Device Settings 

 

…phone speaker should be 
ENABLED when dialing...

Defines all entries of the following list as extensions of telephone terminal devices for 
which the phone speaker is to be enabled when a call is set up from within the associating 
CTI application.
For a correct functionality this CTI feature must be supported by the PBX. Furthermore, 
additional settings must be performed at the PBX if required.

…phone speaker should be 
DISABLED when dialing...

Defines all entries of the following list as extensions of telephone terminal devices for 
which the phone speaker is to be disabled when a call is set up from within the associating 
CTI application.
For a correct functionality this CTI feature must be supported by the PBX. Furthermore, 
additional settings must be performed at the PBX if required.

Extension List The list displays the extensions of the telephones for which the above speaker option is 
to apply.

Add Adds a new entry to the extension list. Single extensions as well as entire extension 
ranges may be entered. The latter ones are entered with a ’–’ character (for example 100–
200).
Entries in an invalid format will not be copied.

Remove Removes the currently selected entry from the extension list. If no entry is selected, this 
button is inactive.

Change Enables the modification of the currently selected entry in the extension list. If no entry is 
selected, this button is inactive.
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5.3.4  System Properties – General 

 

 

System Number Defines the system number of the SAP R/3 system.
The system number specifies the last two digits of the TCP port for which the 
corresponding gateway service was configured and represents mostly value 00. In case 
of doubt consult your SAP administrator for the correct system number.
This setting is automatically loaded from the saprfc.ini after the initial storing of the 
connection (cf. Section 5.3.1, “Automated Configuration of the saprfc.ini”, on page 274).

Free inwait mode/ … Activates the free inwait mode. This mode is not supported anymore.

Activate connection to the R/3 
system

Specifies whether the relevant connection is automatically booted upon the SAPphone 
APL start.

Enable daily restart Activates a daily restart for the relevant connection to terminate the RFC connections no 
longer required for this connection.

Working day stop time Specifies the time at which the relevant connection is stopped on working days.

Working day start time Specifies the time at which the relevant connection is started on working days.

Weekend stop time Specifies the time at which the relevant connection is stopped on weekend days.

Weekend start time Specifies the time at which the relevant connection is started on weekend days.
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5.3.5  System Properties – RFC Server 

 

Server Destination Specifies the identifier under which the server configuration files for the relevant 
connection are to be stored or are stored in the saprfc.ini.

Max. Server Connections Specifies the maximum number of RFC server connections for the relevant connection 
(cf. Section 3.1.3, “Number of RFC connections via SAPphone”, on page 31).

Program ID Specifies the program ID for the relevant connection (cf. PROGID in Section 3.1.3.3, 
“Saprfc.ini – the RFC Configuration File”, on page 32).
The program ID must be configured on the SAP application server and on the XPR server 
in the same way. Respect upper and lower case. Furthermore the ID must be unique.
This setting is automatically loaded from the saprfc.ini after the initial storing of the 
connection (cf. Section 5.3.1, “Automated Configuration of the saprfc.ini”, on page 274).

Host Defines the router connect string for the SAP system on which the desired gateway 
service is configured (cf. GWHOST in Section 5.5, “saprfc.ini”, on page 283).
This setting is automatically loaded from the saprfc.ini after the initial storing of the 
connection (cf. Section 5.3.1, “Automated Configuration of the saprfc.ini”, on page 274).

RFC Trace Activates monitoring of the RFC communication between XPR server and SAP R/3 
system.
This setting is automatically loaded from the saprfc.ini after the initial storing of the 
connection (cf. Section 5.3.1, “Automated Configuration of the saprfc.ini”, on page 274).

Attention:
This setting may be activated for test purposes only!
If the RFC communication logging is activated, the system load may reach a level 
that negatively affects 'real-life' operation.
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5.3.6  System Properties – RFC Client 

 

Client Destination Specifies the identifier under which the client configuration files for the relevant 
connection are to be stored or are stored in the saprfc.ini.

SAP Application Server If this option is activated, the SAPphone APL RFC client service starts only if required and 
does not prematurely register with the SAP application server.
This configuration corresponds in the saprfc.ini to the setting: Type=A.
This setting is automatically loaded from the saprfc.ini after the initial storing of the 
connection (cf. Section 5.3.1, “Automated Configuration of the saprfc.ini”, on page 274).
This entry field is only displayed if the SAP System using load balancing option is 
selected.

SAP System using load 
balancing

If this option is activated, the SAPphone APL RFC client service supports the load 
balancing feature.
This configuration corresponds in the saprfc.ini to the setting: Type=B.
This setting is automatically loaded from the saprfc.ini after the initial storing of the 
connection (cf. Section 5.3.1, “Automated Configuration of the saprfc.ini”, on page 274).
This entry field is only displayed if the SAP System using load balancing option is 
selected.

Host Defines the router connect string for the SAP application server (cf. ASHOST in Section 
5.5, “saprfc.ini”, on page 283).
This setting is automatically loaded from the saprfc.ini after the initial storing of the 
connection (cf. Section 5.3.1, “Automated Configuration of the saprfc.ini”, on page 274).

SAP System Number Defines the system number of the SAP R/3 systems.
The system number specifies the last two digits of the TCP port for which the 
corresponding gateway service was configured and represents mostly value 00. In case 
of doubt consult your SAP administrator for the correct system number.
This entry field is only displayed if the SAP System using load balancing option is 
selected.
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Group name Defines the name of the group in which the SAP R/3 systems to be used for load 
balancing are compiled.
This entry field is only displayed if the SAP System using load balancing option is 
selected.

RFC Trace Activates monitoring of the RFC communication between XPR server and SAP R/3 
system.
This setting is automatically loaded from the saprfc.ini after the initial storing of the 
connection (cf. Section 5.3.1, “Automated Configuration of the saprfc.ini”, on page 274).

Attention:
This setting may be activated for test purposes only!
If the RFC communication logging is activated, the system load may reach a level 
that negatively affects 'real-life' operation.
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5.3.7  System Properties – RFC Login 

 

Client Specifies the client number under which the RFC client of the SAPPHONE APL 
communicates with the SAP R/3 system.

User Specifies the user ID under which the RFC client of the SAPPHONE APL communicates 
with the SAP R/3 system.

Password Specifies the password for the above user under which the RFC client of the SAPPHONE 
APL communicates with the SAP R/3 system.
The entry in this field is hidden.

Confirm Password The above password needs to be re-entered here to avoid typing errors.
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5.4  XML APL

This section describes all XPR server XML APL configuration settings.
 

 

IP-Address Defines the network card IP address used for the HTTP server of the XPR server. Via this 
interface the SOAP/HTTP communication of the ICI interface is lead to the SAP R/3 
system.

Port Defines the TCP port used for the HTTP communication of the HTTP server.

Config.xml Defines the path under which the configuration file for the HTTP server is stored.
The configuration file XmlApl.config.xml is copied to the 
<XPR Install>\res\XmlApl directory during the XPR server installation by default.
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5.5  saprfc.ini 

The saprfc.ini file is a configuration file of the LibRFC32.dll. It is used to 
configure the interfaces SAPconnect and SAPphone of the XPR server for the 
RFC communication with an SAP application server.

The saprfc.ini must be stored in the <XPR Install>\bin\ directory by default.

As alternative to such defaulted paths you can define an individual directory 
under the Windows environment variable RFC_INI for storing the saprfc.ini. 
To copy this optional modification of the system variable, you need to reboot the 
XPR server platform.

Example extract from the saprfc.ini:

[…]

[RFC-SERVER]
DEST=SRV
TYPE=R
PROGID=CE6_850_MMCC
GWHOST=/H/194.77.158.13/H/…/S/3297/H/cpce601
GWSERV=sapgw00
RFC_TRACE=0

[RFC-CLIENT]
DEST=CE6
TYPE=A
ASHOST=/H/194.77.158.13/H/…/S/3297/H/cpce601
SYSNR=00
RFC_TRACE=0
ABAP_DEBUG=0
USE_SAPGUI=0

[…]

List and description of the relevant entries:
 

[RFC SERVER] Specifies the beginning of the parameters for the server communication of a RFC 
connection (optional; see parameter DEST).

[RFC CLIENT] Specifies the beginning of the parameters for the client communication of a RFC 
connection (optional; see parameter DEST).
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DEST Identifier according to which the XPR server LibRFC.dll references the required entry in 
the saprfc.ini. Owing to its referencing character this parameter must be unique 
each!
The entries for the next SAP system begin with this parameter by definition. For this 
reason the DEST entry must be present in the first line for the entries of the associating 
SAP system.
The values specified here must correspond to the entries in the following places:

SAPR3 APL
Corresponds to the configuration entry in the "Destination from saprfc.ini" field under 
the client’s system properties.
Corresponds to the configuration entry in the "Server destination" field under the system 
properties of the RFC configuration.

SAPphone APL
Corresponds to the configuration entry in the "Client destination" field under the system 
properties of the RFC configuration.
Corresponds to the configuration entry in the "Server destination" field under the system 
properties of the RFC configuration.

TYPE This entry defines the manner in which the XPR server accesses the SAP application 
server via the RFC protocol.
Common parameters for an XPR-SAP integration are:

R – Registering
May be configured for the RFC server of the XPR server. In this way the RFC server of 
the SAPR3 or SAPPHONE APL registers with the SAP gateway host as available service 
and waits for queries by the RFC client.

A – Starting up
May be configured for the RFC client of the XPR server. The RFC client service of the 
SAPR3 respectively SAPphone APL is in this configuration only started when needed and 
not prematurely registered with the SAP application server as is the case with type R.

B – Load Balancing
May be configured for the RFC client of the XPR server. The RFC client service of the 
SAPR3 respectively SAPphone APL supports in case of this type the load balancing 
feature.

PROGID The program ID serves for authenticating an RFC communication.
It must be configured on the SAP application server and on the XPR server in the same 
way. Respect upper and lower case.

GWHOST This parameter of the RFC server contains the router connect string to the host on which 
the desired gateway server is configured. Make sure that the expression specified ends 
in the host name or the IP address of the SAP destination system.

GWSERV Here the name of the desired gateway service is specified. This name always begins with 
sapgw, followed by two numbers – called system number. This number specifies among 
other things the last two digits of the TCP port for which the corresponding gateway 
service was configured and represents mostly value 00.
SAP gateway servers operate with a TCP port within the range of 3300 to 3399. With the 
parallel operation of further SAP services (for example dispatcher) on an application 
server, all services must be configured for different TCP ports. For the SAP gateway 
service, TCP port 3300 is used by default.

RFC_TRACE Activates monitoring of the RFC communication between XPR server and SAP R/3 
system.
Possible values for this setting are:

RFC_TRACE=0: 
RFC_TRACE=1:

RFC tracing deactivated
RFC tracing activated
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ASHOST This RFC client parameter contains the router connect string to the host that is configured 
as application server. Make sure that the expression specified ends in the host name or 
the IP address of the SAP destination system.

SYSNR The system number corresponds to the system number displayed in the SAPGUI under 
the application server properties (cf. parameter GWSERV). It is mostly 00.
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5.6  SAP R/3 Client SAPphone 

The SAPphone is the SAP R/3 Softphone application. In this function it provides 
all elements for simple telephone operation.

The following illustration provides an overview of the SAPphone user interface 
elements.
 

In the upper portion a field informs about the current telephone connection. 
Thereunder, seven tabs provide displays and functions for various call situations. 
On the right hand side you will find buttons for basic functions.

The following table describes the most important interface areas.
 

Call status
portion

This field provides information on the SAPphone status – thus on the assigned telephone 
terminal device. Here a current call is displayed and basic information on the caller and 
the individual telephone is given.
The field format varies according to the number of connected callers. While up to two 
connections are displayed in individual windows, connections to more than two 
subscribers are indicated in a list.

’Dial’ tab Provides displays and functions for the establishment of single telephone connections.

’Consult’ tab Provides displays and functions for setting up a consultation. After establishing the 
connection you can continue in three different ways:
Connecting the original caller with the consulted subscriber
Setting up a three-party conference with both subscribers
Terminating the consultation to return to the original subscriber
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The following table describes the most important operating elements.
 

’Transfer’ tab Provides displays and functions for call forwarding. The subscriber can be forwarded with 
or without consultation.

’Conference’ tab Provides displays and functions for setting up and administering conferences.

’Call partner’ tab Provides information on the conversational partner. Prerequisite is an ANI-Hit in the 
configured SAP R/3 data range (cf. Section 3.2.1, “Address Formats and ANI Hits”, on 
page 39).

Hang up all Clears the connection to all currently connected subscribers.
If only one conversation is going on, this connection is cleared. If several connections 
have been set up (e.g. in a self-established conference or consultation), all connections 
are cleared.

Accept Answers an incoming call.

Hang up Clears the connection to a single subscriber.
If only one conversation is going on, this connection is cleared. If several connections 
have been set up (e.g. in a conference or a consultation), one needs to be selected for 
termination.

Initiate Initiates a new call.

Hold Switches the current call to status Hold and enables in this way a subsequent 
consultation.

Deflect Enables rerouting of incoming calls.

Change Enables toggling between several existing telephone calls.

Retrieve Terminates a consultation and connects to the original subscriber.
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5.7  mySAP CRM Interaction WebClient (IC WebClient)

The IC WebClient is used as SAP user interface if an SAP R/3 system is 
connected to the XPR server via the ICI interface.
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5.8  CyViewer

The CyViewer is an XPR client that enables the display of fax messages and the 
output of audio files (for example voice mails) on a telephone. It works on the 
basis of the MSP.

The following figure provides an overview of the CyViewer Wave Player 
elements. 
 

The following table introduces the Wave Player operating elements.
 

Starts sound file playback via the speakers of the respective PC.

Starts sound file playback via the telephone terminal device that is assigned to the 
corresponding PC by CTI.
This option is only available when the PlayWave protocol has been installed in the 
relevant XPR server Telematic APL.

If an audio file playback was started before selecting this icon, the output is stopped in 
the current position. Another playback starts where the message begins.
If an audio file recording was started before selecting this icon, the recording is stopped 
and terminated.

Skips to the beginning of the message of which the output was previously started via PC 
or telephone terminal device.

Skips to the end of the message of which the output was previously started via PC or 
telephone terminal device (for example to attach an annotation).

Starts message recording via the telephone terminal device without the receiver having 
to be picked up. When this option is selected, the CTI work center telephone signalizes 
the recording request with a ringing tone.
This option is only available when the PlayWave protocol has been installed in the 
relevant XPR server Telematic APL.

Starts recording a message via the microphone of the PC on which the SAP Voice Player 
was started.

Opens the configuration dialog for the system settings of the SAP Voice Player (cf. 
Section 5.8, “Configuration dialog”, on page 290).

Displays the relative time position within a played file via a position slide.
Through moving the position slide with the mouse you can head for a specific position in 
the voice message.

Displays the absolute time position during the playback or recording of a sound file.

Displays the entire sound file length. During a recording this display contains the same 
value as in Position, since the file length grows continuously in this case.
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Configuration dialog

The configuration dialog enables the definition of some SAP Voice Player 
properties.
 

The following table describes the available operating elements.
 

You find further information on the CyViewer – for example on fax message 
display – in the Client Applications XPR documentation.

Displays the calling number of the telephone terminal device on which a sound file is put 
out.

Displays the current SAP Voice Player status.
Possible values are:
• Stopped
• Playing
• Recording
• Paused

Local Telephone Number Displays the calling number of the telephone terminal device on which sound files are put 
out.

Voice Message Format Specifies the coding method with which the SAP Voice Player records or plays sound 
files. Possible values are:
• A-Law (common in Europe)
• µ-Law (common in the US and Asia)
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Registry Values

SAPR3 APL Registry Keys

6  Registry Values

The registry information contained in this chapter is divided into the following 
sections:

• SAPR3 APL Registry Keys

• Registry Values of the SMTP APL

• Registry Values of the SAPphone APL

• Registry Values of the XML APL

• Registry Values of the MSPTSP

6.1  SAPR3 APL Registry Keys

In the following we describe the keys of the SAPR3 APL with their respective 
values in the Windows Registry. This information is structured as follows:

• SAPR3 APL Registry Keys

• Registry Values of the Converter

• Registry Values of the StructHandler

• Registry Values of the SAP R/3 Systems

• Registry Values of the RFC Client

• Registry Values of the RFC Server
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6.1.1  SAPR3 APL Registry Keys

The following values are found under the key

HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\Sapr3Apl

Formats [REG_SZ] 

Defines the global list of valid document and file formats supported by all 
logical lines of the SAPR/3 APL. Per system, an additional definition can be 
made in the appropriate place that overrides this global setting for the 
respective line. The formats are described in detail in the OpenScape 
Xpressions Server Administration manual.

OverwriteUserData [REG_DWORD]  

Defines whether user data already available in the user database may be 
overridden with deviating user data from SAP.

QualifiedMrsHostname [REG_SZ]  

Defines the XPR server host name that can be addressed with an INT 
address from within SAP R/3 to use XPR services that cannot be directly 
addressed under SAP R/3.

Cf. Section 5.1.1, “Settings – General Settings”, on page 267.

SystemStartWaitTime [REG_DWORD] 

Defines the waiting time in ms until the first or next RFC client or RFC server 
connection to an SAP system defined in the SAPR3 APL is set up.

Default: PMF,ASC,TXT,WAV,AS7,PS,TIF,BIN,TIF_MUL

Possible values: AS7, ASC, BIN, PMF, PS, TG3, TG4, TIF, TIF_BMP, TIF_MUL, 
TXT, WAV, WAV_16, WAV_A, WAV_MU

Default: 0

Possible values: 0 – Available user data cannot be overridden
1 – Available user data can be overridden

Default: <empty string>

Possible values: <host name>

Default: 5000 [milliseconds]

Possible values: <number> [milliseconds]

Remark: This value must not be changed since an alteration may cause 
connection problems with the LibRFC32.dll.
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6.1.2  Registry Values of the Converter

The following values are found under the key

HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\Sapr3Apl\Converter

EmptyFaxOriginator [REG_SZ]  

Defines a fax address to which messages without originator address destined 
for SAP R/3 are automatically assigned. This assignment is based on the fact 
that SAP R/3 does not accept messages without originator address.

RemoveRawFileExtension [REG_DWORD]  

If a file is sent via the SAPR/3 APL as e-mail attachment, the APL adds the 
appropriate file extension (e.g. .AUF) to the file name.

The registry value RemoveRawFileExtension defines whether an already 
existing file extension is cut off of the original file name before the new 
extension is attached by the APL.

SetOriginatorFaxG3ldProperty [REG_DWORD]  

Defines which information are copied to the fax ID and fax header of a fax 
message by the XPR server.

There is the option to insert the values (fax ID and originator number) 
transferred by SAP R/3 to the XPR server or to copy the corresponding 
values from the XPR user database.

Default: *XXX*

Possible values: <fax address>

Default: 0

Possible values: 0 – Original file name extension is maintained
1 – Original file name extension is removed

Default: 1

Possible values: 0 – Copy values from the XPR user database
1 – Copy values from SAP R/3
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6.1.3  Registry Values of the StructHandler

The following values are found under the key

HKLM\SOFTWARE\Wow6432Node\PP-
COM\MRS\Sapr3Apl\StructHandler

DumpModeSXDOCCHGI1 [REG_DWORD]  

Defines the form in which debug information about the object properties is put 
out.

DumpModeSXEXTRECI1 [REG_DWORD]  

Defines in which form debug information about the recipient(s) of an object is 
put out.

DumpModeSXPCKLSTI1 [REG_DWORD]  

Defines in which form debug information about the content lists of an object 
is put out.

DumpModeSXRECINFI1 [REG_DWORD]  

Defines the form in which debug information about the object sender is put 
out.

Default: 0

Possible values: 0 – Off
1 – Detailed scope
2 – Normal scope

Default: 0

Possible values: 0 – Off
1 – Detailed scope
2 – Normal scope

Default: 0

Possible values: 0 – Off
1 – Detailed scope
2 – Normal scope

Default: 0

Possible values: 0 – Off
1 – Detailed scope
2 – Normal scope
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DumpModeSXSYSDATI1 [REG_DWORD]  

Defines the form in which debug information about the RFC calls is put out.

InfoLevel [REG_DWORD]  

Defines under which debug level of the XPR monitor the SAPR3 APL sends 
special debug objects to the monitor. To display the messages thus 
transmitted to the XPR server in the monitor, the corresponding debug level 
must be active in the XPR monitor.

6.1.4  Registry Values of the SAP R/3 Systems

The following values are found under the key

HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\Sapr3Apl\System[x]

Active [REG_DWORD]  

Defines whether or not the connection to the relevant system with number ’x’ 
is active.

If the connection is indicated as active at the SAPR3 APL start, the 
communication to the associated SAP R/3 system is automatically set up.

Default: 0

Possible values: 0 – Off
1 – Detailed scope
2 – Normal scope

Default: 1

Possible values: <1…4>

Default: 1

Possible values: 0 – Automatic system start inactive
1 – Automatic system start active
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AutoLearn [REG_DWORD]  

Defines whether the ’Autolearn’ mode is switched on or off.

The ’AutoLearn’ mode creates a new XPR user profile for those users who 
send a message via the XPR server but are not yet known as XPR users. 
Besides creating such new XPR user profiles, ’AutoLearn’ also extends 
existing profiles with additional address information of the relevant user (cf. 
Section 3.2.2.4, “XPR Server ’AutoLearn’Mode”, on page 44).

To determine whether an XPR profile that belongs to the sending user already 
exists, a search is performed via the respective address type (fax, pager etc.) 
and name (first and second name) transferred by the SAP R/3 system.

AutoLearnEntries [REG_MULTI_SZ]  

Defines the database fields that, with active ’AutoLearn’ mode, are 
automatically assigned to the XPR database if they do not yet exist for the 
relevant user or are empty. This behavior also applies for creating users who 
are still unknown.

The listed assignments thus serve as definition for default values in user 
profiles allocated by the ’AutoLearn’ mode (cf. Section 3.2.2.4, “XPR Server 
’AutoLearn’Mode”, on page 44).

Default: 0

Possible values: 0 – ’Autolearn’ mode not active.
1 – ’Autolearn’ mode active.

Remarks: By default, the XPR server does not override address information 
already entered in the XPR database. If this behavior is desired, 
the OverwriteUserData [REG_DWORD] registry value must be 
set. This value can be set globally for all SAP R/3 systems as well 
as individually for each system.

Default: <Empty>

Possible values: Each single line in the format <database field>=<content>
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DefaultUser [REG_SZ]  

If the XPR server cannot find a sending SAP user in its user database while 
the ’AutoLearn’ mode is inactive, the message is sent from the user profile 
defined here. This user profile must be defined in the XPR database for this 
purpose.

If no default user is named in this registry value, messages of unknown SAP 
users are in case on an inactive ’AutoLearn’ mode merely sent with 
anonymous originator address.

DeliverToSAPAsEmail [REG_DWORD]  

Defines whether messages of all types are generally delivered as e-mail 
under SAP R/3.

Description [REG_SZ] 

Defines a description that is displayed in the XPR monitor for the relevant 
logical line or for the SAP system that can be reached via this line.

FaxG3Headline [REG_SZ]  

Defines a Fax G3 fax header line deployed for all users of the relevant system 
if the line is activated via UsePerSystemFaxIds [REG_DWORD].

FaxG3Id [REG_SZ]  

Defines a Fax G3 ID deployed for all users of the relevant system if the ID is 
activated via UsePerSystemFaxIds [REG_DWORD].

Default: <empty string>

Possible values: <user ID>

Default: 0

Possible values: 0 – General e-mail delivery inactive
1 – General e-mail delivery active

Default: <empty string>

Possible values: <string with a maximum of 128 characters>

Default: <empty string>

Possible values: <string>

Remark: Is used in combination with UsePerSystemFaxIds 
[REG_DWORD].

Default: <empty string>

Possible values: <fax ID>

Remark: Is used in combination with UsePerSystemFaxIds 
[REG_DWORD].
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FaxG3Nr [REG_SZ]  

Defines a fax number deployed for Fax G3 messages of all users of the 
relevant system if the number is activated via UsePerSystemFaxIds 
[REG_DWORD].

FaxG4Id [REG_SZ]  

Defines a Fax G4 ID deployed for all users of the relevant system if the ID is 
activated via UsePerSystemFaxIds [REG_DWORD].

FaxG4Nr [REG_SZ]  

Defines a fax number deployed for Fax G4 messages of all users of the 
relevant system if the number is activated via UsePerSystemFaxIds 
[REG_DWORD].

Default: <empty string>

Possible values: <calling number>

Remark: Is used in combination with UsePerSystemFaxIds 
[REG_DWORD].

Default: <empty string>

Possible values: <fax ID>

Remark: Is used in combination with UsePerSystemFaxIds 
[REG_DWORD].

Default: <empty string>

Possible values: <calling number>

Remark: Is used in combination with UsePerSystemFaxIds 
[REG_DWORD].



06-SAP-RegistryKeys.fm

Registry Values

SAPR3 APL Registry Keys

A31003-S2370-M103-4-76A9, 10/2014
OpenScape Xpressions V7 SAP R/3 Gateway, Installation and Administration Manual 299

          

Formats [REG_SZ] 

Defines a list of valid document and file formats for this logical line. See also 
the global entry Formats [REG_SZ].

Name [REG_SZ]  

Defines a name that forms in combination with ’SAPR3’ the name of the 
logical line: SAPR3<name>.

Example: Name=’APC’ => Name of the logical line=’SAPR3APC’

OverwriteUserData [REG_DWORD]  

Defines whether user data already available in the user database may be 
overridden with deviating user data from SAP.

If this system-related registry value is not active, value OverwriteUserData 
[REG_DWORD], which is globally defined under <XPR Install>\Sapr3Apl, 
is used.

Default: <empty string>

Possible values: <string with a maximum of 128 characters>

Default: <empty string>

Possible values: <string with a maximum of 8 characters>

Remark: Must be a unique name.

Default: 0

Possible values: 0 – Available user data cannot be overridden
1 – Available user data can be overridden



Registry Values

06-SAP-RegistryKeys.fm

SAPR3 APL Registry Keys

 A31003-S2370-M103-4-76A9, 10/2014
300 OpenScape Xpressions V7 SAP R/3 Gateway, Installation and Administration Manual

         

PrivCheck [REG_DWORD]  

Activates for the relevant SAP system a check as to whether an SAP user is 
entered in the XPR user database and has in addition the send privilege upon 
sending a message.

If this option is set and the originator is not entered in the XPR user database 
or does not have the send privilege, he/she cannot send messages.

Exception:
If a default user whose XPR mailbox is used by an SAP R/3 user for sending 
messages is specified in the XPR server configuration of the SAP R/3 
connection though, the send privilege of this default user is checked (cf. 
DefaultUser [REG_SZ]). The requirement is here that the actually sending 
user is not entered in the XPR database.

UsePerSystemFaxIds [REG_DWORD]  

Activates system-individual fax IDs for all users of the relevant SAP system.

Default: 0

Possible values: 0 – Originator check inactive
1 - Originator check active

Default: 0

Possible values: 0 – System-individual fax IDs are not used
1 – System-individual fax IDs are used

Remark: Is used together with the following values:
• FaxG3Headline [REG_SZ]
• FaxG3Id [REG_SZ]
• FaxG3Nr [REG_SZ]
• FaxG4Id [REG_SZ]
• FaxG4Nr [REG_SZ]
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6.1.5  Registry Values of the RFC Client

The following values are found under the key

HKLM\SOFTWARE\Wow6432Node\PP-
COM\MRS\Sapr3Apl\System[x]\Client

ApplicationServerHost [REG_SZ]  

Defines the TCP/IP host name or the IP address of the SAP R/3 application 
server.

This registry has no effect if through the setting in the client registry value 
UseDestination [REG_DWORD] the corresponding RFC parameter is 
configured via the saprfc.ini .

ConnectRetryDelay [REG_DWORD]  

Defines the time in seconds after which a failed connection setup to an SAP 
system is initiated again.

Destination [REG_SZ]  

Defines the referencing string for the RFC connection data of the RFC client 
in the saprfc.ini.

Default: <empty string>

Possible values: <host name> or <IP address>

Default: 10 [Seconds]

Possible values: <1…600> [seconds]

Default: <empty string>

Possible values: <string>

Remark: Must be a unique name.
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GatewayHost [REG_SZ]  

Defines the host name or the IP address of an SAP gateway server.

This registry has no effect if through the setting in the client registry value 
UseDestination [REG_DWORD] the corresponding RFC parameter is 
configured via the saprfc.ini .

GatewayService [REG_SZ]  

Defines a gateway service on an SAP application server. Wildcard ’xx’ 
defines the system number of the relevant service.

This registry has no effect if through the setting in the client registry value 
UseDestination [REG_DWORD] the corresponding RFC parameter is 
configured via the saprfc.ini .

PendingReport [REG_BINARY]  

If the SAPR3 APL is shut down, such APL reports can be buffered here that 
were due before the APL stop but could not be sent in time.

RfcClient [REG_SZ]  

Defines the SAP tenant number used by the RFC client.

Default: <empty string>

Possible values: <host name> or <IP address>

Default: sapgw00

Possible values: sapgw<xx>; xx = 00…99

Default: <Empty>

Possible values: Binary information

Remark: Modifications may lead to system errors.

Default: 100

Possible values: <SAP tenant number> 
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RfcLanguage [REG_SZ]  

Specifies the login language under SAP R/3. Only specifications configured 
on the relevant SAP system are useful.

Example: d, e

RfcPassword [REG_SZ]  

Defines the user password with which the RFC client logs on to the SAP 
system deploying the associated CPI-C user.

RfcTrace [REG_DWORD]  

Defines whether the RFC logging is switched on or off.

The created log files (*.trc) are defined by the LibRFC32.dll and can be 
found in its setup directory or under the path that was defined in the 
RFC_TRACE_DIR environment variable.

RfcUser [REG_SZ]  

Defines the user ID with which the RFC client logs on to the SAP system 
deploying the associated CPI-C user.

SmtpExpress [REG_DWORD]  

Defines whether or not an SAP user receives an express message that 
notifies him/her about a newly arrived e-mail.

Default: <empty string>

Possible values: <SAP language token>

Default: <Default password>

Possible values: <Password>

Remark: Is administered in the registry in encrypted format and should 
therefore be modified via the XPR GUI only.

Default: 0

Possible values: 0 – Deactivated
1 – Activated

Remark: This switch has nothing to do with the debug outputs of the SAPR3 
APL via the XPR monitor.

Default: MRSC

Possible values: <user ID>

Remark: Entry required.

Default: 0

Possible values: 0 – No express message delivery
1 – Express message delivery
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SystemNumber [REG_SZ]  

Defines the system number of the gateway service on an SAP application 
server.

This registry has no effect if through the setting in the client registry value 
UseDestination [REG_DWORD] the corresponding RFC parameter is 
configured via the saprfc.ini .

UseDestination [REG_DWORD]  

Defines whether the configuration data required for the RFC connection are 
read out of the saprfc.ini or XPR registry.

Default: 0

Possible values: <SAP system number>

Default: 1

Possible values: 0 – Does not use the saprfc.ini
1 – Uses the saprfc.ini

Remark: Setting ’1’ recommended
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6.1.6  Registry Values of the RFC Server

The following values are found under the key

HKLM\SOFTWARE\Wow6432Node\PP-
COM\MRS\Sapr3Apl\System[x]\Server

ConnectRetryDelay [REG_DWORD]  

Defines the time in seconds after which a failed connection setup is initiated 
again.

Destination [REG_SZ]  

Defines the referencing string for the RFC connection data of the RFC server 
in the saprfc.ini.

FaxPollByToAnswer [REG_DWORD]  

Defines whether a set ’Answer required’ send attribute in an SAP fax send job 
is interpreted as fax polling job.

GatewayHost [REG_SZ]  

Defines the host name or the IP address of an SAP gateway server.

This registry value has no effect if through the setting in the server registry 
value UseDestination [REG_DWORD] the corresponding RFC parameter is 
configured via the saprfc.ini .

Default: 10 [Seconds]

Possible values: <1…600> [seconds]

Default: <empty string>

Possible values: <string>

Remark: Must be a unique name.

Default: 0

Possible values: 0 – Does not interpret the send attribute as fax polling job
1 – Interprets the send attribute as fax polling job

Default: <empty string>

Possible values: <hostname> or <IP address>
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GatewayService [REG_SZ]  

Defines a gateway service on an SAP application server. Wildcard ’xx’ 
defines the system number of the relevant service.

This registry value has no effect if through the setting in the server registry 
value UseDestination [REG_DWORD] the corresponding RFC parameter is 
configured via the saprfc.ini .

ProgramId [REG_SZ]  

Defines the program ID required for the authentication of an RFC connection.

This registry value has no effect if through the setting in the server registry 
value UseDestination [REG_DWORD] the corresponding RFC parameter is 
configured via the saprfc.ini .

RfcTrace [REG_DWORD]  

Defines whether the RFC logging is switched on or off.
The created log files (*.trc) are defined by the LibRFC32.dll and can be 
found in its setup directory or under the path that was defined in the 
RFC_TRACE_DIR  environment variable.

This switch has nothing to do with the debug outputs of the SAPR/3 APL via 
the XPR monitor.

Default: sapgw00

Possible values: sapgw<xx>; xx = 00…99

Default: <empty string>

Possible values: <program ID>

Remark: Must be a unique name. Furthermore, heed case sensitivity.

Default: 0

Possible values: 0 – RFC logging inactive
1 – RFC logging active
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StrictStatusReporting [REG_DWORD]  

Defines whether status reports are strictly only sent if this was expressly 
defined in the SAP structure SXEXTRECI1.

Non-strict behavior is useful when status reports for transmitted fax 
messages are desired in SAP R/3. The background is that SAP R/3 does 
normally not request status reports for a fax message. Consequently, the 
originator does not know whether or not the document was successfully 
transmitted.

If strict reporting is activated, the send attributes NOTIF_DEL, NOTIF_READ 
and NOTIF_NDEL of the SXEXTRECI1 structure define whether or not the 
respective status reports are transmitted.

UseDestination [REG_DWORD]  

Defines whether the configuration data required for the RFC connection are 
read out of the saprfc.ini or registry.

Default: 0

Possible values: 0 – No strict reporting
1 – Strict reporting

Default: 1

Possible values: 0 – Does not use the saprfc.ini
1 – Uses the saprfc.ini

Remark: Setting ’1’ recommended
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6.2  Registry Values of the SMTP APL

In the following we describe the registry values of the SMTP APL used for the 
SMTP interface with SAP. You find information about further registry values of the 
SMTP APL in the OpenScape Xpressions Server Administration manual.

DefaultSapUsers [REG_MULTI_SZ] 

If a message is sent via the SMTP interface of the SMTP APL the originator 
of which is unknown in the XPR server, the SMTP APL can deploy the 
settings of a default user to send the message. Such settings may be e.g.: fax 
stationery or send privileges.

Each line of the registry value DefaultSapUsers [REG_MULTI_SZ] specifies 
the default user for a selected domain.

SAP_Enable [REG_DWORD] 

Defines whether the SMTP interface for SAP is activated in the SMTP APL.

Default: –

Possible values: One pair of values <user>;<domain> per line

Default: 1

Possible values: 0 – Deactivates the SMTP interface for the SAP connection
1 – Activates the SMTP interface for the SAP connection
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6.3  Registry Values of the SAPphone APL

In the following we describe the keys of the SAPphone APL with their respective 
values in the Windows Registry. This information is structured as follows:

• Registry Values of the SAPphone APL

• Registry Values of the SAP R/3 Systems

• Registry Values of the SAP R/3 System Location

6.3.1  Registry Values of the SAPphone APL

The following values are found under the key

HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\SapPhoneApl

CADOwners [REG_MULTI_SZ]  

The XPR server components that support CAD transfer their CAD information 
to the CTI APL. There, the CAD information is administered call-related.

Besides the productive data of a CAD information the CTI APL stores a name 
that defines in which context the information was filed. This name is the so-
called CAD-Owner.

CADOwners [REG_MULTI_SZ] contains a list of all CAD-Owners of which 
the SAPphone APL processes CAD information to transfer it to the connected 
SAP R/3 system. Each line of this list contains precisely one CAD owner.

NOTE:
CAD information that was created by the SAPphone APL itself is processed 
by the SAPphone APL without further configuration. The CAD-Owner of the 
SAPphone APL thus need not be defined in this registry value.

Ext_List [REG_SZ]  

List of the telephone extensions for which the registry value Ext_Speaker 
[REG_DWORD] is used.

Default: –

Possible values: VOGUE

Remark: This registry value must be added to the registry manually if 
required.

Default: <empty string>

Possible values: <telephone extension>
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The entries are either separated with ’–’ (<DW1>–<DW2>  for an extension 
range) or ’,’ (<DW1>,<DW2>  for a simple list). Any combination of these 
enumeration characters is also possible.

Ext_Speaker [REG_DWORD]  

Defines whether the speakers of the telephones listed in the registry value 
Ext_List [REG_SZ] are automatically activated or remain inactive upon the 
selection via the SAPphone APL.

MrsAddress [REG_SZ]  

Defines the logical line name used by the SAPphone APL to log on to the 
server.

6.3.2  Registry Values of the SAP R/3 Systems

The following values are found under the key

HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\SapPhoneApl\System[x]

CliActive [REG_DWORD]  

Defines whether system reports are transmitted to the relevant system with 
number ’x’.

If the system reports are deactivated, e.g. no monitor information of 
telephones or connection statuses are transmitted to the relevant system. In 
this way the information flow can be controlled in an XPR-SAP environment 
with different application servers.

Default: 0

Possible values: 0 – Deactivated
1 – Activated

Default: NVS:SAPPHONE

Possible values: <qualified XPR address>

Remark: We recommend to keep the defaulted settings.

Default: 1

Possible values: 0 – System reports are not transmitted via the system link
1 – System reports are transmitted via the system link
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CliDest [REG_SZ]  

Defines the referencing string for the RFC connection data of the RFC client 
in the saprfc.ini.

Client [REG_SZ]  

Defines the SAP tenant number used by the RFC client.

LastCallHandle [REG_DWORD]  

Defines the last call handle used for SAP calls.

This entry is automatically written by the SAPphone APL; a manual definition 
is therefore not useful.

MaxServerConnections [REG_DWORD]  

Defines the maximum number of parallel RFC server connections that the 
XPR server can operate via the SAPphone APL to connected SAP systems. 
See also Section 3.1.3.6, “Numerical Restriction of RFC Connections”, on 
page 35.

Online [REG_DWORD]  

Defines whether or not the connection to the relevant system with number ’x’ 
is active.

If the connection is indicated as active at the SAPphone APL start, the 
communication to the associated SAP R/3 system is automatically set up.

Default: <empty string>

Possible values: <string>

Remark: Must be a unique name.

Default: <empty string>

Possible values: <SAP tenant number>

Default: <empty string>

Possible values: <Call Handle>

Remark: Modifications may lead to system errors.

Default: 20

Possible values: <0…100>

Default: 1

Possible values: 0 – Inactive
1 – Active/automatic system start
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Password [REG_SZ]  

Defines the user password with which the RFC client logs on to the SAP 
system deploying the associated CPI-C user.

ServerId [REG_SZ]  

Defines the SAP telephone server ID returned to the XPR server by the SAP 
R/3 after a corresponding connection test and buffered here. This ID can only 
be determined by a connection test.

ServerMode [REG_SZ]  

Is used in the SPControl and MSPTSP context. If setting ’1’ is configured 
here, the SAP system is informed that the server concerned is a TAPI one. 

This setting is used for the "free waiting" feature.

SrvDest [REG_SZ]  

Defines the referencing string for the RFC connection data of the RFC client 
in the saprfc.ini.

User [REG_SZ]  

Defines the user ID with which the RFC client logs on to the SAP system 
deploying the associated CPI-C user.

Default: <empty string>

Possible values: <encrypted password>

Default: <empty string>

Possible values: <string>

Remark: Modifications may lead to system errors.

Default: <empty string>

Possible values: 0 – No MSPTSP use for ’free waiting’
1 – MSPTSP use for ’free waiting’

Default: <empty string>

Possible values: <string>

Remark: Must be a unique name.

Default: <empty string>

Possible values: <user ID>
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6.3.3  Registry Values of the SAP R/3 System Location

The following values are found under the key

HKLM\SOFTWARE\Wow6432Node\PP-
COM\MRS\SapPhoneApl\System[x]\Location

AccessCode [REG_SZ] 

Defines the XPR server's access code. This entry is used for normalizing 
phone numbers.

AreaCode [REG_SZ] 

Defines the XPR server's area code. This entry is used for normalizing phone 
numbers.

AreaCodeEscape [REG_SZ] 

Defines a digit string as escape sequence that must be dialed for calls with a 
different area code. In Germany this is e.g. 0. This entry is used for 
normalizing phone numbers.

CountryCode [REG_SZ] 

Defines the XPR server's country code. This entry is used for normalizing 
phone numbers.

Default: Value is copied from the corresponding registry value under the 
key MRS\MRS Globals\Location.

Possible values: <calling number>

Default: Value is copied from the corresponding registry value under the 
key MRS\MRS Globals\Location.

Possible values: <area code without leading zero>

Default: Value is copied from the corresponding registry value under the 
key MRS\MRS Globals\Location.

Possible values: <number sequence>

Default: Value is copied from the corresponding registry value under the 
key MRS\MRS Globals\Location.

Possible values: <country code without leading zeros>
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CountryCodeEscape 

Defines the escape sequence that must be dialed for calls with a different 
country code. In Germany this is e.g. 00. This entry is used for normalizing 
phone numbers.

DialAlwaysArea [REG_DWORD]  

Defines whether the area code is also dialed in the same area network. This 
is required e.g. in Switzerland.

ExternalLinePrefix [REG_SZ] 

Defines a digit string as escape sequence required as ’external line prefix’ at 
a PBX. This entry is used for normalizing phone numbers.

LocPrefixExtensions_ [REG_MULTI_SZ]  

Defines a list with phone numbers or phone number portions that are not to 
be normalized by the XPR server.

Every phone number that exceeds the length defined in the registry value 
’MaxInternalLength’ is usually normalized as external phone number. This 
may lead to problems in particular in complex voice networks, since in such 
an environment multi-digit selection codes are often used for routing to 
different locations. To avoid this problem, such selection digits can be defined 
in this registry value so that they are not normalized.

MaxInternalLength [REG_DWORD]  

Defines a phone number length up to which the relevant phone number is not 
normalized. Phone numbers that exceed the length defined here are 
normalized.

Default: Value is copied from the corresponding registry value under the 
key MRS\MRS Globals\Location.

Possible values: <number sequence>

Default: Value is copied from the corresponding registry value under the 
key MRS\MRS Globals\Location.

Possible values: 0 – Area code is only dialed when necessary
1 – Area code is always dialed – even in the same area network

Default: Value is copied from the corresponding registry value under the 
key MRS\MRS Globals\Location.

Possible values: <number sequence>

Default: <empty string>

Possible values: <phone number>; one phone number entry per line

Default: Value is copied from the corresponding registry value under the 
key MRS\MRS Globals\Location.

Possible values: <number>
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PbxCode [REG_SZ]  

Defines the trunk code via which the connected PBX can be reached by the 
XPR server.

6.4  Registry Values of the XML APL

The XML APL keys are documented in the OpenScape Xpressions Server 
Administration manual.

Default: Value is copied from the corresponding registry value under the 
key MRS\MRS Globals\Location.

Possible values: <trunk code>
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6.5  Registry Values of the MSPTSP

In the following we describe the keys of the MSPTSP with their respective values 
in the Windows Registry. In doing so we only consider the keys that are important 
for the solutions of this manual.

The following values are found under the key

HKLM\Software/Cycos AG/msptsp/5.0/

WaitForSapPhoneCallHandle [REG_SZ]  

Controls the update behavior of the CIC when the ’free waiting’ mode is used 
for the SAPGUI.

By default, the application-specific Call Handle is only copied via SAPphone 
when Call Attached Data (CAD) is available in the SAPphone APL. As 
alternative the Call Handle can also be copied when no CAD is available.

If updating in the ’free waiting’ mode is problematic, set this value to 0.

Default: 1

Possible values: 0 – Call Handle is always copied
1 – Call Handle is only copied if CAD is available.
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7  Important SAP Transaction Codes

In combination with the SAPGUI command field, transaction codes serve for 
reaching specific SAP transactions quickly.

The following table lists the most important transaction codes that are of interest 
in the scope of this manual:
 

Transaction code Description

/nSCOA SAPconnect background job

/nSCON SAPconnect (SAP-R/3 versions 3.x)

/nSCOT SAPconnect (as of SAP-R/3 version 4.0)

/nSE37 Configuring conversion rules

/nSM59 Creating / maintaining / testing RFC destination

/nSO28 Inbound routing (configuring a postmaster)

/nSPHA Proprietary SAPphone user and workstation settings

/nSPHB Creating / maintaining SAPphone location and telephony servers

/nSPHT Test transactions for CTI

/nSPRO Customizing/maintaining IMGs

/nSU01 Creating / maintaining foreign user profiles

/nSU1 Maintaining proprietary user profiles

Table 6 SAP transaction codes
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8  Document Formats in SAP R/3 

The following table provides an overview of the document formats used in SAP R/
3:
 

Format identifier Description

BIN Unstructured binary data

GRA Binary graphics data

HTM HTML-formatted data

IDC Text data (SAP-IDoc format)

OTF Text data (SAP-OTF format)

PDF Text data (PDF format)

PS Text data (corresponds to the POSTSCRIPT format)

RAW Text data

RTF Binary data (Rich-Text format)

SCR Text data (SAPScript format)

TIF Binary data (Fax-Multipage-TIFF format)

Table 7 SAP Document Formats
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Scope of Services of the SAPphone Interface

9  Scope of Services of the SAPphone Interface

The following table lists the features realized in the SAPphone interface of the 
respective SAPR/3 versions:
 

SAP version
(where applicable with SAP 
application)

Scope of services

R/3 versions 3.1G to 4.0B • Connection setup
• Call acceptance
• Connection clearing
• Automatic start of SAP workflows

R/3 version 4.5B and later In addition to the previously mentioned features:
• Consultation
• Initiating conferences
• Logging out of/terminating a conference
• Forwarding (with and without consultation)
• Call Attached Data (CAD)
• Generating missed-call e-mails

(callback from e-mail)
• Compatibility test on both sides
• Tracing of RFC connections

Table 8 Scope of Services of the SAPphone Interface under SAP
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Troubleshooting

10  Troubleshooting

The following table provides basic assistance in solving errors frequently 
occurring during the XPR-SAP integration configuration.

If system failures occur in connection with an XPR-SAP integration that cannot 
be solved by the suggestions made in this chapter, we refer to additional system 
documentation (for example release notes etc.) and subsequently to your 
contractual partner if required.

The assistance contained in this chapter is divided into the following sections:

• General Trouble Shooting

• Trouble Shooting in the RFC Communication

• Trouble Shooting in a UM Solution

• Trouble Shooting in a CTI Solution
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10.1  General Trouble Shooting

This section contains information about the following problems:

• The SAPR3, SAPphone and SAProute APL are not offered in the XPR setup 
for selection.

• The SAPGUI cannot connect to the SAP server..

 

Error Description Possible Cause Solution

The SAPR3, SAPphone and 
SAProute APL are not offered in 
the XPR setup for selection.

No SAP client is installed on the XPR 
system.

Install the SAPGUI on the XPR server.
See Section 4.2, “Installing the SAPGUI”, 
on page 56.

The SAPGUI cannot connect to 
the SAP server.

The SAP system with its parameters is not 
yet entered in the SAPGUI.

In the SAPGUI define a new SAP system 
with its associated communication 
parameters.
See Section 4.3, “Configuring a Connection 
to an SAP Application Server”, on page 59.

The relevant connection information is not 
correctly entered in the SAPGUI.

Check the settings of the relevant SAP 
system in the SAPGUI and correct the faulty 
parameter.
See Section 4.3, “Configuring a Connection 
to an SAP Application Server”, on page 59.

The SAP password has not been entered 
correctly.

When logging in to the SAP system enter 
the SAP password in exact spelling (the 
SAP system differentiates between upper 
and lower case).
See Section 4.3, “Configuring a Connection 
to an SAP Application Server”, on page 59.
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10.2  Trouble Shooting in the RFC Communication

This section contains information about the following problems:

• The RFC connection test fails..

 

Error Description Possible Cause Solution

The RFC connection test fails. No RFC interface is installed on the XPR 
server.

Install the SAPGUI on the XPR server.
See Section 4.2, “Installing the SAPGUI”, 
on page 56.

The XPR server does not find the 
saprfc.ini file.

Create the saprfc.ini file.
See for example Section 5.5, “saprfc.ini”, on 
page 283.

Copy the saprfc.ini file to the 
<XPR Install>\bin\ directory.

The XPR server does not find the required 
parameters in the saprfc.ini.

Enter the correct connection parameters in 
the saprfc.ini.
See for example Section 5.5, “saprfc.ini”, on 
page 283.

The virtual user configured for the 
connection has not the privileges required 
for setting up a connection.

Assign at least the S_A.SCON privileges to 
the virtual SAP user.
See for example Section 4.5.3.2, “Creating 
a virtual CPI-C user in SAP R/3”, on page 
80.

Authenticating the program ID fails. Configure the program ID on the XPR and 
SAP side in consistent writing.
See for example Section 4.5.3.2, “Defining 
an RFC destination in SAP R/3”, on page 
85.

Router connect string is not correctly 
specified in the saprfc.ini.

Check the router connect string entry in the 
saprfc.ini.

The last entry of the router connect string 
must be the IP address of the SAP 
destination system. The SAP system host 
name is not permitted.

The virtual CPI-C user is locked in SAP R/3 
(occurs for example automatically after 
several connection attempts with wrong 
password).

Unlock the CPI-C user in the user 
maintenance under SAP R/3.
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10.3  Trouble Shooting in a UM Solution

This section contains information about the following problems:

• Message attachments are not correctly transmitted from within SAP R/3.

• An SAP user does not receive any/all messages via the XPR server.

• An SAP user does not receive any/all messages via the XPR server.

• An SAP user cannot send any/all messages via the XPR server..

 

Error Description Possible Cause Solution

Message attachments are not 
correctly transmitted from within 
SAP R/3.

The logical node defined under SAP R/3 for 
the XPR server has not been configured 
correctly for the file conversion.

Configure the formats for document 
formatting in the required manner.
See Section 4.5.4.2, “Setting the node”, on 
page 142.

An SAP user does not receive 
any/all messages via the XPR 
server.

The SAP user is not present in the XPR 
server user database, since he/she has not 
been defined in the XPR server 
’AutoLearn’.

Activate the ’AutoLearn’ mode in the 
settings of the XPR server SAPR3 APL.
As an alternative the XPR administrator can 
also make the user entries in the XPR 
server manually.

’AutoLearn’ is active. The SAP user 
however has not yet sent a message of the 
relevant type.
Therefore ’AutoLearn’ could not enter the 
corresponding address of this service in the 
XPR user database.

The SAP user must first send a message of 
the type that he/she wants to receive via the 
XPR server.
See Section 3.2.2.4, “XPR Server 
’AutoLearn’Mode”, on page 44.
As an alternative the XPR administrator can 
also make the user entries in the XPR 
server manually.

’AutoLearn’ is active but does not define the 
learned users as user but as contact.

Enter in the registry value
AutoLearnEntries [REG_MULTI_SZ] the 
XPR database fields GROUP and 
PASSWORD correctly.
See Section 3.2.2.4, “Default Values for 
new User Profiles”, on page 50.

’AutoLearn’ is active, the relevant users 
however have already been present in the 
XPR database. Therefore ’AutoLearn’ 
maintains the new addresses but not the 
PREFERRED field upon message 
transmission.

Configure the PREFERRED XPR database 
field of the relevant users for message 
reception via the SAPR3 APL.
See Section 3.2.2.4, “Outgoing messages 
of a user already known”, on page 46.
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An SAP user cannot send any/all 
messages via the XPR server.

The relevant message type has not been 
configured for the SAPconnect method 
under the SAP communication method.

Under the SAP communication methods 
configure the SAPconnect method for the 
relevant message type.
See Section 4.5.4.1, “Setting the 
communication methods”, on page 105.

In the SAP system no logical node has been 
defined for the XPR server.

In the SAP system define a logical node for 
the XPR server.
See Section 4.5.4.2, “Setting the node”, on 
page 142.

The logical node defined under SAP R/3 for 
the XPR server has not been configured for 
the relevant service.

Configure the respective service for the 
XPR server in its logical node.
See Section 4.5.4.2, “Setting the node”, on 
page 142.

The logical node defined under SAP R/3 for 
the XPR server has only been configured 
for a restricted address area.

Configure the address area of the logical 
node in a way that all desired messages are 
passed on to the XPR server by the SAP 
system.
See Section 4.5.4.2, “Setting the node”, on 
page 142.

Error Description Possible Cause Solution
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10.4  Trouble Shooting in a CTI Solution

This section contains information about the following problems:

• The SAPR3 and SAPphone APL are not offered in the XPR setup for 
selection.

• Incoming telephone calls are not displayed on the PC workstation..

 

Error Description Possible Cause Solution

The SAPR3 and SAPphone APL 
are not offered in the XPR setup 
for selection.

No SAP client is installed on the XPR 
system.

Install the SAPGUI on the XPR server.
See Section 4.2, “Installing the SAPGUI”, 
on page 56.

Incoming telephone calls are not 
displayed on the PC workstation.

SAP R/3 does not know an assignment 
between PC work center and telephone 
terminal device.

In SAP R/3 define the assignment of PC 
work center and telephone terminal device.
See Section 4.7.4.1, “Configuration of the 
work center and user settings”, on page 
244.
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Glossary X

A

AAA
General description of a security concept. The three letters represent the concept areas Authentication, 
Authorization and Accounting.

Authentication: Process in which the given identity of a user is uniquely established. One simple identification 
method is e.g. verification of a previously defined password.

Authorization: Process for assigning privileges to a uniquely identified user. Such privileges can be e.g. 
access rights for specific hardware components or user privileges for specific network services.

Accounting: Describes data collecting via resource utilization. These data may later serve for load analysis, 
cost assignment or billing.

Access Mode (Voicemail)
Voicemail protocols offer various options (modes) to gain access to a voicemail box. The types and function-
ality provided in the respective modes depend on the protocol used.

Access Protocol Layer
See APL.

ANI
Acronym for Automatic Number Identification.

Concept for identifying a message originator by his/her transmitted originator number. After the caller has 
been identified, automated processes can be executed based on this information. Such processes include 
among other things the display of stored caller data in a CTI environment.

ANI Hit
Describes the successful finding of information within a database on the basis of the ANI check of an origi-
nator number (cf. ANI).

APL
Acronym for Access Protocol Layer.

Group of software modules in the XPR server. Each APL enables an interface for communicating with 
external components.

Application Builder
XPR server client application.
This application is used for configuring the Automated Attendant of the Vogue script.

Application Server (SAP)
The SAP application server provides the SAP R/3 users with all required SAP applications. If an invoked 
application under SAP R/3 needs stored data, the application server communicates with the database server 
and retrieves all required information from there.
The SAP applications of a company can be distributed among various application servers and are thus highly 
scalable.
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Authentication
See AAA.

AutoLearn
Mechanism for automatic integration of SAP users in the XPR user database in the scope of an XPR-SAP 
integration.

Automated Attendant
IVR system of the Vogue script that answers incoming calls and guides the caller by means of interactive 
voice menus. Possible is e.g. automatic forwarding for leaving a voice mail.

Automated Call Distribution (ACD)
See ACD.

Automated Message Distribution (AMD)
See AMD.

Automatic Number Identification
See ANI.

Authorization
See AAA.

C

CALLEDID
Part of the connection request in the voice communication environment. This information unit contains the 
subscriber calling number to which a communication relationship is to be established.

CallerID
Part of the connection request in the voice communication environment.
This information unit contains the calling number of the subscriber that wants to establish the communication 
relation.

Call Handle
Identifying denominator for a dedicated communication relationship. It is created, for example, in communi-
cations systems while communication is established and made known to the communications systems so 
that they can be uniquely identified in the course of the communication relationship.

Calling Number
See CAD.

Client Connection
Connection that ends on the contemplated communication system's client in case of a client/server interface.

Computer Telephony Integration
See CTI.

CN
Acronym for Call Attached Data.

Concept that enables the display and forwarding of call-related data. For example, when a call is forwarded 
to another agent, already available information can be attached to this call.
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CRM
Acronym for Customer Relationship Management.

Sales application of the company SAP. CRM provides modules required for the management of customer 
relations.

CTI
Acronym for Computer Telephony Integration.

Describes the connection of PBXs and computer systems via a special interface (CTI interface).
With CTI the user can, for example, control a telephone from the workstation or see the automatic display of 
significant caller information (such as name, address and contact history) on the computer screen.

CTI APL
XPR server APL for providing a CTI interface to communicate with a PBX.

CTI Queue (SAP)
See Queue.

Customer Relationship Management (SAP)
See CRM.

D

Database Server (SAP)
The database server acts as central administrator of all data stored in an SAP R/3 landscape.

Direct Access Mode (Voicemail)
Access mode in a voicemail solution, often also called Control Mode.
In the control mode individual mailbox options can be set, messages edited, re-recorded or sent.

DTMF
Acronym for Dual Tone Multi Frequency.

Telephony technology for generating tones by pressing keys on a telephone terminal device. For each key 
an individual tone is generated which results from combining two frequencies.

E

E
Script language used with enabling functionalities in the XPR environment. E's structure is strongly related 
to the C/C++ programing language.

Ergo
Voicemail protocol in the XPR environment. Besides accessing his/her mailbox it enables the user to perform 
multifarious settings by means of telephone keys. Moreover, the system is not bound to a specific type of 
PBX.

E-script
Program written in script language E. Serves for enabling different system features of the XPR communica-
tions server.
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F

Folders on Remote Server
Server system that provides a communications solution.
A communications server is often an element of a comprehensive solution in which it is in charge of message 
routing (telephone, fax, SMS etc.). In this scope, continuative services (e.g. contact center functionalities) 
can be provided.
The XPR server represents a communications server.

Forwarding Access Mode (Voicemail)
Access mode in a voicemail solution, often also called Forwarding Mode.
The Forwarding Mode is the answering function that allows leaving a message when incoming phone calls 
are rerouted to the individual mailbox. The corresponding mailbox is assigned via the redirected number.

G

Gateway Service (SAP)
One SAP service among various others, which are configured on a SAP application server. It provides 
external connections for the entire SAP server system. In this function it is responsible for processing 
outgoing Remote Function Calls (RFC).
An SAP server carrying a gateway service is also called SAP Gateway Host.

GSM
Acronym for Global System Mobile.

GSM is a European standard for digital mobile phone systems. As services GSM offers a number of basic 
services and additional services. Among these services you find Voice and the Short Message Service 
(SMS).

Guest Access Mode (Voicemail)
Access mode in a voicemail solution, often also called Answering Machine Mode.
In this mode the mailbox of an arbitrary subscriber can be directly called. Depending on the operation mode 
either a message can be left or an info box greeting played.

I

ICI (SAP)
Acronym for Integrated Communication Interface.

New SAP interface for integrating external applications in an SAP landscape. This interface was imple-
mented based on the specifications for XML/SOAP of the W3C consortium and works with a progressive, 
web-oriented technology. It thus forms the further development of the SAPconnect and SAPphone interface.
ICI is supported in the XPR server by the XML APL.

IEEE
Acronym for Institute of Electric and Electronic Engineers.

Founded in 1963, the IEEE is an institute of electrical and electronically engineers for the definition of norms 
in the network area, in particular for standardizing bus topologies, transmission protocols, data transmission 
speed and wiring.
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IM
Acronym for Integrated Messaging.

Integrated Messaging is an extension of Unified Messaging. It describes the coupling of different messaging 
systems by synchronizing user data and messages to offer the user the advantages of both systems.
In case of Integrated Messaging the synchronized information is managed on all involved systems in parallel.

Integrated Communication Interface (SAP)
See ICI.

Integrated Messaging
See IM.

Integrated Voice Response
See IVR.

IP
Acronym for Internet Protocol.

IP belongs to the TCP/IP protocol family, an approved industry standard for communication between commu-
nications systems. The transmission protocol defines the rules and arrangements that control the flow of 
information in a communication system. Main task of the IP is network-spanning addressing.
The protocol does not work line- but packet-switched and belongs thus to the connectionless communica-
tions protocols. So-called datagrams are transported to their recipients via the most convenient connections 
by an intelligent network infrastructure. This intelligently selecting a way is also called routing.

IP APL
XPR server APL for providing an IP interface to communicate with an external, IP-based PBX (soft switch).
The IP APL belongs to the family of telematics APLs that also comprises e.g. the ISDN APL.

IP Telephony
Acronym for Internet Protocol Telephony.

In case of IP Telephony - generally also known as Voice-over-IP or VoIP - voice information is not transmitted 
via classic voice circuits but routed via the internet protocol (IP) and a data infrastructure.

ISDN
Acronym for Integrated Services Digital Network.

ISDN is a digital, service integrating communications network, which was created as further development of 
the analog public telephone network. ISDN integrates various services in one transmission network. In the 
ISDN network, telephone, fax, teletex, Datex-J, viewphone and data transmission are combined.

ISDN APL
XPR server APL for providing an ISDN interface to communicate with an external PBX.
The ISDN APL offers furthermore the option to execute additional E-scripts for e.g. enabling complex 
voicemail systems.

IVR
Acronym for Integrated Voice Response.

Voice-controlled algorithm that evaluates voice- or DTMF-based entries during telephone communication 
and reacts to these entries according to preset rules.
IVR is particularly used in the voice-controlled routing of incoming calls as is implemented e.g. in the XPR 
server by the Vogue.e script.
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K

Kernel 
Central computer program component.
The kernel is loaded into the computer's main memory at a program's start. The kernel's task is to start, 
manage and eventually smoothly end all further required system routines.

L

LAN
Acronym for Local Area Network.

Local Area Networks are systems that enable equal network users to perform a group-oriented message 
exchange in a locally restricted area.
Typical LAN technologies are e.g. Ethernet or Token Ring.

Link (SAP)
Logical communication relation between a remote server and an SAP application server set up per SAP 
client.

M

Message Transfer Agent
See MTA.

Monitor Point
CTI functionality within a PBX that enables a continuous status monitoring of selected telephones.

MTA
Acronym for Message Transfer Agent.
Takes on the central routing of messages in the XPR server. Incoming messages are transferred by the 
receiving APL to the MTA, which determines the target APL based on the configured routing rules and 
forwards the message to this APL.

MSPTSP
Acronym for MRS Service Provider TAPI Service Provider.

The MSP (MRS Service Provider) is a software module via which the XPR server can communicate with an 
XPR client application.
The MSPTSP is an additional TSP extension, which provides a TSP-conformable interface. This enables 
applications from other manufacturers to access the XPR server.

N

Nodes (SAP)
Logical view of an externally connected system within SAP R/3.
SAP R/3 administers externally activated systems in logical format as so-called nodes. With configuring such 
a node, specifications are made as regards e.g. for which address area the active system is in charge, or 
which data formats are supported by it.
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O

OSI Reference Model
Acronym for Open System Interconnection or Open Systems Interconnect reference model.

OSI is an open layer model that has been developed since the 70s and has become standard. It tries to 
organize computer-internal communication by introducing seven layers based on each other and communi-
cating with each other. The advantage of such a structure is the definition of standardized communication 
interfaces between clearly defined communication units (the 7 layers).

P

Path Replacement
PBX feature – also known under the name Explicit Call Transfer (ECT).
Realizes the direct connection of two subscribers within a PBX after e.g. the XPR server has established the 
connection to the single communication partners.

PlayWave
Protocol in the XPR environment.
PlayWave enables the playback of voicemails via telephone. This protocol is used by the Outlook Forms, 
Notes Forms and Communications.

Postmaster
System user who receives undeliverable messages.

POTS (Plain Old Telephone System)
The normal analog telephone network as it has been existing for years. It is gradually being replaced by 
digitalization, thus ISDN or broadband networks.

Presentation Server (SAP)
The presentation server is in charge of the user-compatible representation of all SAP-related information on 
the SAP user system. It is part of the SAPGUI, the graphical PC user interface of an SAP user, or is 
addressed as X-Server by an X-Terminal. 
The information to be represented is retrieved by the representation server from the application server.

Program ID
Logical ID for a communications relationship via the RFC protocol. It is used for authentication of the 
connected system.

PSTN (Public Switched Telephone Network)
Public telephone network with switching systems provided by the corresponding telecommunications 
providers.

Q

QoS
Acronym for Quality-of-Service.

QoS summarizes all facilities and mechanisms that ensure information to be transported via a communi-
cation network according to the required standards. QoS mechanisms include hardware-based facilities 
(such as queuing architectures in hardware components) but also protocol-based mechanisms (such as the 
DiffServ field in the IPv6 header).

Quality of Service
See QoS.
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R

Redirected Number
Is in case of a call diversion attached to the rerouted communication setup as additional information. This 
information contains the phone number of the originally called subscriber who has diverted his/her extension.
On basis of this information, voicemail systems can directly forward a call to the voicemail box of the actually 
called subscriber.

Registry
A database structure or a database entry in which the Windows operating system stores various program-
significant presettings to access them later.
Manual modification of registry entries is possible but should only be carried out by experienced users.

Remote Function Call
See RFC.

RFC Destination
Basis for addressing an RFC communication. The RFC destination thus forms the logical view of an RFC 
connection to an external system.

RFC (SAP)
Acronym for Remote Function Call.

RFC is a TCP / IP-based client / server interface with symmetric communication character with the commu-
nication query always occurring from client to server. The RFC communication is based on the so-called 
Remote Function Calls (RFC) after which this interface is named.
RFC forms the communication basis between the SAP R/3 system and an external application with using the 
SAP interfaces SAPconnect and SAPphone.

Routing
Routing principle particularly used in IP data communication.
Based on their respective IP destination address, data packets are routed via a data network. At each intel-
ligent network node (router) a decision is taken concerning the most convenient way to the destination point 
and the data packet routed accordingly.

S

SAPconnect
SAP interface for integrating external applications in an SAP landscape. The SAPconnect interface has been 
available since SAP-R/3 version 3.1G.
SAPconnect supports the message services Fax (with document attachment), E-mail and Pager (SMS). 
Based on this feature range it is used in Unified Messaging solutions.
The XPR server provides a SAPconnect interface with the SAPR3 APL.

SAPGUI
Graphic SAP user interface for SAP users.
The SAPGUI is installed on the computer system of the SAP user and enables the communication with the 
centralized services of the SAP environment.

SAPphone
SAP interface for integrating external applications in an SAP landscape. The SAPphone interface has been 
available since SAP-R/3 version 3.1G.
SAPphone supports CTI and contact center services, thus being used in the corresponding solutions.
The XPR server provides a SAPphone interface with the SAPPHONE APL.
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SAPPHONE APL
XPR server APL for providing a SAPphone interface for the communication with an external SAP R/3 system.
Via the SAPphone interface the systems involved can be provided with CTI and contact center functions.

SAP R/3
Integrated collection of standardized company applications that map and support a broad range of company 
processes.
SAP R/3 is a real-time system. All company-significant information is centrally consolidated in the SAP 
database and can thus be queried any time.

SAPR3 APL
XPR server APL for providing a SAPconnect interface for the communication with an external SAP R/3 
system.
Via the SAPconnect interface, Unified Messaging messages can be exchanged between the systems 
involved.

SAPrfc.INI
Configuration file for RFC-based computer applications. This file is used in the scope of an XPR-SAP 
integration to configure the LibRFC.dll of the XPR server platform.
The saprfc.ini contains the required configuration parameters for the RFC communication via the SAP 
interfaces SAPconnect and SAPphone. These parameters comprise e.g. program ID, system number and 
the host name of the relevant SAP application server.

Server Connection
Connection that ends on the contemplated communication system's server in case of a client/server 
interface.

SMS APL
XPR server APL for sending SMS messages. The SMS APL provides the interface for connecting a cell 
phone via which the XPR server sends all SMS messages.

Switch Matrix
PBX element that performs central switching of voice circuits. Depending on the connection requirements it 
is dynamically configured by a control logic and represents the central switching unit of a PBX.

T

TAPI Service Provider
See TSP.

TCP
Acronym for Transmission Control Protocol.

TCP is a protocol for communication between computer systems. It is member of the TCP/IP protocol family 
to which further communication protocols belong (cf. UDP and IP).
On information sending TCP ensures safe transmission which is based on an additional communication 
relation between the sending and receiving computer system. This relation controls the actual data 
exchange. If e.g. transmitted payload is received faulty or not at all, the sender is accordingly informed by 
the recipient and can resend the respective information.
TCP works connection-oriented, thus establishes and cancels connections.

TCP APL
XPR server APL that enables the client/server communication in a Windows environment via a TCP / IP 
network.
The TCP APL is particularly used for the communication of XPR clients (ACD client etc.) with the XPR server.
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Transaction Code
Serves in SAP systems for conveniently reaching SAP transactions.

TSP
Acronym for TAPI Service Provider.

Software module that manages the communication between the Microsoft Telephony API of a PC and a 
connected PBX. The PC serves the PBX as external, logical unit that controls communication relationship 
establishment.
For various PBXs optimized TSPs are used by the respective manufacturer.

U

UDP
Acronym for Users Datagram Protocol.

UDP is, like TCP, a member of the TCP/IP protocol family and an alternative to TCP, thus also a communi-
cation protocol between two computer systems. Like TCP, UDP works on the basis of the internet Protocol 
(IP) as well. It is however not as reliable in its transmission method. This is due to UDP not checking the 
transmitted data. But owing to its simple structure it enables faster information transmission compared to 
TCP.

UM
Acronym for Unified Messaging.

Unified Messaging describes the consolidation of various communication services on a common platform. 
Such services can be, for example, Voice (telephony), Fax, E-mail or SMS, which are administered in a 
Unified Messaging solution on a universal communication platform and, in the ideal case, are intercon-
vertible.
In practical terms this means that a user can reach all of his/her incoming messages via a central system 
access.

Unified Messaging
See UM.

V

Voice Circuit
Transmission channel that is established on setting up a communication relationship between two or several 
telephone terminal devices. It remains as reserved transmission resource until the connection has been set 
up. Establishment and termination of the voice circuit occurs in the PBX by the switchmatrix upon request.

Vogue.e
VOice GUidE E-script of the XPR server.
Realizes IVR functions (Automated Attendant) for incoming calls in the XPR server.

W

Wave Driver
Software module that enables processing (recording and playback) of sound data on computer systems.
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X

XML APL
XPR server APL that provides among other things an ICI interface (Integrated Communication Interface) for 
the communication with an external SAP R/3 system.
Via the ICI interface, Unified Messaging and CTI functions can be provided to the systems involved.

XPR
Acronym for Xpressions.

The Xpressions server is an efficient Advanced Unified Messaging Server by Unify Software and Solutions GmbH&Co.KG which, 
among other things, provides various communications services by means of LAN or ISDN interfaces. Such 
services comprise e.g. Fax, CTI, E-mail, SMS, call center call distribution or Fax-on-Demand.
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